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1 Présentation du Makoto Intravascular Imaging Systemm™

1.1 Indications d’utilisation

Le Makoto Intravascular Imaging System™ est destiné a I'examen du proche infrarouge
des artéres coronaires chez les patients subissant une coronarographie invasive.

Le systéme est concu pour détecter des plaques d’intérét contenant un ceceur lipidique.
Le systeme est congu pour évaluer la masse du cceur lipidique de l'artere coronaire.

Le systeme est destiné a I'examen par ultrasons de la pathologie intravasculaire
coronarienne. L'imagerie par ultrasons intravasculaire est indiquée chez les patients
candidats a des procédures d’intervention coronariennes transluminales.

1.2 Formation
Le Makoto Intravascular Imaging System™ doit étre exclusivement utilisé par le
personnel du laboratoire de cathétérisme cardiaque et des médecins qualifiés.

Une formation sur site par le personnel d’'Infraredx ou des formateurs certifiés sur
l'utilisation du Makoto Intravascular Imaging System™ est disponible au moment de
l'installation et sur demande. Veuillez contacter le service clientele d’Infraredx ou votre
fournisseur de services local pour planifier des formations sur site et des évaluations
périodiques des compétences de la formation.

1.3 Coordonnées d’'Infraredx
Aux Etats-Unis, contactez :

Infraredx, Inc.

28 Crosby Drive, Suite 100
Bedford, MA 01730
Etats-Unis

www.infraredx.com
1-800-596-3104
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1.4 Brevets

Le Makoto Intravascular Imaging System™, les cathéters et les accessoires associés
sont protégés par un ou plusieurs brevets. Pour obtenir une liste exhaustive des brevets
publiés, veuillez consulter :

http://www.infraredx.com/infraredx-intellectual-property/

1.5 Marques de commerce

Infraredx™, Makoto™, Dualpro™ et TVC™ sont des marques de commerce
d’Infraredx, Inc. Le nom « Infraredx » est une marque déposée par Infraredx, Inc. aux
Etats-Unis, dans I'Union européenne, en Australie, en Chine, en Corée du Sud et au
Japon.

Tous les autres noms de marque et noms de produits utilisés et référencés dans ce
document sont des marques de commerce, des marques déposées ou des noms de
marque de leurs détenteurs respectifs.
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2 Maniere d’interpréter ce manuel

Ce manuel contient des informations importantes pour l'utilisation du Makoto
Intravascular Imaging System™. Lisez et passez attentivement en revue le manuel
avant d’essayer d'utiliser le produit.

2.1 Symboles et icones
Des alertes sont présentes partout dans ce manuel. Ces alertes sont appelées
Avertissements, Mises en garde et Remarques.

Le non-respect des avertissements écrits peut entrainer une
situation dangereuse pouvant blesser le patient ou I'opérateur.

AVERTISSEMENT

Le non-respect des mises en garde écrites peut endommager le
Makoto Intravascular Imaging System™ ou entrainer une
ATTENTION dégradation des performances du systeme.

REMARQUE : Les remarques fournissent des rappels et des conseils utiles
pour l'utilisation des fonctionnalités avancées.

2.2 Abréviations

CA Courant alternatif

ANSI American National Standards Institute (Institut national de
normalisation américain)

ZS Zone de sténose

AVI Audio Video Interleave (imbrication audio vidéo)

CABG Pontage aorto-coronaire

CUl Console User Interface (interface utilisateur de la console)

CPU Central Processing Unit (unité centrale de traitement)

DICOM Digital Imaging and Communications in Medicine standard

(norme pour la gestion informatique des données issues de
limagerie médicale)
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MEE
CEM
IEM
OE
EtO
FDA
FHD

HD
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IP
ISO
IVUS
JPEG

LCBI
PCL
LCBImx
PIR
SPIR
zZP

PP
PACS

ACTP
RF
UL
USB
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Digital Video Disc (disque vidéo numérique)
Membrane élastique externe
Compabilité électromagnétique
Interférence électromagnétique
Oxyde d’éthylene
Oxyde d’éthylene
Food and Drug Administration

Full High Definition display (écran haute définition intégrale),
1920x1080 pixels

High Definition display (écran haute définition)
Commission électrotechnique internationale

Internet Protocol (protocole Internet)

International Organization for Standardization
Intravascular Ultrasound (échographie intravasculaire)

Joint Photographic Experts Group (Groupe mixte d’experts
en photographie)

Lipid Core Burden Index (indice de masse du cceur lipidique)
Plaque d’intérét contenant un cceur lipidique

LCBI max. d’'une largeur de fenétre spécifiée

Proche infrarouge

Spectroscopie par proche infrarouge

Zone de plaque

Progression de plaque

Picture Archiving and Communication System (systeme
d’archivage et de transmission d’'images)

Angioplastie coronarienne transluminale percutanée
Radiofréquence
Underwriters Laboratories

Universal Serial Bus (bus universel en série)
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2.3 Actions

Le Makoto Intravascular Imaging System™ est principalement congu pour une
interaction par écran tactile. En plus de I'écran tactile, le systeme est équipé d’'une
souris. Souvenez-vous des actions et des gestes suivants pour vous aider a interagir
avec le Makoto Intravascular Imaging System™

Toucher Un contact momentané avec I'écran tactile ou le fait
d’enfoncer et de relacher un bouton physique

Appuyer Appuyer et relacher un bouton physique

Cliquer avec le bouton Un seul clic sur le bouton droit de la souris
droit de la souris

Cliquer avec le bouton Un seul clic sur le bouton gauche de la souris
gauche de la souris

ou Cliquer

Double-cliquer Deux clics successifs rapides sur le bouton gauche de la souris
Faire défiler vers Tourner la roulette de défilement sur la souris vers l'utilisateur
le haut / le bas pour descendre ou dans l'autre sens pour monter

Faire glisser Quand le doigt est en contact avec une icone mobile,

déplacer le doigt vers un autre emplacement. Retirer le doigt

de I'écran pour relacher l'icéne.
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3 Mises en garde, sécurité et précautions

3.1 Contre-indications

L'utilisation du cathéter Makoto Intravascular Imaging System™ est contre-indiquée
guand l'introduction d’un cathéter constitue une menace pour la sécurité du patient. Les
contre-indications incluent :

une bactériémie ou septicémie ;

des anomalies majeures du systéme de coagulation ;

une instabilité hémodynamique grave ou un choc ;

les patients qui sont diagnostiqués avec un spasme de l'artére coronaire ;
les patients qui ne peuvent pas subir de PAC (pontage aortocoronarien) ;
une occlusion totale ;

les patients qui ne peuvent pas subir ’ACTP ;

les patients qui ne conviennent pas aux procédures IVUS.

3.2 Complications
Les complications suivantes peuvent survenir a la suite d’'un examen intravasculaire :

réaction allergique ;

angor ;

un arrét cardiaque ;

des arythmies cardiaques y compris, mais sans s’y limiter, une tachycardie
ventriculaire, une fibrillation auriculaire / ventriculaire et un bloc cardiague complet ;
une tamponnade cardiaque / un épanchement péricardique ;

la mort ;

un dispositif coincé nécessitant une intervention chirurgicale ;

un embolisme (air, corps étranger, tissus ou thrombus) ;

une hémorragie / un hématome ;

hypotension ;

infection ;

infarctus du myocarde ;

ischémie myocardique ;

un AVC et un accident ischémique transitoire ;

thrombose non expliquée ;

une occlusion vasculaire et une fermeture soudaine ;

un traumatisme vasculaire y compris, mais sans s’y limiter, une dissection et
une perforation.
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3.3 Sécurité

Le Makoto Intravascular Imaging System™ ou Makoto™ a été congu pour étre utilisé et
entretenu de la facon la plus sdre possible. Cependant, tout instrument meédical peut
causer des blessures s'il n’est pas correctement installé, utilisé, déplacé ou entretenu ;
et ce systeme n’échappe pas a cette regle.

Les risques potentiels sont :

e des Iésions oculaires (vision) provoguées par une exposition a un rayonnement
laser direct ou réfléchi ;

e une décharge électrique provoquée par I'entrée en contact avec des
composants électriques a l'intérieur du systéme ;

e un préjudice physique provoqué par l'utilisation ou le déplacement du systeme.

Le Makoto™ est doté de fonctionnalités congues spécifiquement pour assurer un
fonctionnement en toute sécurité aux utilisateurs. Tout le personnel du laboratoire de
cathétérisme doit se familiariser avec I'emplacement et le fonctionnement des
caracteéristiques de sécurité mentionnées ci-dessous. Pendant I'imagerie, les
composants mobiles sont totalement enfermés. Ainsi, l'utilisateur ne s’expose pas a des
risques mecaniques.

Toute personne utilisant le Makoto™ pour effectuer une procédure sur un humain de
guelque nature que ce soit doit comprendre parfaitement les conséquences d’une telle
utilisation. L’AIUM (American Institute of Ultrasound in Medicine, Institut américain des
ultrasons en médecine) a publié un document intitulé « Medical Ultrasound Safety »
(Sécurité des ultrasons en médecine) (AIUM 2009). ALARA est un acronyme désignant
le principe d'utilisation prudente du diagnostic par ultrasons en obtenant les
informations diagnostiques a une puissance de sortie As Low As Reasonably
Achievable (aussi faible que raisonnablement possible). Pour obtenir une copie de ce
document, veuillez contacter I'AIUM.

Les précautions décrites dans cette section doivent étre prises
lors de l'installation, du fonctionnement, du déplacement ou de
I'entretien du systéme afin d’éviter des situations potentiellement

AVERTISSEMENT | d@NGEreuses.
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SYMBOLE

SIGNIFICATION

Avertissement

Attention

Consulter la notice d'utilisation

Consulter le mode d’emploi

CIEY B>

Le produit répond aux normes américaines,
européennes et canadiennes applicables
telles qu’évaluées par TUV Rheinland.

100-120 V~50/60 Hz 5 A
220-240 V~50/60 Hz 3 A

Le produit fonctionne a partir d’'une source
d’alimentation qui fournit nominalement
100 VCA, 120 VCA, 220 VCA ou
240 VCA, 50/60 Hertz

Le courant maximum est de 5 ampéres a
100-120 VCA, 3 ampéres a 220-240 VCA.

Fabricant

Date de fabrication

REF

Numeéro de catalogue

IFU0163rJ.fr (2021-05-05)
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SN

Numéro de série

LOT

Numeéro de lot

Date limite d’utilisation

Masse

Représentant autorisé dans la
Communauté européenne

Mise a la terre de protection (terre)

Application cardiaque directe protégée contre
les chocs de défibrillation (piece appliquée
de type CF)

La quantité contenue dans I'emballage.

Diametre intérieur du cathéter-guide
compatible

Diametre extérieur du fil-guide compatible

IFU0163rJ.fr (2021-05-05)

infraredy:

A N NIPRD COMPANY

3-4



Makoto Intravascular Imaging System™

Guide d’utilisation

Ouverture de laser

il

/
v

A conserver a I'abri de la lumiére du soleil

Apyrogene

Garder au sec

Limite de température

Limitation d’humidité

Ce dispositif peut uniquement étre vendu ou
utilisé sur ordonnance d’un médecin

Ne pas utiliser si 'emballage est endommagé

R ® 3B X

Ne pas réutiliser ce dispositif

IFU0163rJ.fr (2021-05-05)
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Ne pas restériliser

STERILE (EO Stérilisé a I'oxyde d’éthylene

N’a pas fait 'objet d’'une évaluation de
I'innocuité lorsqu’il est utilisé avec une IRM

Aucune piece de la console du Makoto™ ou du contrdleur du Makoto™ ne peut étre
entretenue par I'utilisateur. Tous les réglages sont effectués en usine avant que le
produit soit expédié aux clients ou sur site par un membre du personnel ou un
fournisseur de services d’Infraredx qualifié.

Toute modification ou toute tentative de modification du Makoto
Intravascular Imaging System™ rend la garantie du produit
nulle et peut également entrainer un dysfonctionnement du
systeme.

ATTENTION Une dégradation du dispositif ou une défaillance du produit peut
en découler.

3.4 Précautions optiques

Le produit contient un appareil a laser de classe 1M qui émet un
rayonnement laser invisible. Ne regardez pas directement a
l'aide d’instruments optiques.

AVERTISSEMENT

infraredy:

IFU0163rJ.fr (2021-05-05) 3-6



Makoto Intravascular Imaging System™
Guide d’utilisation

AVERTISSEMENT

AVERTISSEMENT

AVERTISSEMENT

Le Makoto Intravascular Imaging System™ integre un systeme laser et est classé comme
un « appareil a laser de classe 1M » en vertu d’une norme sur les performances de
rayonnement du Department of Health and Human Services (DHHS, Département de la
Santé et des Services sociaux des Etats-Unis) conformément & la Radiation Control for
Health and Safety Act of 1968 (Loi de 1968 sur le contrble des rayonnements pour la
santé et la sécurité) et a la CEI 60825-1, Sécurité des appareils a laser.

L’énergie lumineuse émise par ce systéme se situe dans la région invisible et proche
infrarouge du spectre électromagnétique a des longueurs d’onde comprises entre 1 et
2 microns. Il est nécessaire de tenir compte de ce fait lorsque des précautions sont
prises pour éviter une exposition involontaire.

REMARQUE : Le port de lunettes de sécurité laser n’est PAS requis lors de
l'utilisation du Makoto Intravascular Imaging System™,

3.5 Précautions électriques

AVERTISSEMENT

infrared»:
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Il est déconseillé d'utiliser cet équipement a proximité d’autres
équipements ou empilé sur ceux-ci, sans quoi des
dysfonctionnements pourraient étre rencontrés. Si cette
configuration est inévitable, suveillez tous les équipements, y
compris celui-ci, pour vous assurer gu’ils fonctionnent
normalement.

>

ATTENTION

Les équipements médicaux €électriques nécessitent des
précautions spéciales concernant la compatibilité
électromagnétique, et doivent étre installés suivant les
ATTENTION !nformatlons re!atlves ala compatlb.lll,te,electromagr]gthue
incluses dans I'’Annexe H : conformité électromagnétique.

>

NE positionnez PAS le Makoto Intravascular Imaging System™
a proximité d’autres eéquipements, car cela pourrait provoquer
ATTENTION des interférences électriques.

>

Une IVUS en direct ou un scan de retrait peut étre
interrompu(e) si le systeme est exposé a une décharge
électrostatique (DES). Si une IVUS en direct ou un scan de

retrait est interrompu(e), le scan peut étre immediatement
ATTENTION  redémarre.

>

Le Makoto Intravascular Imaging System™ utilise une tension de ligne CA a l'intérieur
de la console. Le fait de débrancher la fiche du cordon d’alimentation du Makoto™ de la
prise coupera l'alimentation du systeme, provoquant ainsi un arrét brutal de toutes les
opérations.

Aucune piece du boitier extérieur ne doit étre déplacée, sauf par un technicien qualifié
et autorisé.

Pour réduire le risque d’électrocution, ne branchez pas le connecteur d’alimentation
électrique du systeme a un équipement qui n’est pas protégé a la terre. Ne raccordez
pas le systéeme a un équipement de classe Il.

Les équipements de communication radiofréquence (RF) peuvent affecter les
performances du Makoto Intravascular Imaging System™. Ce type d’équipement doit
étre situé le plus loin possible du Makoto™. Des émissions RF rayonnées ou conduites
peuvent provoquer une distorsion de I'image ou d’autres artefacts sur I'écran de I''VUS.

infraredy:
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Le systeme Makoto™ n’est pas destiné a étre utilisé avec un
equipement chirurgical haute fréquence (HF) / radiofréquence

ATTENTION (RF):

Des émissions RF rayonnées ou conduites peuvent provoquer
une distorsion de I'image ou d’autres artefacts sur I'écran du

ATTENTION Makoto Intravascular Imaging System™.,

Infraredx recommande d’utiliser une source d’alimentation sans coupure dans une
installation dans laquelle des creux de tension ou des interruptions peuvent se produire.

Le systéme Makoto™ est destiné a étre branché a I'aide d’'un céble réseau a un
systeme d’information hospitalier protégé et sécurisé. Lorsqu’un cable réseau est
branché au Makoto Intravascular Imaging System™ pour transférer des données vers
un systeme d’information hospitalier, le cable doit alors étre un cable Ethernet blindé
Cat 5e (consultez la section 3.9). L'utilisation d’'un cable non conforme peut entrainer
une augmentation des émissions RF ou une diminution de I'immunité RF.

3.6 Précautions mécaniques

Ne positionnez PAS l'opérateur de la console mobile du Makoto
Intravascular Imaging System™ entre la console du systéeme
Makoto™ et d’autres équipements mobiles du laboratoire de
cathétérisme en raison du risque de dommages corporels.

AVERTISSEMENT
La table d’opération doit étre maintenue a niveau pendant
l'utilisation du systéeme Makoto™ ou a tout moment lorsque le
contréleur du Makoto™ se trouve dans le champ stérile.
AVERTISSEMENT N’utilisez PAS les commandes d’inclinaison ou de déplacement

de la table, si ces derniéres sont disponibles.

infraredy:
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NE positionnez PAS le Makoto Intravascular Imaging System™
dans la plage de mouvement des pieces du systeme de
radiographie.

AVERTISSEMENT

Assurez-vous que les cables provenant du Makoto Intravascular
Imaging System™ ou y étant branchés sont bien a plat sur le
sol.

AVERTISSEMENT

Dans un scénario typique d’utilisation, la console mobile du Makoto Intravascular
Imaging System™ est positionnée prés du pied de la table d’examen ou a droite des
moniteurs du systeme de radiographie. Un risque de basculement peut étre créé sila
console mobile du systeme Makoto™ entre en contact avec un équipement mobile du
laboratoire de cathétérisme (table d’examen, C-Arm, etc.). Ne verrouillez pas les
roulettes a frein sur la console du Makoto™ lorsque ce dernier est positionné dans la
plage de mouvement de I'équipement en question.

Lors de l'utilisation normale de la console mobile du Makoto Intravascular Imaging
System™ différents cables peuvent étre branchés a la console ou en provenir.
Assurez-vous que les cables sont bien a plat sur le sol afin de réduire au maximum les
risques de trébucher. Partout ou cela est possible, évitez de poser des cables dans les
zones ou beaucoup de piétons circulent dans la piece.

Le contrdleur du Makoto™ doit étre positionné sur une surface plane au cours de la
procédure, en particulier pendant I'acquisition des données Le contréleur du Makoto™
doit étre positionné dans le support de stockage de la console lorsque la console est
déplacée ou que le contréleur n’est pas utilisé.

infrared
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3.7 Précautions chimiques et anti-incendie

AVERTISSEMENT

Il 'y a aucun risque chimique ou d’incendie connu associé au Makoto Intravascular
Imaging System™,

infrared»:
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3.8 Précautions liées au cathéter et aux accessoires

AVERTISSEMENT

AVERTISSEMENT

AVERTISSEMENT

AVERTISSEMENT

infrared»:
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>

AVERTISSEMENT

>

AVERTISSEMENT

>

AVERTISSEMENT

>

AVERTISSEMENT

Le Makoto Intravascular Imaging System™ émet un rayonnement laser proche infrarouge
depuis le laser situé sur la console a travers le contréleur du Makoto™ et le cathéter
branché. La lumiére proche infrarouge est invisible pour I'ceil humain. Fixer ou diriger la
lumiere proche infrarouge vers la cornée et la rétine peut causer des lésions oculaires.

Le Makoto Intravascular Imaging System™ d’'Infraredx est congu pour étre utilisé
uniquement avec le cathéter d’imagerie IVUS+NIRS Dualpro™ (REF. : TVC-C195-42)
doté d’Extended Bandwidth™, un cathéter coronaire jetable a usage unique.

Avant leur utilisation, examinez soigneusement tous les équipements a utiliser pendant
la procédure pour vous assurer qu'’ils fonctionnent correctement. Le cathéter a été
inspecté et stérilisé a I'oxyde d’éthylene avant d’étre livré. Avant toute utilisation,
inspectez le cathéter et son emballage pour vous assurer de I'absence de dommages
ou de trous sur les emballages stériles.

infrared»:
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A Conservez les cathéters emballés dans un endroit frais et sec.

ATTENTION
N’entortillez ou ne courbez pas fortement (>45°) le cathéter a
aucun moment. Cela peut entrainer une défaillance du cable de
lecteur.

ATTENTION

3.9 Respect des normes de sécurité

L'utilisation d’accessoires non approuvés peut entrainer le non-

respect par le Makoto Intravascular Imaging System™ d’une ou

plusieurs normes répertoriées dans cette section du manuel.
AVERTISSEMENT

Le Makoto Intravascular Imaging System™ a été congu pour respecter toutes les normes
applicables (CEI, ANSI, ISO, UL, etc.) en matiére d'utilisation en toute sécurité de lasers,
d’ultrasons et d’équipements électriques dans les établissements de santé.

Les accessoires suivants ont été testés et sont compatibles avec le Makoto
Intravascular Imaging System™ : cable de données et vidéo intégré (TVC-10PMC),
cable DVI-D (PN2665), imprimante Bluetooth® (TVC-9BPK) et cable Cat5e blindé
(PN2690). Contactez votre commercial pour passer commande.

Les normes spécifiques incluent notamment :

| Standard ‘ Description
CEI 60601-1:2012 version 3.1 Appareils électromédicaux — Partie 1 :
ANSI/AAMI ES60601-1:2005/(R)2012 exigences géneérales pour la sécurité et les
Canada : CAN/CSA 22,2 N° 60601-1:14 performances essentielles

KS C CEI 60601-1:2008

CEI 60601-1-2:2014 quatrieme version Appareils électromédicaux — Partie 1-2 :
Exigences générales pour la sécurité de
base et les performances essentielles -

infraredy:
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| Standard

‘ Description

CEI 60601-1-6:2010 version 3.0 + A1:2013
CAN/CSA 22,2 N° 60601-1-6:11

CEIl 60601-2-37:2007 version 2.0
CAN/CSA 22,2 N° 60601-2-37:08
KS C CEIl 60601-2-37:2011

CEIl 60825-1:2014

CFR (Code des reglementations fédérales
ameéricaines) titre 21 parties 1040.10 et
1040.11

CEI 62304 : 2006
CAN/CSA-CEI/IEC 62304:14

ISO 10555-1:2013

ISO 10993

ISO 11135:2014 + A1:2018

CEIl 62366:2007 (version 1.0) + A1:2014
CAN/CSA-CEI 62366:14

ISO 15223-1:2016

Norme collatérale : compatibilité
électromagnétique - Exigences et tests

Appareils électromédicaux — Partie 1-6 :
Exigences générales pour la sécurité de
base et les performances essentielles —
Norme collatérale : aptitude a l'utilisation

Appareils électromédicaux — Partie 2-37 :
exigences particuliéres pour la sécurité de
base et les performances essentielles des
équipements de diagnostic et de
surveillance médicaux & ultrasons

Sécurité des appareils a laser — Partie 1 :
exigences et classification des
équipements

Logiciels de dispositifs médicaux —
Processus de cycle de vie des logiciels

Cathéters intravasculaires — cathéters
stériles et a usage unique — Partie 1 :
exigences générales

Evaluation biologique des dispositifs
medicaux

Stérilisation des produits médicaux —
Oxyde d’éthylene

Dispositifs médicaux — Application de
I'ingénierie de I'aptitude a I'utilisation aux
dispositifs médicaux

Dispositifs médicaux — Symboles a utiliser
avec les étiquettes des dispositifs

médicaux, I'étiquetage et les informations
a fournir — Partie 1 : Exigences générales.
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4 Description du systeme

AVERTISSEMENT

Le Makoto Intravascular Imaging System™ fournit une imagerie intravasculaire basée
sur un cathéter a I'aide des technologies IVUS et NIRS. Le systeme utilise a la fois le
son et la lumiére pour caractériser les caractéristiques intravasculaires.

Contr6leur
du Makoto

Console du Makoto (mobile)

Cathéter d’'imagerie
IVUS+NIRS
Dualpro™

infraredx (TVC-C195-42)

Figure 4-1 : console mobile du Makoto Intravascular Imaging System™ équipée du cathéter d’'imagerie IVUS+NIRS
Dualpro™ doté d’'Extended Bandwidth.
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Le systéme comprend trois composants majeurs :

e la console mobile du Makoto Intravascular Imaging System™ ;
e e controleur du Makoto™ ;

e le cathéter d'imagerie IVUS+NIRS Dualpro™ doté d’Extended Bandwidth™
(consultez les instructions d'utilisation du cathéter).

Le systeme posseéde deux composants mineurs :

o la barriére stérile du contrdleur du Makoto™ (emballée avec le cathéter) ;

o les accessoires d’amorcage du cathéter Dualpro™ (comprend des seringues
d’amorcage, emballées avec le cathéter).

4.1 Laconsole mobile du Makoto Intravascular Imaging System™

La console mobile du Makoto Intravascular Imaging System™ ou la console du
Makoto™ contient de nombreux composants majeurs du systéme.

La console du Makoto™ integre un module d’alimentation qui fournit I'énergie aux
différentes parties du systeme. Le module d’alimentation alimente les écrans, l'unité
centrale de traitement (CPU), le laser et le controleur du Makoto™.

Le CPU est intégré dans la console du Makoto™. Le CPU geére, stocke et restitue les
données enregistrées avec le controleur et le cathéter du Makoto™. Il contrdle
également la fonction des interfaces utilisateur graphiques fournies a l'utilisateur. Le
systeme contient un lecteur de données capable de stocker environ 1 000 scans. Les
données peuvent étre exportées du systéeme sur des disques optiques (disque DVD ou
Blu-Ray), une clé USB ou un emplacement réseau via un cable Ethernet.

Le systeme peut étre configuré pour envoyer des données aux réseaux PACS.
Il n’est PAS recommandé d'utiliser le Makoto Intravascular
Imaging System™ comme un lieu d’archivage permanent des
données. Les données de scans doivent étre archivées sur
ATTENTION  d'autres supports et supprimées du disque dur du systéme.

La source de lumiére laser pour la réalisation de NIRS est intégrée dans la console. La
lumiere est fournie par un cable a fibre optique au contréleur Makoto™ ou le cathéter
est branché pendant l'utilisation. C’est ce faisceau de lumiere qui permet au systeme de
générer un chemogram ou une carte de probabilité des plaques d’intérét contenant un
ceeur lipidique.
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Ecran du
médecin

Ecran du poste
de travail du
technicien

Roulettes a

frein de

direction .
Roulettes a
frein de
position

Figure 4-2 : Makoto Intravascular Imaging System™ (TVC-MC10).

La console intégre deux écrans. Le premier, celui du médecin, est orienté vers
'opérateur stérile pendant I'utilisation. Le second écran tactile, celui du poste de travalil
du technicien, est orienté vers le technicien non stérile ou I'opérateur circulant pendant
I'utilisation. Cette disposition permet a I'opérateur non stérile d’annoter des données
tout en fournissant a I'opérateur stérile une vue dégagée sur I'écran.

L’écran du médecin est un moniteur FHD 1080p de 21,5 pouces (1920x1080p).
L’inclinaison et le pivotement de I'écran peuvent étre ajustés pour fournir un angle de
vision optimal au médecin stérile.

L’écran du poste de travail du technicien est un moniteur tactile capacitif FHD 1080p de
15,6 pouces (1920x1080p). La rotation, I'inclinaison et le pivotement de I'écran peuvent
étre ajustés pour permettre un angle de travail confortable.
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Lecteur de supports
optiques Blu-Ray

Figure 4-3 : panneau d’interface du c6té gauche du Makoto Intravascular Imaging System™ (TVC-MC10) intégrant les

ports USB 3.0 et le lecteur de supports optiques Blu-Ray.

PACS
Bouton

d’alimentation
Radiographie
Sortie vidéo

Figure 4-4 : panneau d'interface du coté droit du Makoto Intravascular Imaging System™ (TVC-MC10) intégrant le bouton

d’alimentation et les ports de sortie vidéo, PACS et d’intégration de la radiographie.

La console du Makoto™ est également configurée pour exporter un signal vidéo
couleur de 1920x1080p (au format 16:9) a I'aide d’'un cable vidéo DVI-D blindé. La

résolution vidéo exportée peut étre configurée en option sur 1600x1200 (au format 4:3).

En plus de I'écran du poste de travail du technicien, les utilisateurs peuvent interagir

avec le systéme en utilisant la souris fournie. Cette souris est située sous I'écran du
poste de travail du technicien.

Le systéme est équipé de deux roulettes a frein directionnelles pour faciliter le transport

et de deux roulettes a frein supplémentaires pour maintenir en place ou entreposer
le systeme.
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4.2 Interface utilisateur graphique du Makoto Intravascular Imaging
System™

Les fonctions du Makoto Intravascular Imaging System™ sont commandées grace aux
interfaces utilisateurs graphiques du logiciel : le mode Acquisition et le mode Révision.

A 4

Basculement
entre les modes
du Makoto

JEEE

Figure 4-5: mode Acquisition.

9k & A(%H((S

Figure 4-6 : mode Révision.

4.2.1 Mode Acquisition

Le mode Acquisition est un mode de fonctionnement dans lequel de nouvelles données
peuvent étre enregistrées par le Makoto Intravascular Imaging System™. Il se compose
de quatre phases différentes : « Setup » (Configuration), « Prime » (Amorcage),

« Scan » (Numeérisation) et « Close » (Fermeture). En utilisant la barre de progression,
I'opérateur peut se déplacer facilement et rapidement entre les phases pour s’adapter
au rythme de la procédure.
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Barre de Basculement entre
progression les modes du
Makoto

Setup : Prime

40 E{1]
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Figure 4-7 : affichage du mode Acquisition en mettant I’'accent sur la commande de la barre de progression de la
procédure pour changer de phases et la commande de basculement du mode du Makoto pour changer de modes de
fonctionnement. La phase « Scan » (Numérisation) du mode Acquisition est active et le basculement du mode du Makoto
vers le mode Révision est désactivé dans I'image.

La barre de progression décrit les différentes étapes ou phases de I'acquisition des
données et fournit également une commande pour changer de phases. Touchez les
différents noms de phase pour passer a la phase désirée.

REMARQUE : Les phases du mode Acquisition peuvent se dérouler dans
n’'importe quel ordre. Chaque étape peut étre ignorée puis
reprise si cela est nécessaire ou plus pratique.

Touchez la commande de basculement du mode du Makoto, I'icbne « Review »

(Révision) ikl pour accéder au mode de fonctionnement Révision. Cette action ne
peut étre réalisée que si aucune procédure active n’est en cours. Toute procédure
active doit étre fermée avant de changer de modes.

4.2.1.1 La phase « Setup » (Configuration)
La phase « Setup » (Configuration) permet a I'opérateur de saisir des informations sur le
patient et la procédure pour faciliter 'archivage et la récupération ultérieure pour révision.

infraredy:

A N NIPRD COMPANY

IFU0163rJ.fr (2021-05-05) 4-6



Makoto Intravascular Imaging System™
Guide d’utilisation

Des précautions doivent étre prises lors de la saisie des
informations sur le patient pour en assurer I'exactitude.

ATTENTION

Setup + Prime

11/04/1973

smith, Joe J 11/03/1961

Figure 4-8 : phase « Setup » (Configuration) du mode Acquisition.

REMARQUE : Les données de scans peuvent étre enregistrées avant la fin
de la phase « Setup » (Configuration).

Les informations sur la procédure et le patient peuvent étre configurées manuellement
ou en sélectionnant les données déja présentes dans le systeme ou la liste de travail
des modalités. L'utilisation des fonctions d’achévement semi-automatiques peut réduire
les erreurs de transcription et améliorer I'exactitude des informations saisies.

REMARQUE : L'utilisation des fonctions d’achevement semi-automatiques
peut réduire les erreurs de transcription et améliorer
I'exactitude des informations saisies.

REMARQUE : La phase « Setup » (Configuration) n’est pas accessible
pendant la numérisation active.

Consultez la section 7 pour obtenir des informations plus détaillées sur la configuration

de la procédure.
Consultez la section 13.4 pour plus d’informations sur la configuration des connexions

de la Liste de travail de modalité.
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4.2.1.2 La phase « Prime » (Amorgage)

Le cathéter stérile doit étre amorcé conformément au document
contenant les instructions d’utilisation inclus dans I'emballage du
cathéter.

AVERTISSEMENT

Le suivi des conseils d’'amorcage supplémentaires a I'écran ne
remplace pas la formation a l'utilisation du Makoto Intravascular
Imaging System™,

AVERTISSEMENT

La phase « Prime » (Amorcage) donne des conseils a I'opérateur sur le processus
d’amorcage d’un cathéter et le branchement du cathéter sur le contréleur du Makoto™.

03/11/2015 Sample, Delta DOB 01/01/1954 Setup » Prime » Scan » Close

1. Prime

3. Flush
® Prim

ime with 0.5 mi saline before test or use

Figure 4-9 : phase « Prime » (Amorgage) du mode Acquisition.

REMARQUE : Appuyez sur le bouton « Mark » (Marque) sur le contrdleur du

Makoto™, K oK , pour passer a la prochaine phase.

REMARQUE : La phase « Prime » (Amorgage) n’est pas accessible pendant
la numérisation active.
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Consultez la section 8 pour obtenir plus d’'informations sur le branchement du cathéter et
les instructions d’utilisation fournies avec le cathéter pour plus de détails sur 'amorcage.

4.2.1.3 La phase « Scan » (Numérisation)

La phase « Scan » (Numérisation) de la procédure permet a I'opérateur d’enregistrer
des données de scans IVUS et NIRS pendant la procédure en cours. L’opérateur peut
egalement relire, réviser, supprimer, mesurer, annoter et modifier la vitesse du prochain
retrait pendant la procédure en cours lorsque I'imagerie active n'a pas déja commencé.

Cette phase inclut de nombreux affichages de données d’'imagerie complexes, y
compris le chemogram, le chemogram au niveau du bloc, le halo du chemogram, les
images IVUS transversales et longitudinales.

Les deux ensembles d’informations, NIRS et IVUS, enregistrés par le Makoto
Intravascular Imaging System™ sont coenregistrés et peuvent étre révisés en utilisant
la lecture synchronisée.

Halo du
chemoaram

Chemogram

Bloc du
chemogram

Chemogram au
niveau du bloc

IVUS

IVUS longitudinale

transversale

Figure 4-10 : phase « Scan » (Numérisation) du mode Acquisition avec les affichages principaux des informations sur
I'image indiqués.

La phase « Scan » (Numérisation) permet également d’accéder aux fonctions d’annotation
et de mesure disponibles pendant une procédure active. Les scans peuvent étre
renommes, annotes et avoir des cadres individuels marqués pour étre facilement
récupérés en vue de leur révision. Des mesures du cadre peuvent également étre prises.
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Mesure du
cadre
Annotation
du cadre Commande de
sélection de
cadre épais
« Mark »
(Marque) Commande de
mesure de la
Capture longueur / région
d’écran
Commande des
Commande )
vignettes de
de lecture
marque
Commande de S ‘l 1’_ > ¢
sélection de e B 25
cadre fin

Figure 4-11 : phase « Scan » (Numérisation) du mode Acquisition avec les commandes de base indiquées.

Consultez les sections 9 et 10 pour obtenir des informations plus détaillées sur
I'acquisition, la navigation et la mesure de scans.

4.2.1.4 La phase « Close » (Fermeture)
La phase « Close » (Fermeture) de la procédure permet a I'opérateur d’examiner un
résumé des données obtenues pendant une procédure avant l'archivage sur le systeme.

Il est important de terminer la phase « Close » (Fermeture) pour chaque procédure
avant de mettre le systéme hors tension.

- JE )

Figure 4-12 : phase « Close » (Fermeture) du mode Acquisition.
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REMARQUE : Commencer une nouvelle acquisition a partir du contrdleur du
Makoto™ fera automatiquement retourner le mode Acquisition
a la phase « Scan » (Numérisation).

REMARQUE : Vous devez entrer les informations minimales requises du
patient et de la procédure sur I'écran de la phase « Setup »
(Configuration) pour terminer la phase « Close » (Fermeture).

REMARQUE : Les procédures qui n'ont pas été fermées avant l'arrét du
systeme sont accessibles depuis le mode Révision. La
procédure peut étre reprise avant d’étre fermée et archivée.

Consultez la section 11 pour obtenir des informations plus détaillées sur la fermeture de
la procédure.

4.2.2 Mode Révision

Le mode Révision se compose de deux phases : la phase « Select » (Sélection) et la
phase « View » (Visualisation). Ces phases permettront a l'utilisateur de sélectionner
une procédure, puis de la visualiser ou de I'exporter pour la visionner plus tard.

Barre de Basculement entre les
progression modes du Makoto

Select ; View @ X

Scan || Settings

Scan Time | Scan Name Scan Type Archive Status

B 143250 RCA Pullback ¢

Figure4-13 : mode Révision avec la barre de progression et les commandes de basculement du mode du Makoto
mises en évidence.

Touchez la commande de basculement du mode du Makoto, I'icéne Scan Elll, pour
accéder au mode de fonctionnement Acquisition. Cela peut étre fait a n’importe quel
moment dans la phase « Select » (Sélection) du mode Révision.
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4.2.2.1 La phase « Select » (Sélection)

La phase « Select » (Sélection) permet a I'opérateur de rechercher et de choisir des
procedures précédemment enregistrées pour la visualisation, la modification, la
suppression, I'impression ou l'archivage sur d’autres supports.

Vue
Sélection
de scans o
Sélection de marques
Sélection d Exportation et
élection de .
archivage
procédures
Historique Importation
de scans

Figure 4-14 : phase « Select » (Sélection) du mode Révision.

Pendant cette phase, les données correctement formatées peuvent étre sélectionnées
a partir d’autres supports a importer dans le Makoto Intravascular Imaging System™,

Consultez la section 12 pour obtenir des informations plus détaillées sur les fonctions
de sélection, d’exportation et d’importation.

4.2.2.2 La phase « View » (Visualisation)

La phase « View » (Visualisation) fournit de nombreuses commandes similaires a celles
trouvées pendant la phase « Scan » (Numérisation) du mode Acquisition. Dans cette
phase, les données peuvent étre révisées, analysées, annotées et supprimées en
utilisant des commandes habituelles telles que décrites dans la section 10.
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Figure 4-15 : phase « View » (Visualisation) du mode Révision.

REMARQUE : Les données d'une seule procédure peuvent étre consultées
a la fois.

Touchez la commande de basculement du mode du Makoto , I'icbne « Review »

(Révision) ik, pour revenir & la phase « Select » (Sélection) du mode Révision.

4.3 Le controleur du Makoto™

Le contrdleur du Makoto™ (voir ci-dessous) désigne l'interface entre le cathéter et la
console du Makoto™. La poignée du cathéter est insérée dans une douille sur la face
avant du contr6leur, puis tournée pour terminer les branchements physiques, optiques
et électriques. Ces branchements permettent a I'unité d’actionner simultanément le
noyau d’'imagerie interne et de stabiliser la gaine externe du cathéter. Le mode de
retrait du contrdleur du Makoto™ permet une rotation automatique a environ

1 800 tr/min et un mouvement longitudinal distal a proximal & une vitesse de 0,5, 1,0, et
2,0 mm/s. Le noyau d’'imagerie du cathéter peut effectuer un retrait automatique continu
dans la direction distale a proximale sur une longueur totale de 150 mm.
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4.3.1 Indicateurs

Figure 4-16 : contrdleur du Makoto™.

Le contrdleur du Makoto™ est équipé d’'un écran LCD qui fournira des messages sur le
statut et des graphiques a l'utilisateur.

Type de cathéter

'r: L I lllll E u - u bl 5 \nlwi;isvzemdeent

Position, « READY »
(PRET)
P = proximale
-
Position relative, F-

icone « READY » H LI—.—l

(PRET)

Mode Acquisition

D = distale

AT 2.0 [

enregistrée depuis

6 2 la derniére marque
Echelle relative

| MM

[ 4

Enregistrement

Plage totale 3 'r'i P Plage enregistrée
enregistrée A | LLis—— — i i€
9 depuis la derniére
marque

Figure 4-17 : les indicateurs de I'’écran LCD du contréleur du Makoto™ pendant I'acquisition d’'IVUS en direct en position
« READY » (PRET) (en haut) et pendant I'acquisition de retrait automatique (en bas).

Le contrdleur identifie pour l'utilisateur deux positions importantes pour I'opération : la
position « READY » (PRET) et la position « 0,0 mm ».
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Cette position est la position la plus distale que la douille du
cathéter du contrdleur du Makoto™ peut atteindre. Cette position
indique I'emplacement ou le contréleur est prét a ce que
l'utilisateur « LOAD » (CHARGE ou branche) ou décharge
(débranche) correctement un cathéter ou commence l'imagerie. Il
s’agit également de la position dans laquelle la fenétre de
transmission du cathéter branché est la plus résistante a la torsion
liée a la poussée et est préte a étre suivie sur un fil-guide.

Icone de la position

/ « READY » (PRET).

40 30 20 10 |C
SNAERERRN RN ARRRRR NN | B

Figure 4-18 : quand le contrdleur du Makoto™ est en position « READY » (PRET), I'icbne « READY » (PRET) s’affiche a

« 0,0 mm »

droite de I'écran de la console du Makoto ™.

Cette position est 'emplacement de départ de I'imagerie
ininterrompue continue pendant un scan IVUS en direct transféré.
La position « 0,0 mm » est d’environ 5 mm proximale a la position
« READY » (PRET). Les images IVUS transversales ne peuvent
pas étre visionnées ou enregistrées dans les emplacements situés
entre « READY » (PRET) et « 0,0 mm ».

Comme indiqué dans la Figure 4-17, I'écran LCD du contrdleur du Makoto™ est utilisé
pour communiquer d’'importantes informations sur les capteurs, les modes de
fonctionnement et les statuts :

Type de cathéter Ce symbole apparait pour indiguer qu’un cathéter IVUS +

NIRS a été branché sur le contréleur.

Mode Acquisition Cet indicateur affiche « LIVE » (DIRECT), « AUTO » ou rien

Vitesse de
mouvement

« READY »

pour indiquer le mode d’acquisition d’images actuel du
systeme.

Cet indicateur communique la vitesse actuelle de transfert
guand l'acquisition d'images est en cours. Quand aucune
acquisition d’'images n’est en cours, la vitesse de mouvement
communique le paramétre de commande de la vitesse du
prochain retrait (consultez la section 9.2.1).

Quand I'écran affiche « READY » (PRET), cela indique que

infraredy:

A N NIPRD COMPANY

IFU0163rJ.fr (2021-05-05) 4-15



Makoto Intravascular Imaging System™
Guide d'utilisation

(PRET) le systéme est en position « READY » (PRET) ou dans la
position la plus distale que l'utilisateur peut atteindre en faisant
fonctionner le contréleur du Makoto™.

Echelle relative  La plage d’acquisition d’images continue, de 0,0 & 150,0 mm,
est indiquée sur le contréleur avec des démarcations a
50,0 mm et a 100,0 mm.

Position relative  Quand le contréleur du Makoto™ est déplacé de maniere
proximale & partir de la position « READY » (PRET),
I'emplacement actuel de la pointe d’'imagerie est représenté
par une ligne verticale sur I'échelle relative.

P

Figure 4-19 : indicateur de la position relative pendant aucune imagerie (en haut), une IVUS en direct (au milieu) et un
retrait (en bas).

Position/Distance En imagerie Live IVUS ou Pullback, la distance affichée
désigne la distance entre le début de I'imagerie et la marque
la plus récente en millimétres. Lorsque le dispositif n’est pas
en mode d’imagerie, la position actuelle de la pointe
d’'imagerie apparait.

Enregistrement  L’indicateur d’enregistrement apparait lorsque le systéeme
enregistre les images affichées sur I'opérateur.

Plage enregistrée La plage d’enregistrement de I'lVUS en direct actuel ou de
I'acquisition de retrait automatique est représentée par un
rectangle plein. Les translations des acquisitions IVUS en
direct apparaissent en blanc et les acquisitions de retrait
automatiques apparaissent en vert, la partie pleine indiquant
la plage enregistrée depuis la derniére marque.
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)

Figure 4-20 : Plage enregistrée pendant I’acquisition en cours : IVUS en direct avec position actuelle identique a la
position de départ (1" ligne), IVUS en direct enregistrée avec position actuelle proximale a la derniére pression du bouton
« Mark » (Marque) (2° ligne), retrait automatique sans marque (3¢ ligne), retrait automatique avec barre pleine indiquant la

plage enregistrée depuis la derniére marque (4° ligne).

« LOAD » Ce message indique que le contréleur du Makoto™ est en
(CHARGER) position « READY » (PRET) et qu’un cathéter peut étre chargé
dans la douille.

>3L0AD

DA D | | P|

Figure 4-21: I’écran LCD du contréleur du Makoto ™ indiquant le statut « LOAD » (CHARGER).

« TURN » Ce message indique que le contréleur du Makoto™ a détecté
(TOURNER) un mauvais branchement de la poignée du cathéter.

*ITURN

DA D | | |

Figure 4-22 : I’écran LCD du contréleur du Makoto™ indiquant une instruction de tourner la poignée du cathéter.

« WAIT » Le contréleur du Makoto™ attend que la console du Makoto™
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(ATTENDRE) et I'interface utilisateur du logiciel soient initialisées.

oWAIT

Figure 4-23 : I’écran LCD du contréleur du Makoto™ indiquant d’attendre que le systeme termine de démarrer par le statut
« WAIT » (ATTENDRE).

Le non-respect des avertissements écrits peut entrainer une

situation dangereuse pouvant blesser le patient ou I'opérateur.
AVERTISSEMEN
T

« SEE DISPLAY »

(VOIR LECRAN) Le contréleur Makoto™ a détecté une erreur ou une
défaillance. Ce message invite 'opérateur a consulter les
écrans du Makoto Intravascular Imaging System™ pour
obtenir des instructions plus détaillées.

A\SEE

DISPLAY

7 3

Figure 4-24 : Message d’erreur (gauche) et message de défaut interne (droite) du contréleur Makoto™. Dans les deux cas,
I'utilisateur est invité a consulter I'écran du systéme pour corriger I’erreur ou le défaut.

Remargue : Sile message « See Display » (Voir I'écran) apparait a plusieurs reprises
apres avoir suivi les indications a I'écran, contactez votre fournisseur de
services local ou le service clientéle Infraredx pour obtenir de l'aide.
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4.3.2 Commande du mode Acquisition

AVERTISSEMEN
T

AVERTISSEMEN
T

AVERTISSEMEN
T
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ximal len
I ] ] N
L

Retour en
position

« READY »
(PRET)

Distal rapide

Figure 4-25 : boutons des fonctions du contréleur du Makoto™, deux modeles disponibles (ci-dessus et ci-dessous)).

Le contréleur du Makoto™ est équipé de boutons simples permettant a l'utilisateur de
commander le mouvement du systéme et I'acquisition de données.

Retour en position

« READY » (PRET) Ce bouton déplacera automatiquement le noyau d’'imagerie
du cathéter depuis son emplacement actuel vers la position
« READY » (PRET) la plus distale. Cette position du noyau
est nécessaire avant de déplacer le cathéter dans le patient
ou de le brancher ou débrancher.

« STOP » (ARRET) Ce bouton arréte le mouvement du contréleur du Makoto™
et toute collecte de données en cours.

Retrait Ce bouton déclenche la rotation automatique et le retrait
automatique d’un cathéter branché. La vitesse de rotation
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est réglée a environ 1 800 tr/min, mais la vitesse de retrait
correspond a la vitesse sélectionnée sur la console du
Makoto™ (0,5, 1,0, ou 2,0 mm/sec).

A partir de « READY » (PRET) : une pression et un
relachement du bouton de retrait déplacent le noyau d’'imagerie
a la position « 0,0 mm » et démarrent I''VUS en direct pour
pouvoir visionner un apercgu de I'emplacement d'imagerie de
départ du scan. Appuyez a nouveau sur le bouton de retrait
pour lancer le scan. Maintenir enfoncé le bouton de retrait en
position « READY » (PRET) permet d'ignorer I'apercu et de
commencer le mouvement et I'enregistrement automatiques.
Le bouton peut étre relaché lorsque I'écran indique que
limagerie « AUTO » a commencé.

A partir de la position 0,0 mm : une pression et un
relachement du bouton de retrait déclenchent un
mouvement immédiat et I'enregistrement du scan.

Vous pouvez appuyer sur le bouton de retrait,
pendant que le contréleur du Makoto™ est immobile ou gu'il
tourne pendant une acquisition d’'IVUS en direct.

Enfoncer une fois ce bouton permet de déclencher la
rotation automatique du noyau d’imagerie du cathéter (sans
retrait). Une image IVUS transversale en direct apparait sur
I'écran de la console du Makoto™.

Enfoncer plusieurs fois le bouton d’'IVUS en direct, E
permet d’activer ou de désactiver un enregistrement de
I'acquisition IVUS en direct en cours. Cette action n'arréte
pas la rotation du noyau d’imagerie du cathéter.

Ce bouton met en signet un cadre ou une position dans un
scan pour une référence ou une révision ultérieures.

Pendant I'acquisition d'images, ce bouton remet I'affichage
du contrbleur & zéro. La distance affichée par la commande
sera mesurée a partir de I'endroit de la derniere pression sur
le bouton « Mark » (Marque).

infraredy:

A N NIPRD COMPANY

4-21



Makoto Intravascular Imaging System™
Guide d’utilisation

Pendant I''VUS en direct non enregistrée, ce bouton
enregistre un seul cadre IVUS.

Pendant la phase « Prime » (Amorcage) du mode
Acquisition, ce bouton fait passer le systeme a la phase
« Scan » (Numérisation).

Distal rapide Maintenir enfoncé ce bouton déplace le noyau d’'imagerie du
cathéter de maniere distale a une vitesse de 10 mm/s.

Appuyer sur ce bouton et le relacher déplace le noyau
d’'imagerie du cathéter de maniere distale d’une distance
fixe de 0,5 mm.

Distal lent Maintenir enfoncé ce bouton déplace le noyau d’'imagerie du
cathéter de maniére distale a une vitesse de 2 mm/s.

Appuyer sur ce bouton et le relacher déplace le noyau
d’'imagerie du cathéter de maniere distale d’une distance
fixe de 0,1 mm.

Proximal lent Maintenir enfoncé ce bouton déplace le noyau d’'imagerie du
cathéter de maniere proximale a une vitesse de 2 mm/s.

Appuyer sur ce bouton et le relacher déplace le noyau
d’'imagerie du cathéter de maniére distale d’'une distance fixe
de 0,1 mm.

Proximal rapide Maintenir enfoncé ce bouton déplace le noyau d’'imagerie du
cathéter de maniere proximale a une vitesse de 10 mm/s.

Appuyer sur ce bouton et le relacher déplace le noyau
d’'imagerie du cathéter de maniére distale d’'une distance fixe
de 0,5 mm.

4.4 Cathéters d'imagerie compatibles

Les cathéters d'imagerie compatibles sont emballés séparément et sont stérilisés pour un
usage unique. Veuillez consulter les instructions d’utilisation fournies avec le cathéter
pour obtenir plus d’informations sur le cathéter ainsi que sa préparation et son utilisation.
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4.5 Spectroscopie par proche infrarouge (NIRS)

Le Makoto Intravascular Imaging System™ est congu pour identifier les plaques
d’intérét contenant un cceur lipidique par le sang dans les arteres coronaires d’'un cceur
qui bat par l'intermédiaire d’'un cathéter coronaire de numérisation. Le systeme utilise la
spectroscopie par proche infrarouge (NIRS) pour identifier la composition chimique de
la paroi artérielle comme aide au cardiologue interventionnel dans I'évaluation des
plaques coronaires. La base fondamentale de cette capacité d'imagerie est le principe
de la spectroscopie de réflectance diffuse, qui est bien établi et utilisé dans de
nombreuses disciplines scientifiques.

En résumé, la lumiére NIR incidente est diffusée et absorbée par le tissu et la lumiéere
réfléchie contient des informations sur la composition du tissu en fonction de ses
propriétés d’absorption et de diffusion. Ces propriétés d’absorption et de diffusion sont
régies par la composition chimique et la morphologie du tissu.

4.5.1 Chemogram

Apres un retrait du noyau d’imagerie du cathéter par I'artére, le logiciel du systeme
affiche une représentation graphique, sous la forme d’'une carte, indiquant la probabilité
gu’une plaque d’intérét contenant un cceur lipidique (PCL) soit présente. Cette carte est
appelée chemogram. Il fournit une image de l'artere qui indique la probabilité de trouver
une plaque d’intérét contenant un ceceur lipidique a un endroit particulier du scan. Une
forte probabilité est affichée en jaune et la probabilité décroissante passe
progressivement au rouge.

4.5.2 Lecture del’écran du chemogram

Pendant I'acquisition de données en temps réel, la carte de détection du fil-guide
identifie 'emplacement de I'artefact produit par un fil-guide numérisé et aide le médecin
a identifier les artefacts d’images dans les données spectroscopiques. A la fin d’un scan
de retrait, le moniteur du Makoto Intravascular Imaging System™ affiche deux cartes de
pseudo-couleur de la paroi artérielle. Ces cartes sont le chemogram et le chemogram
au niveau du bloc. Le chemogram et le chemogram au niveau du bloc indiquent les
zones de l'artére coronaire étant susceptibles de contenir des plagues d’intérét
contenant un cceur lipidique.

Les vues longitudinales de I'écran représentent le scan de droite a gauche (distal a
proximal). L’axe x indique que la distance de retrait en millimetres de I'extrémité distale
de la fenétre de transmission du cathéter. L’axe y dans le chemogram et la carte de
détection du fil-guide correspondent a la position angulaire relative des caractéristiques
de la paroi vasculaire en degrés (la position angulaire de départ par rapport a la paroi
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est arbitraire). La partie du scan située a I'intérieur du cathéter-guide peut étre indiquée
en gris uni sur les extrémités proximales du chemogram et du chemogram au niveau du
bloc, si le systéme détecte que le scan a été inséré dans le cathéter-guide.

Le chemogram est coloré dans une échelle de couleur allant de rouge a jaune, d’'une
faible probabilité a une forte probabilité de présence de lipides. La couleur jaune
apparait a l'utilisateur lorsque la probabilité de présence de lipides dépasse 0,6
n’importe ou sur I'écran. Un masque semi-transparent noir apparait sur le chemogram
dans les zones ou I'algorithme de détection de PCL a déterminé I'existence d’un faible
signal ou d’une autre interférence.

Le moniteur du systéme affiche les résultats de 'indice de masse du cceur lipidique
(LCBI) & gauche du chemogram. Le LCBI est un rapport entre les scores de probabilité
des lipides positifs (>0,6) et les scores de probabilité de lipides valides totaux dans la
plage sélectionnée du chemogram, sur une échelle de 0 a 1 000 (masse du cceur
lipidique faible a élevée) dans un segment défini. Dans des études (consultez la
section 17.2 de I'annexe B) portant sur des échantillons d’autopsie déterminés
histologiqguement, il a été démontré qu'’il existait une corrélation entre le LCBI et la
présence et le volume de fibroathérome dans l'artére.

Emplacement

LCBI du LCBI max.
LCBI max Région
sélectionnée
pour le LCBI

Figure 4-26 : le LCBI régional et maximal pour la région sélectionnée s’affichent a gauche dans le chemogram.

Le logiciel affichera le LCBI maximal d’'une fenétre de longueur fixe (4 mm par défaut)
dans un segment et indiquera la position dans la région.

LCBI Lipid Core Burden Index (Indice de masse du cceur lipidique)
calculé pour chaque retrait et dans des régions définies par
l'utilisateur.

LCBI max. Lipid Core Burden Index calculé sur une largeur spécifiée
dans un retrait total ou une région numérisée spécifiée par
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I'utilisateur. La valeur maximale trouvée sera présentée a
I'utilisateur.

Le chemogram du niveau du bloc, qui améliore le chemogram, est affiché au centre de
la vue IVUS (écographie intravasculaire) longitudinale et se trouve sans dimension dans
la direction y. Le bloc chemogram associé au support affiché actuellement apparaitra
au centre de la vue IVUS transversale. Le chemogram du niveau du bloc est divisé en
deux grands blocs de 2 mm et résume I'ensemble des résultats prédictifs valables dans
le segment correspondant du chemogram. Le chemogram du niveau du bloc est
représenté par 4 couleurs allant de la probabilité la plus forte a la plus faible : jaune,
brun, orange et rouge. Si le nombre de pixels dans le bloc du chemogram affecté par
une interférence ou un signal faible dépasse 25 %, alors la couleur du bloc est noire.

REMARQUE : Sile pourcentage de spectres trop faibles pour contribuer a la
génération du chemogram dépasse 12 %, aucun chemogram ne sera
génere.
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4.6 Ultrason intravasculaire

Le Makoto Intravascular Imaging System™ est congu pour identifier la paroi de la
lumiére et de la cuve, a travers le sang, dans les artéres coronaires d’'un cceur en
battement par cathétérisme et coronarographie. Le systeme utilise des ultrasons pour
analyser les limites de la paroi de la lumiere et de la cuve de l'artere et aide le
cardiologue chargé de l'intervention a évaluer les plaques d’athérome. Les ultrasons
peuvent identifier d’autres particularités de I'artere comme des stents implantés et
d’autres particularités des plagues d’athérome comme la calcification.

Cette information est analysée par I'envoi d'impulsions sonores a la paroi de la cuve
depuis I'extrémité de I'imagerie du cathéter et la réception de I'écho. Les
caractéristigues morphologiques de I'artere absorbent et renvoient le son différemment.
Ces signaux s’affichent ensuite a I'écran pour I'interprétation.

Avec des images d’angiographie, les analyses de la progression de la |ésion peuvent
étre réalisées en comparant deux diametres dans la zone d’intérét. Généralement, ces
diameétres sont sélectionnés depuis un emplacement de référence et 'emplacement
avec le plus petit diametre de lumiére dans la zone ciblée. La réduction de ce diamétre
est désignée par une sténose. L'utilisation de I'angiographie pour analyser les
diametres d’'une projection unique peut s’avérer difficile au moment d’analyser les
emplacements des Iésions ou de la cible avec des lumiéeres excentriques. L'IVUS
permet de mieux analyser la lumiéere, y compris les lumiéres excentriques.

Comparer la zone de lumiére peut également offrir un moyen supplémentaire d’analyser
la progression d’une Iésion. Le Makoto Intravascular Imaging System™ comparera
deux zones a des emplacements différents pour fournir la lumiére de la zone de
sténose (AS).

AS% = (Zonemax — Zonemin) / ZONemax
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5 Stockage, déplacement et positionnement du
Makoto Intravascular Imaging System

5.1 Déplacement du Makoto Intravascular Imaging System™
Le Makoto Intravascular Imaging System™ est équipé de deux roulettes verrouillables a
I'arriere du systéme et deux roulettes verrouillables directionnelles a I'avant du systeme.

a

Roulettes a
frein de
direction
Roulettes a
frein de
position

Figure 5-1 : Makoto Intravascular Imaging System™.

Débloquez les verrous de toutes les roulettes pour déplacer les manettes des roulettes
vers le haut pour déplacer, tourner ou manceuvrer le systéme dans des espaces réduits.

Remarque : Bloquez les roulettes a verrou directionnel a I'avant du
systeme pour faciliter le transit sur des distances plus
longues.
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Pendant le transit, positionnez les moniteurs en ligne
avec la base du Makoto Intravascular Imaging System™
pour augmenter la visibilité.

5.2 Positionnement pour utilisation

AVERTISSEMENT

AVERTISSEMENT

NE positionnez PAS I'opérateur de la console mobile de Makoto
Intravascular Imaging System™ entre le systeme et un autre
équipement en mouvement dans le laboratoire de cathétérisme.

NE positionnez PAS le Makoto Intravascular Imaging System™
avec les verrous de roulette bloqués dans I'amplitude normale
de mouvement de pieces du systéeme de radiographie ou
d’autres équipements du laboratoire de cathétérisme pendant
son utilisation.

Le Makoto Intravascular Imaging System™ est positionné pour utilisation a proximité du
pied de la table d’opération ou a I'autre bout de la table d’opération par le médecin, a

droite du systeme d’opération de radiographie.

Une fois la position souhaitée du systéme obtenue, engagez les roulettes verrouillables
de position sur le systeme.

AN

ATTENTION

Remarque :

Remarque :

NE repositionnez PAS le Makoto Intravascular Imaging
System™ de maniére a entraver I'acces a la prise €électrique.

Réglez la position d’affichage du médecin sur le Makoto
Intravascular Imaging System™ pour optimiser la visibilité de
'image pendant son utilisation.

Pour éviter tout mouvement accidentel de la console Makoto™,
engagez les roulettes verrouillables de position a I'arriére de
la console.
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5.3 Stockage avant utilisation

Ces instructions NE sont PAS pour un stockage a long terme
du Makoto Intravascular Imaging System™. Veulillez contacter
le service client d’Infraredx ou votre fournisseur de service local

ATTENTION  pour étre guidé sur la maniére de préparer le systéme pour un
stockage a long terme.

Lorsqu’il n’est pas en fonctionnement, le Makoto Intravascular Imaging System™ doit
étre configuré afin de réduire le risque d’endommagement du systeme.

1. Positionnez le contréleur Makoto™ fermement dans le
support a l'arriere du systéeme.

2. Enroulez le cordon du contrdleur Makoto™ soigneusement
et accrochez le crochet supérieur au panneau arriere
du systeme.

3. Enroulez le cordon d’alimentation soigneusement et
accrochez le crochet inférieur a I'arriere du systéme.

4. Engagez les roulettes verrouillables a I'arriére du systeme.

5. Tournez les moniteurs pour les aligner avec la base du
systeme.

En plus des étapes précédentes, sélectionnez un emplacement de stockage facile
d’acceés situé dans une zone de faible trafic ou le risque d’impact avec d’autres
equipements en mouvement (lits, brancards...) est réduit. L’emplacement doit répondre
aux exigences environnementales et physiques définies dans la section 16 de ce manuel.
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6 Alimentation On/Off

6.1 Alimentation On

AVERTISSEMENT

1. Retirez le cordon d’alimentation a 'arriere du systeme. Laissez le reste du
cordon tomber a plat sur le sol tout en tenant la prise.

2. Branchez le systéme a une prise de terre accessible facilement.

Bouton
d’alimentation

Figure 6-1 : panneau latéral et bouton d’alimentation Makoto Intravascular Imaging System ™ sélectionnés.

3. Allumez le systéme en appuyant et en relachant le bouton situé sur le cété de la
console. Cette action alimentera la console du systeme Makoto™ et du
controleur Makoto™.

Une fois le systeme allumé et le logiciel chargé, la phase de configuration du mode
d’acquisition Makoto sera présentée a I'opérateur.
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ATTENTION

Si la prise du cable d’alimentation appropriée a la région
d’utilisation n’est pas équipée d’'une mise a la terre, alors
raccordez un cable de mise a la terre au goujon de terre
équipotentiel situé a 'arriere du Makoto Intravascular Imaging
System™ dans la partie inférieure.

Figure 6-2 : goujon de mise a la terre équipotentiel
situé a l’arriéere du Makoto Intravascular Imaging
System™ a I'extrémité droite de la partie inférieure.

ATTENTION

Pendant le démarrage, la prise de connexion du cathéter du
contrdleur Makoto™ pivotera automatiquement. Si un cathéter
est raccordé pendant le démarrage du systeme, assurez-vous
gue le cathéter a été retiré du patient

Remarque :

IFU0163rJ.fr (2021-05-05)

Si le Makoto Intravascular Imaging System™ est allumé et n’est
pas en position « READY » (PRET), lorsque le systéme I'exige,
veuillez utiliser les contréles de mouvement distal pour faire
avancer I'imagerie distale jusqu’a ce que vous atteigniez la
position « READY » (PRET).
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6.2 Alimentation Off

AVERTISSEMENT

Pour éteindre le Makoto Intravascular Imaging System™, appuyez et relachez le
bouton d’alimentation situé sur le c6té droit de la console.

Si une bréve pression du bouton d’alimentation n’éteint pas le
systeme, laissez le bouton d’alimentation enfoncé (~5
ATTENTION S€condes) jusqu’a ce que le systéme s’arréte.
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7 Configuration des informations du patient et de

la procédure
Dans le mode d’acquisition pendant la phase de configuration, l'utilisateur peur entrer
des informations sur le patient et la procédure afin d’archiver et de faciliter la
récupération dans le cadre d’'une révision ultérieure. Ces informations peuvent étre
insérées au début de la procédure ou a chaque fois avant la fin de la procédure.

Parameétres

Setup

Source de liste
de patients
prévus

« Clear »
(Effacer)

Continuer
Figure 7-1 : phase de configuration du mode d’acquisition dans les contrdles principaux sélectionnés.

Quatre élements d’identification du patient peuvent étre entrés pour chaque procédure.
Il s’agit du nom du patient, de son numéro d’identification, de son genre et de sa date
de naissance. Les champs de données configurés comme « requis » doivent étre
complétés pour fermer la procédure afin de I'examiner ou de I'archiver par la suite.

Nom du patient Le nom du patient peut étre inséré dans le format
suivant : nom, prénom, et initiale du deuxiéme prénom.

Identification du patient  Le numéro meédical enregistré ou le numéro de fichier
du patient.

Genre Le Makoto Intravascular Imaging System™ propose
trois options de genre différentes pour aider & décrire
le patient.

Date de naissance Le jour, mois et année du patient peuvent étre
spécifiés.
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Remarque : Utilisez I'option de genre « Autre » pour I'entrée de patients
anonymes.

Quatre autres champs peuvent étre utilisés pour identifier plus en détail la procédure :

Identification de procédure Le numéro ou code utilisé pour identifier cette
procédure.

Identification d’adhésion |l s’agit d’'une valeur d’identification de la procédure
souvent assignée au moment de I'enregistrement du
patient pour la procédure et qui peut étre utilisée par
le PACS (systéme d’archivage et de transmission
d’'images) afin de vérifier les données transférées.
Cette valeur est généralement insérée
automatiquement lorsque les parametres de liste de
travail de modalité sont utilisés.

Médecin Le nom du médecin chargé de la procédure.

Groupe de cathéter Le numeéro de groupe construit du cathéter utilisé
pendant cette procédure d’'imagerie.

Assurez-vous de linsertion correcte des informations du patient
pour éviter un mauvais étiquetage des données ou une perte

ATTENTION des données de la procédure.

REMARQUE : Les champs requis pour I'identification du patient et de la
procédure peuvent étre configurés dans les parametres, voir
section 13.

Remarque : Insérez le numéro de groupe du cathéter pour acquérir des
données pour insérer automatiqguement le numéro de groupe du
cathéter dans chaque fichier numeérisé lorsqu’il est enregistré.

7.1 Insertion manuelle des informations du patient et de la procédure

L’insertion manuelle des informations du patient et de la procédure peut étre effectuée
avec le clavier du logiciel a I'écran.
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X

Appuyez sur « Clear » (Effacer) ISl pour supprimer les données du patient et de la
procédure dans les champs de configuration puis recommencez.

Remarque : Les champs d’information peuvent étre complétés avant de
fermer la procédure lorsque le systeme n’est pas en train
d’acquérir activement des données d’'image.

7.2 Insertion semi-automatique des informations du patient et de la
procédure

Les données du patient peuvent étre directement insérées dans les champs
fournis tels que décrits ci-dessus. Pour améliorer la cohérence de l'insertion pour
les patients revenus ou prévus, il est possible de sélectionner les informations
dans le répertoire local ou la liste des patients programmeés (liste de travail).

Remarque : Appuyez sur les titres de colonne dans la liste de patients
prévus pour réduire la liste de differentes manieres.

Remarque : Tapez le texte dans le filtre pour réduire la liste aux noms et
identifications du patient allant avec votre insertion. Effacez le
texte ou appuyez sur effacer pour revenir a la liste compléte.

Remarque : La liste des patients locaux apparait par défaut. L’option
« Worklist » apparait lorsque le systéme est configuré sur
connexion de la liste de travail de modalité.

Remarque : Faire un choix dans la liste effacera les données
correspondantes dans les champs Patient et Procédure.

7.2.1 Listing des patients locaux
Le systeme chargera automatiquement les informations du patient des procédures
enregistrées précedemment du systeme dans le listing des patients prévus.

Cliquez sur le nom souhaité dans la liste pour compléter la configuration du nom
du patient, de I'identification du patient, du genre et de la date de naissance.

Les champs de la derniere procédure nécessiteront une insertion manuelle.
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Setup » Prime ) Scan » Close ¥I

Settings

Filter: _ Local Worklist .
o . Source de liste de

Date of Birth | Gender | Patient ID patients prévus
11/15/2015 0 03034

12/30/1950 F 014

Figure 7-2 : phase de configuration avec contréle de sélection pour la source du listing des patients prévus sélectionnée.

7.2.2 Liste de travail de modalité
Si le systéme a été configuré pour charger les informations de la liste de travail de
modalité du systéme d’information de I'hépital (HIS), alors le contenu du listing
des patients prévus peut étre remplacé par un listing des patients locaux dans la
liste de travail de modalité récupérée dans le HIS.

Consultez la section 13 pour configurer les parametres de connexion de la liste de
travail de modalité.

Le systéme récupérera automatiguement tous les détails du patient et de la
procédure pour I'angiographie, « XA », le type de modalité pour la date
d’aujourd’hui et le rend disponible pour la sélection sur le systeme.

Cliquez sur le nom souhaité dans la liste pour compléter la configuration du nom
du patient, de l'identification du patient, du genre et de la date de naissance et les
informations de procédures rendues disponibles par le HIS, tout comme
I'identification d’adhésion.

Les champs de procédure restants devront étre saisis manuellement.

Remarque : Pour actualiser les saisies de la liste de travail de modalité

affichées, alternez entre les options « Local »,
i i ; Norklist
et « Worklist » (Liste de travail) . Worklist]

7.3 Effacer les informations du patient et de la procédure
Pour effacer les informations du patient et de la procédure et recommencer, cliquez sur

« Clear » (Effacer)
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Cette action n’effacera pas les données numérisées de la procédure active.

7.4 Passage ala phase suivante
Aprés avoir inséré les données du patient et de la procédure, pour aller a la phase
« Prime » (Amorcage) du mode Acquisition, cliquez sur « Continue » (Continuer)

-

Continue |

Remargue : Utilisez le contrble de progression pour modifier les phases ;
appuyez sur la phase de votre choix pour passer les phases de
la procédure.

Remarque : Avec un cathéter connecté, en pressant le bouton « Live IVUS »

(IVUS en direct), , le contréleur Makoto™ avancera
immédiatement a la phase « Prime » (Amorcage).

Remarque : Avec un cathéter connecté, en pressant le bouton « Pullback »

(Retrait), , le contréleur Makoto™ avancera
immeédiatement a la phase « Scan ».
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8 Amorce du cathéter et préparation du contrbleur
Makoto™ pour utilisation

La phase suivante de la procédure commence avec I'amorce du cathéter. En paralléle,
le contréleur Makoto™ peut étre placé dans le champ stérile pour utilisation. La
préparation de I'imagerie s’achéve avec la connexion du cathéter au contréleur et en

évaluant la préparation du cathéter.

8.1 Amorce du cathéter

Le cathéter stérile doit étre amorcé et préparé conformément au
document contenant les instructions d’utilisation inclus dans
'emballage du cathéter.

AVERTISSEMENT

ple, Delta DOB 01/01/1954 Prime = Sca

3. Flush
aPrime

ime with 0.5 mi saline before test or use

Figure 8-1: le guidage d’amorce a I’écran proposé dans la phase « Prime » (Amorgage) du mode Acquisition.

Le Makoto Intravascular Imaging System™ proposera un guidage a I'écran dans les
étapes principales pour amorcer un cathéter raccordé au contréleur Makoto™.

Ces étapes sont prévues pour illustrer et augmenter les instructions fournies avec le
cathéter. Cela ne remplace pas la nécessité pour l'utilisateur d’étre forme, et de lire et
de comprendre les instructions d’utilisation fournies avec le cathéter.

A l'aide des illustrations & I'écran, des illustrations fournies avec le cathéter et des
instructions écrites d'utilisation du cathéter, I'opérateur stérile doit amorcer le cathéter.
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8.2 Préparation du contréleur Makoto™
Le contréleur Makoto™ doit étre placé dans une barriére stérile du contréleur Makoto™
avant d'étre place sur la table d’opération.

Veuillez remarquer que les instructions suivantes nécessitent la participation d’un
opérateur stérile et non stérile pour appliquer la barriére stérile et placer le contrbleur
Makoto™ dans le champ d’opération :

AVERTISSEMENT

AVERTISSEMENT

AVERTISSEMENT

AVERTISSEMENT

AVERTISSEMENT
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Les articles stériles NE doivent PAS étre en contact avec le
contréleur Makoto™ jusqu’a I'ouverture de la prise du cathéter
de la barriére stérile du contréleur Makoto™.

AVERTISSEMENT

Ne permettez pas au c6té du couvercle du joint de la barriere
stérile qui a été en contact avec la prise du contréleur Makoto™
d’étre en contact avec I'opérateur stérile.

AVERTISSEMENT

Pour positionner le contrdleur Makoto™ dans le champ stérile, effectuez les étapes
suivantes :

1. L’opérateur non stérile retire la barriere stérile de la boite du cathéter.

2. L’opérateur non stérile ouvre le package contenant la barriere stérile du
controleur Makoto™.

3. L’opérateur stérile retire la barriere stérile du contrdleur Makoto™ de son
emballage, et déplie les deux petits plis de la barriere qui cachent le joint blanc et
le couvercle en plastique bleu.

4. L’opérateur non stérile retire le contréleur Makoto™ du support sur la console,
qui est a I'extérieur du champ stérile.

5. L’opérateur non stérile maintient le contréleur Makoto™ paralléle au sol dans les
airs a proximité du champ stérile tout en tenant la poignée a I'arriere du
controleur.

6. L’opérateur stérile insére sa main droite dans le pli de la barriére stérile du
contrbleur Makoto™ indiqué par une main et une fleche. La barriére doit étre
orientée de maniere a ce que le couvercle bleu de la prise soit aligné avec la
partie supérieure du contréleur Makoto™.

7. La main gauche est insérée dans le pli de I'autre coté de la barriere stérile du
contrdleur Makoto™ également indiqué par une main et une fléche.

8. L’opérateur stérile maintient la barriére stérile du contréleur Makoto™ ouverte.

9. L’opérateur non stérile envoie le contréleur Makoto™ a I'opérateur stérile en
placant le contrdleur dans la barriere stérile du contréleur Makoto™ ouverte.
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10.L’opérateur stérile saisit le contréleur Makoto™ jusqu’a la barriére stérile du
contréleur Makoto™ par les poignées sur le dessus du contrdleur, supportant
tout son poids.

11.L’opérateur non stérile relache ensuite le contréleur puis tient les bords de
I'ouverture de la barriére stérile du contréleur Makoto™ indiqués par des fleches
et tire la barriére pour couvrir le cable ombilical du contréleur Makoto™.

12.L’opérateur stérile place le contréleur Makoto™ fermeé sur la table d’opération.

13.L’opérateur stérile aligne le joint blanc de la barriere stérile du contrdleur
Makoto™ avec la prise du controleur Makoto™ et raccorde le joint de la barriere
a la prise.

14.1’opérateur non stérile doit raccorder la position du cordon pour éviter que la
partie ensachée sorte de la zone de procédure stérile pendant I'utilisation.

Le controleur Makoto™ est désormais prét pour la connexion du cathéter.

Assurez-vous que le joint blanc est fermement raccordé a la
prise du contrdleur Makoto™. Le matériel de la barriere ne doit

ATTENTION Pas géner l'ouverture. Si cela est appliqué correctement, il doit y
avoir un espace entre le joint blanc et la surface avant du
controleur.
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8.3 Connexion du cathéter

Le cathéter stérile doit étre manipulé et préparé conformément
au document contenant les instructions d’utilisation inclus dans
'emballage du cathéter.

AVERTISSEMENT
Ne touchez pas le dessous du couvercle bleu car il pourrait avoir
été en contact avec la prise du contr6leur Makoto™ qui n’est
pas stérile.

AVERTISSEMENT

Les instructions du cathéter fournies dans ce manuel sont uniquement pour les
directives générales. Suivez toujours les instructions pour l'utilisation de la
documentation fournie avec chaque cathéter Infraredx.

Le cathéter doit étre connecté au contrbleur Makoto™ par un opérateur stérile.

Le contrdleur Makoto™ doit étre positionné sur la table du

patient de maniere a ce qu’il y ait un espace suffisant pour que
ATTENTION la connexion du cAatheter soit dlsponlblg et que la prise du

cathéter du contrdleur Makoto™ ne soit pas entravee.

A Ne contaminez pas les faces en fibre du cathéter ou du
contréleur Makoto™ pendant la connexion.
ATTENTION

1. Confirmez que le joint blanc de la barriere du contréleur Makoto™ stérile est
raccordé a la prise du contrbleur Makoto™.

2. Retirez le couvercle bleu de la barriere du contréleur Makoto™ stérile le long des
lignes perforées et placez-le hors du champ stérile.

3. Confirmez que le contrdleur Makoto™ est en position PRET comme indiqué par le
message « LOAD » sur I'écran LCD situé sur la partie supérieure du contréleur.

4. Alignez la poignée du cathéter avec le coté coloré vers le haut.

infrared

A N NIPRD COMPANY

IFU0163rJ.fr (2021-05-05) 8-5



Makoto Intravascular Imaging System™
Guide d’utilisation

5. Insérez la poignée du cathéter dans la prise du cathéter du contréleur Makoto™.

6. Tournez la poignée du cathéter dans le sens des aiguilles d’'une montre jusqu’a

ce que I'écran LCD du contréleur indique que le cathéter est correctement
connecté en observant le message « READY » (PRET).

Remarque : Si le controleur Makoto™ localise une connexion patrtielle du
cathéter, alors les instructions seront indiquées sur I'écran LCD

ou « Voir I'écran » sera indiqué sur I'écran LCD du contrdleur et

des indications supplémentaires détaillées s’afficheront sur
I'écran du systeme Makoto™.

8.4 Test du cathéter

Aprés I'amorce du cathéter comme indiqué dans les instructions fournies avec le
cathéter et la connexion du cathéter au contrdleur Makoto™, la performance du
cathéter peut étre vérifiée avec la fonction « Live IVUS » dans le systeme.

Amorcez le cathéter avec une solution saline de 0,5 mL supplémentaire puis appuyez

sur « Live IVUS » (IVUS en direct), E dans le contréleur Makoto™ pour démarrer
'imagerie. Si une image IVUS apparait sous forme de cercles concentriques et que la

clarté de I'image est satisfaisante, alors appuyez sur « STOP » (ARRET), , sur

I'écran ou appuyez sur « STOP » (ARRET), , dans le contréleur Makoto™.

Remarque : Si la qualité de I'image n’est pas satisfaisante ou est sombre,
continuez de rincer le cathéter avec la seringue d’amorcage.

Procédez a la phase de numérisation en appuyant sur « Scan », Sca n , dans le
contrble de progression en haut de I'écran.

Remarque : L’analyse de la qualité du cathéter principal peut étre effectuée
sur les écrans de phase « Prime » (Amorgage) ou « Scan ».
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Remarque : Pendant la rotation du cathéter et la mise a iour de I'image,

appuyez sur le bouton « Mark » (Marque), , du contrdleur
Makoto™ pour passer a la phase de numérisation.

Remarque :
Appuyez sur le bouton « Pullback » (Retrait), , de I'écran

du contréleur Makoto™ pour passer le systeme a la phase de

numeérisation et démarrer une acquisition de retrait automatique.
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9 Acquisition des images numeérisees
intravasculaires Makoto™

Consultez les instructions d'utilisation du cathéter pour le
guidage du chargement du cathéter sur le fil-guide, le cathéter
dans le cathéter de guidage et le passage du cathéter dans

I'artére.
AVERTISSEMENT

Apres I'analyse de la qualité du cathéter principal, le cathéter doit &tre positionné sur le
fil-guide et passé comme indiqué dans les instructions d’utilisation du cathéter.

Il y a deux types d’acquisitions de données pouvant étre réalisées avec le Makoto
Intravascular Imaging System™ : Acquisition du Live IVUS et du retrait automatique.

L’acquisition du Live IVUS générera des images IVUS sans chemogram. Un retrait
automatique géneérera des images IVUS avec un chemogram.

9.1 Acquisition du Live IVUS
Durant I'acquisition de données Live IVUS, le systeme démarrera la rotation de
l'imagerie du cathéter sans démarrer le retrait automatique (translation proximale)

de I'imagerie. Une image IVUS transversale apparaitra a I'écran et sera mise a jour
pendant I'activation du Live IVUS.

Position
PRET

« Mark »
(Marque)

Activer
I'enregistrement

« Stop » (Arrét)

Vitesse de
translation
actuelle

Figure 9-1: mode d’acquisition Makoto pendant un scan Live IVUS non enregistré.
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Remarque : Un scan Live IVUS ne sera pas sauvegardé dans la mémoire du
systeme sauf si l'utilisateur décide de I'enregistrer.

Remarque : Live IVUS produira seulement une image IVUS ; aucune donnée
NIRS ne s’affichera ou ne sera générée sur le chemogram.

Remarque : Live IVUS produira une image IVUS transversale en direct.
L'image IVUS apparaitra également sur I'écran de I''VUS
longitudinale pendant un scan Live IVUS enregistré.

9.1.1 Démarrage du Live IVUS

Appuyez sur le bouton Live IVUS, , du contréleur Makoto™ pour activer
'imagerie IVUS en temps réel. Le statut du mode imagerie sur I'écran LCD sera
mis a jour pour afficher « LIVE » et les informations d’emplacement sont
imprimées avec un texte blanc.

GLVE  0.0ms LIVE  0.0ms

READY

E | P|

0.0..

oD Pl

Figure 9-2 : le contrdleur Makoto™ affiche I’acquisition Live IVUS non enregistrée a la position PRET (gauche) et a la
position 0,0 mm (droite).
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9.1.2 Translation du Live IVUS

WARNING

WARNING
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Distal lent Proximal lent

Distal rapide Proximal rapide

Distal lent Proximal lent

Distal rapide

Proximal
rapide

Figure 9-3 : commandes de base de translation de I'imagerie, différentes configurations (dessus, dessous) peuvent
exister.

Lorsque vous effectuez un scan Live IVUS, utilisez les commandes de
mouvement distal et proximal du contrdleur Makoto™ pour régler I'emplacement
de 'image en cours dans l'artere.

Une pression prolongée sur les commandes de mouvement lent effectuera une
translation dans la direction souhaitée a une vitesse de 2,0 mm/s. Une pression
rapide effectuera une translation dans la direction souhaitée d’'une distance fixe
de 0,1 mm.

Une pression prolongée sur les commandes de mouvement rapide effectuera
une translation dans la direction souhaitée a une vitesse de 10,0 mm/s. Une
pression rapide effectuera une translation dans la direction souhaitée d’'une
distance fixe de 0,5 mm.

Remarque : Pendant 'imagerie active en position PRET, la translation dans
la direction proximale résultera en un déplacement de la position
de I'image dans la gamme d’'imagerie continue de 0 mm a 150
mm.

Le retour & la position PRET peut se produire uniquement
lorsque le systeme n’acquiert pas d’'image.
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Remarque : Pendant que vous procédez activement a I'imagerie, la
translation proximale ET distale se produira uniquement dans
une gamme de 0 mm a 150 mm. La translation s’arrétera
automatiqguement lorsque les emplacements extrémes sont
atteints et I'imagerie poursuivra.

Remarque : Pendant qu’a la position 0 mm et aucune imagerie, en appuyant

sur les commandes de 'emplacement distal,

m, replacera le contréleur et 'imagerie du cathéter en

position PRET.

9.1.3 Enregistrement d’'une image Live IVUS
Pendant que vous effectuez un scan Live IVUS non enregistré, une image simple
peut étre sauvegardée pour alimenter la procédure. Cette image peut étre
sauvegardée, vérifiée, mesurée, ou supprimeée.

Lors d’'un scan Live IVUS, appuyez sur le bouton « Mark » (Marque) du contrdleur

Makoto™, ﬂ ou appuyez sur la commande « Mark » (Marque), ﬂ de I'écran

du systéme Makoto™ pour ajouter un signet a 'image. Cette image sera enregistrée

comme un scan d’'image simple.

9.1.4 Enregistrement d’un scan Live IVUS
Un ensemble d’'images de Live IVUS peut étre enregistré en un seul fichier numérisé.
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Figure 9-4 : mode d’acquisition Makoto pendant un scan Live IVUS enregistré.

Appuyez sur le bouton Live IVUS du controleur Makoto™, E ou appuyez sur

« Record » (Enregistrer) k3<%l sur I'écran du systeme Makoto™ a proximité de
'image IVUS transversale pour activer I'enregistrement.

Appuyez sur le bouton Live IVUS du contréleur Makoto™, ﬁ Ou appuyez sur

Enregistrer, , toujours sur I'écran du systeme Makoto™ pour arréter
I'enregistrement de données uniquement. Le cathéter poursuivra sa rotation et
'image IVUS transversale poursuivra sa mise a jour.

GLVE  0.0ms | @LIVE  0.0mws LIVE  0.0mus

READY | . 55.0.

Iﬂ |

Figure 9-5: Ecran LCD du contréleur Makoto™ pendant le processus de transition du début du Live IVUS non
enregistré sur READY (PRET) (gauche) & I'enregistrement, puis de la translation proximale et stationnaire du Live
IVUS (milieu) a laremise a zéro, et a la translation proximale pendant I’enregistrement (droite). Remarquez I’apparition
de I'icone d’enregistrement pendant le Live IVUS enregistré. Lorsque la translation est effectuée pendant le Live IVUS
enregistré une barre pleine apparait ol I'enregistrement dans cette acquisition a déja été effectué depuis la derniére
marque (milieu et droite), tandis que I'enregistrement préalable a la derniére marque est une barre vide (droite).

30.0..

Pendant la translation du Live IVUS, I'emplacement relatif, réel, et les indicateurs de

vitesse de la translation seront mis a jour.
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Appuyez sur le bouton « STOP » (ARRET) du contrdleur

Makoto™,

a sur I'écran du systéme Makoto™ pour arréter la rotation et
le mouvement du cathéter ET terminer I'enregistrement.

ou encore appuyez sur « STOP » (ARRET)

Appuyez sur le bouton « Pullback » (Retrait) du contrdleur

Makoto™, , pour terminer I'enregistrement du Live IVUS en
cours et démarrer un nouveau scan de retrait automatique dans
la configuration du taux de retrait en cours. Les scans de retrait
automatique sont toujours enregistrés.

Des marques peuvent étre placées dans le fichier numérisé et
des mesures IVUS transversales peuvent étre réalisées dans les
images d’'un scan Live IVUS enregistré pour mieux alimenter la
procédure.

9.1.5 Marquer et remettre a zéro en Live IVUS

Pendant I'acquisition Live IVUS enregistrée, des marques peuvent étre placées et
consultées grace au bouton « Mark » (Marque) du contréleur ou a I'icéne « Mark »
(Marque) a I'écran.

Pendant I'acquisition Live IVUS non enregistrée, des marques peuvent étre placées et
consultées en enregistrement image par image grace au bouton « Mark » (Marque) du
contrdleur ou a I'icdne « Mark » (Marque) a I'écran.

Ajouter une marque pendant I'acquisition Live IVUS réinitialisera I'affichage de la
distance parcourue a 0,0 mm.

9.1.6 Arrétdu Live IVUS
Un scan Live IVUS peut étre supprimé de deux maniéeres :

a. Appuyez sur le bouton STOP, , du contrbleur Makoto™ ou appuyez

sur STOP, a sur l'interface utilisateur pour arréter les mouvements du
contrbleur Makoto™, interrompre les mises a jour de I'image IVUS
transversale, et finir I'enregistrement d’un scan Live IVUS en cours.

infraredy:

A N NIPRD COMPANY

IFU0163rJ.fr (2021-05-05) 9-7



Makoto Intravascular Imaging System™
Guide d’utilisation

Ou,

b. Appuyez sur « Pullback » (Retrait), &, pour compléter le scan Live
IVUS et démarrer immédiatement une acquisition de retrait automatique.

REMARQUE : Apres avoir arrété I'acquisition Live IVUS, le contrbler
Makoto™ affichera la distance parcourue depuis la derniére
pression sur le bouton « Mark » (Marque). Cette valeur restera
affichée jusqu’a ce que le bouton « Live IVUS » (IVUS en
direct), « Pullback » (Retrait), ou « Return to READY » (Retour
a PRET) ou un bouton de translation soit actionné.

9.2 Acquisition de retrait automatique

Une acquisition de retrait automatique démarrera la rotation et le retrait du contrdleur
Makoto™ et de I'imagerie du cathéter. Cette action démarrera également la collecte et
'enregistrement de données IVUS et NIRS du taux de retrait configuré par l'utilisateur.

Indicateur
du fil-guide Image

affichée

Numéro et

position de

I'image
affichée Indicateur
de spectre

Taux de

retrait

Figure 9-6 : mode Acquisition avec acquisition de retrait automatique en cours.

9.2.1 Configuration du taux de retrait automatique suivant
La vitesse de translation pour un retrait automatique doit étre configurée par
I'utilisateur avant de démarrer une imagerie.
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Configurez la vitesse de translation de retrait de votre choix en appuyant sur la

f'(\
commande de taux de retrait, . et en sélectionnant la vitesse souhaitée pour
les options disponibles :

0,5 mm/s
1,0 mm/s

2,0 mm/s

infraredy:

A N NIPRD COMPANY

IFU0163rJ.fr (2021-05-05)



Makoto Intravascular Imaging System™
Guide d’utilisation

9.2.2 Démarrage du retrait automatique

B
Appuyez sur le bouton « Pullback » (Retrait), -’ , du contréleur Makoto™ pour
démarrer une acquisition de retrait automatique. Pendant un retrait, I''VUS transversal,
'VUS longitudinal, I'indicateur de détection du fil-guide et I'indicateur de spectre sont
mis a jour en temps réel.

9.2.2.1 Acquisition de retrait automatique avec apergu
Lorsque vous démarrez I'acquisition de retrait automatique depuis 'emplacement PRET

avec le bouton « Pullback » (Retrait), , le systeme se déplacera d’abord a
'emplacement « 0,0 mm » et démarrera I'acquisition Live IVUS. Cela permet un apercu
intravasculaire de I'emplacement de démarrage du retrait. Apres I'apercu, appuyez sur

le bouton « Pullback » (Retrait), , de nouveau pour poursuivre I'acquisition.

9.2.2.2 Indicateur de spectre
Au démarrage d’'un scan de retrait automatique, le Makoto Intravascular
Imaging System™ contrdlera la qualité du spectre lumineux enregistré.
Le systéme nécessite un nombre minimum de spectres pour générer un
chemogram. Lorsque des spectres sont enregistrés, 'indicateur de spectre
se remplira. Il disparaitra une fois le nombre minimum atteint.

Remargue : Lorsque le systeme Makoto™ collecte suffisamment de données
nécessaires pour créer un chemogram, l'indicateur de spectre
disparaitra de I'écran.

Remarque : |l faut enregistrer environ 12 mm de données numerisées de
retrait pour avoir suffisamment de données pour générer
un chemogram.

Remargue : Méme si I'indicateur de bons spectres se remplit en raison de la
collecte initiale de spectres de bonne qualité, si plus de 12 %
d’entre eux sont trop faibles pour contribuer a la génération du
chemogram, aucun chemogram ne sera génére.
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9.2.3 Arrét du retrait automatique

AVERTISSEMENT

L’imagerie a l'intérieur du cathéter de guidage doit étre réduite
au minimum pour des résultats de chemogram optimaux.

Une fois que la distance de retrait souhaité a été atteinte ou que la quantité de
données a été enregistrée, le Makoto Intravascular Imaging System™ peut s’arréter
de deux maniéres :

a. Appuyez sur le bouton « STOP » (ARRET), , du contréleur Makoto™ ;

Ou

b. Appuyez sur « STOP » (ARRET), , sur I'interface utilisateur de la console

Makoto™,

Ces deux actions arréteront les mouvements du contrdleur Makoto™ et I'acquisition

de données.

AN

ATTENTION

Remarque :

Remarque :

En cas d’urgence, utilisez le bouton « STOP » (ARRET),

du contréleur Makoto™.

Le contrdleur Makoto™ arrétera automatiquement le retrait si le
prochain point le plus proche est atteint (emplacement
150,0 mm).

Apres avoir arrété le retrait, le contréleur Makoto™ affichera la
distance parcourue depuis la derniére pression sur le bouton

« Mark » (Marque). Cette valeur restera affichée jusqu’a ce que
le bouton « Live IVUS » (IVUS en direct), « Pullback » (Retrait),
ou « Return to READY » (Retour & PRET) ou un bouton de
translation soit actionné.
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Sélection

de scans
Masque de
cathéter de
guidage

Figure 9-7 : mode Acquisition aprés lafin d’'un scan de retrait automatique avec un cathéter de guidage.

Une fois la fin de I'acquisition de retrait, le chemogram, le chemogram bloc et le Lipid

Core Burden Index (indice de masse du cceur lipidique) seront mis a jour. L'indicateur
de détection du fil-guide sera masqué de la vue. Consultez la section 10.2.8 pour plus
d’'informations.

Si le cathéter de guidage est détecté par le Makoto Intravascular Imaging System™,
alors un masque de cathéter de guidage sera appliqué au chemogram, a I''VUS
longitudinal et au chemogram bloc. Consultez la section 10.2.7 pour plus d’'informations
sur la maniere de retirer le masque de cathéter de guidage de la vue.

Remarque : Sile masque de cathéter de guidage est activé, la partie du
chemogram dans le masque de cathéter sera exclue du calcul LCBI.

9.2.4 Marquer ou remettre a zéro pendant le retrait automatique

Pendant l'acquisition de retrait automatique, des marques peuvent étre placées et
consultées grace au bouton « Mark » (Margue) du contréleur, a I'image ou a l'icbne
« Mark » (Marque) a I'écran.

Ajouter une marque pendant I'acquisition de retrait réinitialisera I'affichage de la
distance parcourue a 0,0 mm.

9.3 Réalisation de scans supplémentaires avec le Makoto
Intravascular Imaging System™
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A\

AVERTISSEMENT

A

AVERTISSEMEN
T

A

AVERTISSEMEN
T

Plusieurs scans peuvent étre effectués dans chaque procédure. Le cathéter peut
nécessiter une quantité supplémentaire de solution saline héparine pour I'imagerie
suivante.

. N -
Appuyez sur le bouton Live IVUS, , Ou le bouton « Pullback » (Retrait), . du
contrdleur Makoto™ pour acquérir des données supplémentaires. Le scan précédent
sera sauvegardé et un nouveau scan actif apparaitra.
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Un nouveau scan créera un nouveau bouton d’activation du scan pour une révision
située au-dessus du chemogram.

Remargue : Sivous enregistrez plus de trois scans, utilisez les fleches droite
et gauche pour amener le bouton scan souhaité dans les vues.

Remarque : Un total de 20 enregistrements par procédure peut étre
sauvegardé. Si la limite est atteinte, effacez les scans non
souhaités ou fermez la procédure et démarrez-en une nouvelle.

Remargue : L’annotation d’'un nom de scan changera le texte du bouton
associé.
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10 Révision, mesure et annotation des scans

10.1Sélection de scans
Apres avoir enregistré de nombreux scans, il est possible de commuter entre les scans
avec les contrbles de sélection du scan.

Modifier scan

Commande
de sélection
du scan

Figure 10-1 : phase de numérisation du mode Acquisition avec scan « RCA » sélectionné pour révision.
Appuyez sur le nom de scan souhaité et chargez les données pour I'affichage a I'écran.
Vous pouvez voir jusqu’a trois scans a tout moment dans la commande de sélection du

scan. Appuyez sur les contrdles de fleche de chaque coté de la commande de sélection
du scan pour déplacer d’autres scans dans les vues.
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10.2Modification des scans

Fenétre d’édition

du scan
Nom du scan j YV AR
03/11/2015 14:32:50 x Fermer
Numéro de ' modiication
groupe du ":"'I' , Jcatheter Lot Number I-"’- 10
cathéter 64623
motes

Remarques Al STEMI, post 2.5mm ostial POBA

du scan

Activer/désactiver .
la visibilité du bloc Act|yer
du chemogram l'indicateur du
. fil-guide
Activer/désac —I MShow longitudinal Block Level Chemogram
tiver la - g Show trans! mogram Block
visibilité du H
L mx LCBl w
bloc du g Effacer scan
chemogram
Scan Activer le masque
mxLCBI du cathéter de

guidage

Figure 10-2 : modifier la fenétre de scan ouverte pour « RCA».

Les informations de scan peuvent étre modifiées pour fournir des détails
supplémentaires et faciliter une sélection ultérieure.

Appuyez sur le bouton Modifier, E du scan sélectionné pour accéder a la fenétre

d’édition du scan. Appuyez sur le « X », B ou a I'extérieur de la fenétre d’édition du
scan pour fermer ou sauvegarder tous les changements.

10.2.1 Nom du scan

Le nom du scan peut étre personnalisé pour renvoyer des informations sur le scan. Cela
peut inclure les noms, emplacements ou le timing de l'artere (ex. : « pre » ou « post »).
Le nom peut étre configuré en insérant les informations dans le champ du nom.

Ce nom de scan apparaitra dans le répertoire des procédures et scans complétés,
tout comme les fichiers DICOM et les rapports.

Remarque : Utiliser le filtre dans la phase de sélection du mode Révision
pour rechercher des noms de scan. Consultez la section 12.1
pour plus d’informations.
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10.2.2 Numéro de groupe du cathéter

Chaque scan est collecté avec un cathéter ayant un numéro de groupe de production
associé. Cette information peut étre enregistrée indépendamment pour chaque scan en
insérant la valeur du package de cathéter dans le champ du numéro de groupe du
cathéter dans la fenétre d’édition du scan.

Remarque : Insérez le numéro de groupe du cathéter pendant la phase de
configuration pour alimenter automatiquement ce champ pour
les scans tels gu'ils sont enregistrés.

Remarque : Utilisez le filtre dans la phase « Select » (Sélection) du mode
Révision pour rechercher des références de lot de cathéter.
Consultez la section 12.1 pour plus d’informations.

10.2.3 Remarque du scan
Les remarques concernant le scan collecté peuvent étre enregistrées dans le champ

Remarques de la fenétre d’édition du scan.

Remarque : Utilisez le filtre du mode Révision, de I'écran de la phase de
sélection pour rechercher des détails importants du scan
enregistrés dans les remarques du scan. Consultez la
section 12.1 pour plus d’informations.

10.2.4 Scanner la visibilité longitudinale du chemogram au niveau du bloc
La visibilité du chemogram au niveau du bloc sur I'écran IVUS longitudinal peut étre
activée ou désactivée a I'aide de cette case. Ce choix concerne uniquement le scan

actuel.

REMARQUE : Le parametre de visibilité par défaut du chemogram au niveau
du bloc pour chaque nouveau scan peut étre défini dans les
parametres du systéme. Voir section 13.6 Affichage des
scans.

REMARQUE : Ce parametre peut étre ajusté rapidement en effectuant un
clic droit avec la souris sur le chemogram au niveau du bloc et

en choisissant le réglage approprié.
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10.2.5 Scanner la visibilité transversale du chemogram au niveau du bloc

La visibilité du chemogram au niveau du bloc sur I'écran IVUS transversal peut étre
activée ou désactivée a l'aide de cette case. Ce choix concerne uniquement le scan
actuel.

REMARQUE : Le parametre de visibilité par défaut du chemogram au niveau
du bloc pour chaque nouveau scan peut étre défini dans les
parametres du systéme. Voir section 13.6 Affichage des
scans.

REMARQUE : Ce parametre peut étre ajusté rapidement en effectuant un
clic droit avec la souris sur le chemogram au niveau du bloc et
en choisissant le réglage approprié.

10.2.6 Scan mxLCBI

La taille de fenétre du LCBI maximale peut étre ajustée pour chaque scan par rapport a
la valeur par défaut. Utilisez le curseur pour ajuster la fenétre utilisée pour calculer le
mxLCBI entre 1 mm et 10 mm.

REMARQUE : La valeur par défaut poru tous les nouveaux scans peut étre
définie dans les parametres du systéme. Voir section 13.6.5
« mx LCBI Window Size » (Taille de fenétre du LCBI max).

10.2.7 Activer le cathéter de guidage

L’imagerie a l'intérieur du cathéter de guidage doit étre réduite
au minimum pour des résultats de chemogram optimaux.

AVERTISSEMENT

Dans la fenétre d’édition du scan, utilisez la commande d’activation du masque du cathéter
de guidage pour alterner la visibilité du masque du cathéter de guidage sur le chemogram,
I'indicateur de fil-guide, I''VUS longitudinal et le chemogram bloc.
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Masque de
cathéter de
guidage

Figure 10-3 : modification du scan avec masque du cathéter de guidage activé (gauche). Modification du scan
avec masque du cathéter de guidage désactivé (droite).
10.2.8 Activer I'indicateur du fil-guide
Dans la fenétre d’édition du scan, utilisez la commande d’activation de l'indicateur
de fil-guide pour alterner la visibilité de I'indicateur de fil-guide et du chemogram.
La commande apparait en bleu lorsque l'indicateur de fil-guide est visible.

Indicateur du
Na

‘. - d fil-guide

Catheter Lot Number

64623

Notes
STEMI, post 2.5mm ostial POBA

mshcw longitudinal Block Level Chemogram

Ler| [ Show transverse Chemogram Block

Activer
T ', TLCBI window size = 4 mim
I'indicateur du i
fil-guide N = i

Figure 10-4 : la fenétre d’édition du scan avec I'activation de I'indicateur de fil-guide activé (gauche) ; le chemogram est
masqué et I'indicateur de fil-guide est visible (droite).

10.2.9 Effacer scan
Les scans individuels peuvent étre effacés dans la fenétre d’édition du scan. Une
demande de confirmation sera fournie a I'utilisateur.
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W show longitudinal Block Level Chemogram

Effacer
scan
Figure 10-5: lacommande de scan effacé dans la fenétre d’édition du scan (gauche) et lademande de confirmation (droite).

Une fois confirmée par I'utilisateur, la suppression d’un scan ne
peut étre annulée.
ATTENTION

10.3Navigation du scan
Le scan sélectionné peut étre révisé avec plusieurs commandes.

Sélection de
scans
Révision de
la lumiére
Lecture Commande
de sélection
Commande de cadre
de sélection épais

de cadre fin

Figure 10-6 : phase de numérisation du mode Acquisition avec sélection de scans et commandes de lecture sélectionnées.
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10.3.1 Lecture automatique

Appuyez sur la commande Lecture/Pause, / , située en dessous de I'image
IVUS transversale pour répéter automatiquement les images enregistrées dans leur
ordre d’enregistrement.

La lecture se produira a environ 16 images par seconde pour les enregistrements Live
IVUS ou 30 images par seconde pour les enregistrements de retrait automatique.

Pause

Figure 10-7 : phase de numérisation du mode Acquisition pendant la lecture automatique avec la commande Pause
sélectionnée.

La mise sur pause arrétera la lecture sur I'image affichée. La reprise de la lecture
démarrera par la répétition des images a partir du dernier fragment affiché.

Remarque : Une fois la derniére image enregistrée atteinte, la lecture en
boucle reprendra par la premiére image des séries.

Remarque : Lorsqu’une région est sélectionnée, la lecture automatique
tournera les images dans la région sélectionnée.

10.3.2 Révision de la lumiere

Comme une aide pour réaliser les mesures et réviser les images individuelles, la
révision de la lumiere lira une trés courte boucle des images pour accentuer les
différences dans I'apparence IVUS de la cuve et de la plaque immobiles du mouvement
relatif & la circulation sanguine.

La révision de la lumiere activée en appuyant sur la commande de révision de la

lumiere, , a droite du bouton de lecture automatique.
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REMARQUE : |l est possible d’ajuster la durée ou la plage de la révision du
flux lumineux dans les paramétres du systeme. Voir section
13.6.2 Plage d’'images de la révision du flux lumineux.

10.3.3 Lecture manuelle
Le scan sélectionné peut également étre lu manuellement. Appuyez et relachez la

commande de sélection de I'image fine, m pour lire le scan lentement dans

la direction de votre choix. Ainsi, la lecture s’arrétera une fois I'image atteinte par le
scan ou la région sélectionnés ; cela ne fermera pas les images sélectionnées.

Remarque : Appuyez et relachez la commande de sélection de I'image fine,

, pour lire les images sélectionnées dans leur ordre
inverse d’enregistrement.

10.3.4 Sélection de I'image

10.3.4.1 Sélection de I'image approximative

Faites glisser la commande de sélection de I'image approximative entre le chemogram
ou la carte de détection du fil-guide et I'lVUS longitudinal ou tout autre endroit sur la
ligne bleue pour actualiser rapidement I'image affichée.

Remarque : Le déplacement de la commande de sélection de I'image
approximative est une lecture a taux variable.

10.3.4.2 Sélection de I'image fine
Appuyez sur I'image fine approximative ou les commandes de sélection de I'image fine

distale, m pour changer I'image affichée en augmentation d’une image.

Remargue : Avec le curseur au-dessus du chemogram, de l'indicateur de fil-
guide, de I''VUS transversal ou de I'VUS longitudinal, faites défiler
la molette de la souris pour changer I'image affichée en
augmentation d’une image.
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10.4 Marques
Pendant et apres que le scan soit complété, des marques peuvent étre placées.

Pendant I'acquisition du scan, appuyez sur les commandes « Mark » (Marque), F&

ou ﬂ Pendant la révision, naviguez sur I'image souhaitée et appuyez sur « Mark »
(Marque) a I'écran.

Remarque : Une seule marque peut étre placée sur chaque image.
Remarque : Jusqu’a 30 marques peuvent étre créées dans un seul scan.

Remarque : Jusqu’a cing marques peuvent étre vues complétement a I'écran
a tout moment.

Remarque : Compléter une mesure IVUS transversale ou sur une annotation
d’'image créera automatiquement une marque pour I'image.

Remargue : Utilisez le bouton « Mark » (Marque) dans les phases de
configuration ou d’amorcage pour passer a la phase suivante du
mode Acquistion.

Remarque : Pendant I'acquisition d'images, utilisez le bouton « Mark »
(Marque) pour réinitialiser les distances affichées a 0 mm.

La position relative d’'une marque dans le scan est indiquée par de petits triangles verts
sur le chemogram et I'lVUS longitudinal. Lorsque la marque est sélectionnée, I'image
affichée en cours connectera les triangles.
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ll\\II'Il[\l\1|l\l\'\llwl\\'lll\ (N
Image
"i affichée en
cours
Indicateurs
d’emplaceme
nt de marque
Marque

sélectionnée

Imprimer le Modifier la
rapport de marque marque
) Position de
Vignettes de de marque

marque
Figure 10-8 : Les emplacements de marque sont affichés par les indicateurs de triangle vert du chemogram et de I'lVUS
longitudinal et avec une vignette visuelle affichant le contenu de I'image.

10.4.1 Sélection de marques

Une vignette de marque sera créée pour chague marque placée. La vignette est la
commande pour sélectionner 'emplacement marqué pour une révision ultérieure. Elle
fournit également une représentation visuelle du contenu a I'emplacement de I'image.

Appuyez sur 'image de la marque souhaitée pour mettre a jour I'écran et afficher
'image dans I'écran de I'VUS transversal.
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10.4.2 Modifications de marques

\J
Les margues peuvent étre effacées ou annotées. Appuyez sur le bouton Modifier, ,
de la marque sélectionnée pour ouvrir la fenétre d’édition de marque.

Appuyez sur « X », m ou a I'extérieur de la fenétre d’édition de marque pour fermer
la fenétre, en sauvegardant les changements.

10.4.2.1 Notes de marque

Fenétre
d’édition de

la marque Small plaque rupture noted
S

Note de scan

Supprimer la marque

Figure 10-9 : note de marque saisie dans la fenétre d’édition de marque.

Des remarques concernant le contenu d’'une image peuvent étre enregistrées dans le
champ Notes de la fenétre d’édition de marque.

10.4.2.2 Suppression

Les marques peuvent étre supprimées avec la commande « Delete » (Supprimer),
dans la fenétre d’édition de marque.

Remarque : La suppression de marque ne peut étre annulée.

Remarque : La suppression d'une marque comprenant des mesures ou des
annotations d’image nécessitera une confirmation.

10.4.3 Impression
Les rapports de marque sont condensés en une page de résumeés de la procédure

basée sur les résultats dans I'image sélectionnée.
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Sur la marque sélectionnée, appuyez sur le bouton Imprimer, , pour envoyer un
rapport d’une page a l'imprimante configurée par défaut pour le systeme.

10.5Mesures

Le systeme d’'imagerie Makoto fournit des commandes avec la phase de numérisation
pour effectuer des mesures de l'affichage transversal et des affichages longitudinaux
(Chemogramet IVUS longitudinal).

Commande de
sélection de
régions

Région
sélectionnée

Région Commande de
sélectionnée mesure de la
longueur /
région

Figure 10-10 : phase « View » (Visualisation) avec une région sélectionnée dans le scan « RCA ».

10.5.1 Mesure de lalongueur, de la sténose de la zone de lumiére et du LCBI
Les mesures de la longueur, de la sténose de la zone de lumiére et du LCBI sont effectuées
sur la vue de I''VUS longitudinal et du chemogram a travers la création de régions.

10.5.1.1 Création de régions

Les régions sont les sous-segments d’'un scan importants pour 'opérateur ou le médecin.
Ces segments peuvent concerner les lésions, les segments normaux, les stents...
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Consignes

Commande de
mesure de la
longueur /
région

Figure 10-11 : phase « View » (Visuealisation) avec création de région en cours. Les consifnes pour terminer la région
apparaissent a l’écran.

11

Les régions sont créées en appuyant sur la commande Longueur, Length § puis en
indiguant un emplacement de début et de fin de la région sur I''VUS longitudinal ou
chemogram. Il est possible de définir la région :

(A) En appuyant et en maintenant au niveau de la position de départ souhaitée
puis en étirant jusqu’a la position de fin souhaitée ;
ou

(B) En appuyant sur les positions de marques de départ et de fin dans les
vignettes de marque.

Remarque : Utilisez les marques pour définir le début ou la fin d’'une région
souhaitée avec une précision accrue.

Une fois la région créée, les zones de I'affichage longitudinal situées en dehors de la
région s’estompent et un contréle de sélection de la région s’affiche sous les controles
de sélection de scan.

Remarque :
Utilisez le bouton de lecture, Bd&8, pour créer une boucle avec la

région sélectionnée.

Le LCBI et les résultats s’affichent a gauche de la région du chemogramet la longueur
s’affiche a gauche de I''VUS longitudinale.
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Figure 10-12 : phase « View » (Visualisation) avec la région sélectionnée.
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10.5.1.2 Modification des régions
Il est possible de modifier la position ou 'emplacement de début et de fin des régions

qui ont été créées dans le chemogram.

[ 40.4-66.4 mm #|

3 ] 4 Modification
Y 70 4|» 00 o 50 ¥ e
EERER m e des limites de
w \ la région
Modification
de la position
de la région

Figure 10-13. Commandes de modification des régions

Faites glisser la position de la région pour déplacer la région définie sans en modifier la
longueur.

Faites glisser la limite proximale ou distale de la région pour ajuster de maniére
grossiere I'extrémité sélectionnée de la région. La longueur de la région s'adaptera
automatiqguement. Les LCBI s'actualiseront lorsque la modification sera terminée.

REMARQUE : Placez le curseur sur les commandes de modification du
début ou de la fin et utilisez la roulette de la souris pour
effectuer des ajustements précis de I'emplacement de la limite

de la région.

REMARQUE : Verrouillez la région pour éviter tout ajustement accidentel.
Voir section10.5.1.7 Verrouiller une région.
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10.5.1.3 Longueur, LCBI et LCBI max
Une fois terminée la création de région, trois résultats de mesure liés a la région
s’affichent.

Longueur : Il s’agit de la distance en millimétres (mm) entre la
position de début et la position de fin de la région.

LCBI : Il s’agit du Lipid Core Burden Index (Indice de masse
du cceur lipidique) de la région. Le LCBI est le ratio des
signaux positifs de lipides et du total de pixels valides
dans la région sélectionnée, exprimé sur une échelle
de 0 a 1000.

mx(4) : Il s’agit du Lipid Core Burden Index maximum d’une
taille fixe de fenétre dans les limites de la région.
La taille de fenétre par défaut est de 4 mm.

10.5.1.4 Sténose de I'aire de la lumiere (AS%)

Il est possible de calculer la sténose de I'aire (Area Stenosis ou AS) de la lumiéere en
utilisant deux marques contenant chacune une mesure d’aire que le systéme a
identifiée comme correspondant a la lumiére.

Remarque : Ajoutez les mesures de lumiere a I'image de début et a I'image
de fin d’'une région existante pour obtenir la sténose de l'aire de
la lumiere pour la région en question.

10.5.1.5 Sélection et désélection

Sélectionnez les régions en appuyant sur le bouton correspondant au niveau du
contrdle de sélection de région. L'affichage longitudinal, la longueur, le LCBI et le LCBI
max sont actualisés en conséquence.

Désélectionnez les régions en appuyant a nouveau sur le bouton de région
correspondant ou sélectionnez le scan actuel ou un autre scan.

Remarque : Le fait de créer une nouvelle région désélectionne la région
actuelle.
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10.5.1.6 Annotation de la région

LCBI
150
mx(4)

329

Figure 10-14 : nom de région saisi dans la fenétre de modification de la région.
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Fenétre de
modification
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Nom de
région

Note
relative a
la région

Supprimer la

région

Appuyez sur le bouton « Edit » (Modifier), E du bouton « Selected Region »
(Région sélectionnée) pour ouvrir la fenétre « Region Edit » (Modifier la région).
Appuyez sur le champ souhaité pour en modifier le contenu.

Appuyez sur le « X », m ou a I'extérieur de la fenétre « Region Edit » (Modifier la
région) pour fermer ou sauvegarder votre saisie.

10.5.1.7 Verrouiller une région

Appuyez sur le bouton « Edit » (Modifier), E , du bouton « Selected Region » (Région
sélectionnée) pour ouvrir la fenétre « Region Edit » (Modifier la région). Appuyez sur

I'icbne « Region Lock » (Verrouillage de la région), E ﬂ pour autoriser ou
empécher I'ajustement de la position ou des limites de la région.

IFU0163rJ.fr (2021-05-05)
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10.5.1.8 Suppression de région

Appuyez sur le bouton « Edit » (Modifier), E du bouton « Selected Region » (Région
sélectionnée) pour ouvrir la fenétre « Region Edit » (Modifier la région). Appuyez sur le

bouton « Delete » (Supprimer), BE&&&, pour supprimer la région.

Remarque : La suppression d’'une région ne peut étre annulée.

10.5.2 Mesure sur image
Il est possible d’effectuer des mesures sur toute image transversale d’'IVUS afin de
clarifier ou de quantifier le contenu de I'image.

Remarque : Effectuer une mesure sur image crée automatiguement une
marque pour l'image.

Remarque : Effectuer une mesure sur image actualise I'image de la vignette
de marque.

REMARQUE : Lorsque 'outil est actif, appuyez sur I'outil pour abandonner la
mesure ou l'annotation sur I'image en cours.

10.5.2.1 Mesure de zone

L'outil de mesure de zone, Bl peut étre utilisé pour mesurer l'aire ainsi que les
diametres minimum et maximum des éléments a I'image.

infraredy:

A N NIPRD COMPANY

IFU0163rJ.fr (2021-05-05) 10-18



Makoto Intravascular Imaging System™
Guide d’utilisation

Consignes

) Mesure
Zohe zoomeée gu de zone
niveau du point
sélectionné
Point

supplémentaire

Point de départ

Figure 10-15 : Phase « Scan » (Numérisation) avec mesure de la zone activée et en cours. Le premier point placé est
indiqué par un plus grand cercle plein.

Appuyez sur I'outil de mesure de zone, B&&H, pour commencer a mesurer. L'icone
devient bleue lorsqu’elle est active. Des instructions s’affichent au-dessus de I'image
transversale d'IVUS et servent de guide pour terminer la mesure.

Appuyez sur I'image transversale d’IVUS pour placer les points le long de I'élément
souhaité afin de commencer a définir la zone. Continuez a ajouter des points jusqu’a
ce que la zone soit définie.

Remarque : Lorsque le troisiéme point est ajouté pour définir la zone, un
apercu de la zone apparait en pointillés. Il illustre la maniéere
dont la zone terminée apparaitra si 'utilisateur appuie sur le
point de départ pour compléter la zone.

Remarque : ﬂ
Appuyez sur « Cancel » (Annuler), , au niveau des

instructions a I'écran pour abandonner la mesure en cours.
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Résultats

Figure 10-16 : mesure de zone terminée et affichage des résultats.

Appuyez sur le premier point pour terminer la mesure et afficher les résultats. Pour
chaque zone terminée, la zone transversale avec diameétres minimum et maximum
s’affichera dans le coin supérieur gauche de I'image transversale d’'IVUS.

Remarque : Appuyez sur le résultat de mesure pour afficher les diamétres
minimum et maximum dans l'image.
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Figure 10-17 : Des contours et résultats codés par couleur s’affichent si une zone tracée est totalement imbriquée dans une
seconde zone. Le contour de la lumiére est sélectionné et les emplacements des diamétres minimum et maximum sont indiqués.

S’il'y a plus d’'un contour de zone tracé, les résultats seront codés par couleur.

Remarque : Trois zones peuvent étre tracées sur chaque image.

Remargue : Chaque résultat de mesure d’une zone posséde la méme
couleur que son contour. Chaque icone de zone calculée, par
exemple une zone de plaque, correspond a la couleur utilisée
pour les contours qui servent a définir le résultat de la zone
calculée.

Remarque : Si une zone est toalement imbriquée dans une seconde zone
sur la méme image, le systeme Makoto™ en désignera
automatiqguement une pour représenter la « Lumiére » et I'autre
« EEM », tandis qu’une zone de plaque et une progression de
plaque, « PP » seront calculées.

Remarque : Si trois zones impriquées apparaissent sur la méme image, la
zone 1 tracée entierement a I'intérieur de la zone 2 et la zone 2
entierement a l'intérieur de la zone 3, le systéme Makoto™
désignera automatiquement la zone la plus a I'extérieur pour
représenter « EEM », celle la plus a I'intérieur pour représenter
la « Lumiére », et celle du millieu pour représenter le « Stent ».
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Une zone de plaque et une progression de plaque, « PP »,
seront calculées entre « EEM » et la « Lumiére ». Une autre
zone sera calculée entre le « Stent » et la « Lumiére ».

Ajustez la taille ou la forme de la zone en appuyant sur les points existants et en les
faisant glisser vers 'emplacement désiré. Pour affiner la forme de la zone terminée,
ajoutez des points a la zone terminée et faisant glisser le contour de la zone entre les
points existants. Les résultats présentés s'actualiseront lorsque la modification sera
terminée.

Remarque : Faites glisser les points de mesure pour ouvrir le zoom local et

améliorer la visualisation de I'image prés du curseur ou sous le
doigt de l'opérateur.

10.5.2.2 Mesure linéaire
Il est possible d’effectuer des mesures linéaires au niveau de I'image transversale d’'IVUS
pour mesurer des éléments de I'image, comme des diamétres ou des épaisseurs.

Mesure linéaire

Supprimer la

mesure
Nrupture
LY
: .;l‘
| | T"‘ﬂ |
iy ’qh
TN o 4/
. -
o
~ ‘"
._‘/
Mesure

sélectionnée

Figure 10-18 : Mesure linéaire terminée. Trois mesures linéaires ont été faites sur cette section.

infraredy:

A D NIPRD COMPANY

IFU0163rJ.fr (2021-05-05) 10-22



Makoto Intravascular Imaging System™
Guide d’utilisation

Appuyez sur I'outil de mesure linéaire, , pour commencer a mesurer. L'icbne
devient bleue lorsqu’elle est active. Des instructions s’affichent au-dessus de I'image
transversale d’'IVUS et servent de guide pour terminer la mesure.

Appuyez sur le point de départ de la fonction a mesurer sur I'image IVUS transversale.
Appuyez sur la position de fin de la fonction pour terminer la mesure. La mesure
linéaire entre les deux points s'affichera en millimetres sur I'image IVUS transversale.

Remarque : Lorsque vous utilisez la souris ou faites glisser le point de fin, un
apercu de la ligne et de la distance apparait jusqu’a ce que vous
placiez le point de fin.

Remarque : Il est possible de tracer jusqu’a six mesures linéaires par image.

Faites glisser le point de début ou de fin pour ajuster la mesure.

10.5.2.3 Supprimer des mesures sur image
Pour supprimer des mesures sur image individuelles, commencez par sélectionner le
résultat de mesure.

07/08/2016 DOB 01/01/0001

@ Measurements

2.8 mm

Supprimer la
mesure

Figure 10-19 : marque avec une mesure linéaire sélectionnée. Notez 'option permettant de supprimer la mesure et le résultat.

Lorsque vous sélectionnez une mesure, un bouton « Delete » (Supprimer), ,
s’affiche a gauche du résultat sélectionné. Appuyer sur le bouton « Delete »
. ,
(Supprimer), , efface la mesure et le résultat du scan.
Remarque : La suppression de mesure ne peut pas étre annulée.
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Remarque : Aucune confirmation n’est demandée lors de la suppression de
mesures individuelles.

Remarque : Supprimez la marque pour effacer TOUTES les mesures d’'une
image en une fois.

10.6 Annotation sur image
Outre les mesures, il est possible de placer des commentaires directement sur
'image transversale d’'IVUS.

Appuyez sur le bouton d’annotation sur image, EliEEER pour commencer a créer
des commentaires sur image. Déterminez 'emplacement ou la note devra
s’afficher, qui correspondra au bord gauche de la note. Appuyez sur <Enter>
(<Entrée>) sur le clavier virtuel pour terminer I'annotation.

Remarque : Effectuer une annotation sur image crée automatiquement une
marque pour l'image.

Remarque : Vous pouvez faire glisser les annotations sur image terminées
vers un nouvel emplacement sur I'image actuelle.

Remarque : Terminer une annotation sur image actualise I'image de la
vignette de marque.

Pour supprimer une annotation sur image, appuyez sur I'annotation pour la

sélectionner puis appuyez sur le bouton « Delete » (Supprimer), .

10.7Capture d’écran

Vous pouvez effectuer des captures de la totalité de I'écran lors des phases « Scan »
(Numeérisation) et « View » (Visualisation). Cette image capturera tout le contenu a
I'écran ainsi que tous les boutons et commandes.

Lorsque vous examinez un scan, naviguez jusqu’a lI'image souhaitée a 'aide des
commandes de réglage grossier ou fin de 'image.
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Capture
d'écran

aEES

Figure 10-20 : phase « Scan » (Numérisation) du mode Acquisition avec le bouton de capture d’écran indiqué.

Appuyez sur le bouton Capture, E pour enregistrer une image de I'écran entier pour
un usage ultérieur.

Remarque : Vous pouvez enregistrer jusqu’a 30 captures d’écran par scan.

Remarque : |l est possible d'imprimer ou de supprimer des captures d’écran
depuis la phase « Close » (Fermeture) du mode Acquisition ou
depuis la phase « Select » (Sélection) du mode Révision.

10.8 Parameétres d’affichage
Le Makoto Intravascular Imaging System™ propose plusieurs boutons permettant
d’optimiser la disposition de I'affichage et la qualité des images obtenues par IVUS.

10.8.1 Rotation longitudinale d’IVUS

L'image longitudinale d'IVUS est créée a partir des données d’'image le long de I'axe
marqué au niveau de I'image transversale d’IVUS. L’axe marqué au niveau de I'image
transversale d’'IVUS est indiqué par les triangles solides et ouverts sur I'axe. Le triangle
solide sur I'axe indique la portion de I'image qui sera tracée dans la moitié supérieure
de I''VUS longitudinale.
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Figure 10-21 : rotation longitudinale d’'IVUS. La ligne verte en pointillés indique I'’emplacement initial de I’axe de I'lVUS
longitudinale, et la ligne solide son emplacement actuel. Les lignes sont accentuées ici a des fins d’illustration.

Pour ajuster les données affichées dans I'lVUS longitudinale, faites glisser le triangle
plein sur 'axe marqué jusqu’a un nouvel emplacement sur la circonférence de I'image
IVUS transversale.
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REMARQUE : Ajuster cet affichage de I'lVUS longitudinal n’affecte pas les
ajustements apportés a la rotation du chemogram.

10.8.2 Rotation du chemogram

Figure 10-22 : Il est possible de faire pivoter les chemograms de maniére a éloigner les groupes de lipides du bord du
chemogram afin de faciliter I'examen et I'interprétation.

L’'axe vertical du chemogram est une dimension continue de 360°. Cela signifie que le
bord supérieur du chemogram est relié au bord inférieur. L’'emplacement de la coupe
est arbitraire et permet de la représenter sur un plan en deux dimensions. Certains
eléments peuvent des lors étre séparés entre les bords supérieur et inférieur.

Appuyez ou cliquez dans le chemogram et faites glisser verticalement pour ajuster
'emplacement de la coupe du chemogram.

REMARQUE : Le systéme se souviendra de I'ajustement de la ligne de
coupe du chemogram et l'utilisera lors des consultations de
scans ou géneérations de rapports suivantes. Les captures
d’écran ne seront pas ajustées.

REMARQUE : Ajuster cet affichage du chemogram n’affecte pas les
ajustements apportés a I'lVUS longitudinal.

10.8.3 Rotation de I'lVUS transversale
Il est possible de faire pivoter I'image transversale afin de faciliter la comparaison avec
d'autres scans ou d’aider l'utilisateur a mieux visualiser I'anatomie.
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y {Rupture

Figure 10-23. Rotation de I'lVUS transversale. L'image de gauche montre I'orientation par défaut et I'image de droite
montre I'image apreés rotation, effectuée en faisant glisser la commande sur le halo du chemogram vers un nouvel
emplacement.

Pour ajuster la rotation de I'image transversale, faites glisser la commande de l'arc gris
qui apparait dans le halo du chemogram vers un nouvel emplacement.

REMARQUE : Les orientations de l'image IVUS transversale et du halo du
chemogram sont liées. Faire pivoter I'image transversale fait
également pivoter le halo du chemogram.

REMARQUE : La rotation de I'image transversale s'applique a toutes les
images du scan.

REMARQUE : La rotation de I''VUS longitudinale est relative a la rotation de
'VUS transversale, de sorte que les ajustements de la
rotation de I'lVUS transversale ne perturberont pas la vue de
'VUS longitudinale sélectionnée.

REMARQUE : La rotation de I''VUS transversale apparaitra dans les
rapports, AVIS et images DICOM créés dans le mode
Révision.
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10.8.4 Parameétres de I'image transversale

Il est possible d’ajuster 'image transversale de I''VUS a l'aide des boutons de
parametres d'image. Ces boutons incluent un ensemble de commandes de base ainsi
gu’'un ensemble de commandes avancees.

Etendre les
commandes

Figure 10-24 : paramétres de I'image transversale. A gauche, les commandes de base. A droite, les commandes avancées.

Appuyez sur le bouton des paramétres d'image pour y accéder puis utilisez le bouton

Etendre, , pour accéder aux parametres et fonctions avances.

Appuyez sur la croix, E:i ou a I'extérieur de la fenétre pour utiliser les paramétres
actuels et fermer la fenétre.

10.8.4.1 Zoom
Vous pouvez ajuster la profondeur de champ de I''VUS transversale a l'aide des
commandes de zoom a c6té de I'image transversale d’'IVUS. Il est possible
d’ajuster la profondeur d’'image transversale d’'IVUS de 6 a 16 mm, par
incréments de 2 mm.

Zoom

Diameétre de
champ d'IVUS

Figure 10-25 : les commandes de zoom permettent d’ajuster le diamétre d’'IVUS transversale. 6 mm de diamétre, & gauche.
10 mm de diametre, au centre. 16 mm de diametre, a droite.

Appuyez sur les commandes de zoom pour augmenter, @ ou réduire :
le zoom sur I''VUS transversale. L'affichage de I''VUS longitudinale sera actualisé
en conséquence.
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10.8.4.2 Gain
Faites glisser le curseur pour ajuster la valeur du parametre de gain. La valeur est
comprise entre 0,5 et 3,0.

Une valeur basse produit une image sombre, tandis qu’une valeur élevée produit une
image plus claire.

10.8.4.3 Saturation
Faites glisser le curseur pour ajuster la valeur du paramétre de saturation. La valeur est
comprise entre 0,50 et 1,50.

Une valeur basse produit une image sombre, tandis qu’une valeur élevée produit une
image plus claire. A utiliser conjointement au paramétre de Noir pour contréler la plage
dynamique.

10.8.4.4 Noir
Faites glisser le curseur pour ajuster la valeur du paramétre de noir. La valeur est
comprise entre 0,00 et 0,50.

Une valeur basse produit une image claire, tandis qu’une valeur élevée produit une
image plus sombre. A utiliser conjointement au paramétre de saturation pour controler
la plage dynamique.

10.8.4.5 Gamma
Faites glisser le curseur pour ajuster la valeur du parametre gamma. La valeur est
comprise entre 0,5 et 2,6.

Une valeur basse produit une image plus blanche, tandis qu’une valeur élevée produit
une image plus sombre.

10.8.4.6 Revenir au réglage précédent

Appuyez sur le bouton Revenir aux parametres précédents . pour réinitialiser les
parametres aux valeurs qu’ils avaient au moment d’ouvrir la fenétre de parametres.
Cela n’a aucun effet sur le zoom.

10.8.4.7 Enregistrer comme parameétres locaux par défaut
H
Appuyez sur le bouton Enregistrer en local, , pour enregistrer les parametres

actuels comme parametres par défaut. Toutes les nouvelles procédures démarreront avec
ces parametres d'image, a I'exception du zoom.

infraredy:

A N NIPRD COMPANY

IFU0163rJ.fr (2021-05-05) 10-30



Makoto Intravascular Imaging System™
Guide d’utilisation

Ces valeurs seront utilisées lorsque vous appuyez sur le bouton Return to Local
Settings (Revenir aux parametres locaux).

10.8.4.8 Revenir aux paramétres locaux

Appuyez sur le bouton Revenir aux parametres locaux, -& pour charger les
parametres locaux par défaut.

10.8.4.9 Revenir aux paraméetres d’usine

)

Appuyez sur le bouton Revenir aux parametres d’usine, , pour charger les
parametres par défaut établis par le fabricant.
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11 Clore les procédures

Lors de la phase « Close » (Fermeture) de la procédure, il est possible d’examiner les
détails de la procédure avant d’enregistrer les scans et I'analyse dans la mémoire locale
du systéme.

Modifier les
informations
de procédure

Clore la
procédure

Revenir au
scan

Figure 11-1 : phase « Close » (Fermeture) du mode Acquisition avec la commande « Close procedure » (Fermer la
procédure) activée.

Les détails de la configuration, des scans recueillis, des marques et des captures
d’écran sont affichés pour confirmation. C’est 'occasion d’évaluer les données de la
phase « Setup » (Configuration) ou de supprimer les scans indésirables avant de clore
la procédure.

Remarque : Si des informations essentielles nécessaires pour identifier une
procédure sont manquantes, I'opérateur sera invité a retourner a
la phase « Setup » (Configuration).

Remarque : Si un scan est initié depuis le contréleur Makoto™, le mode
Acquisition reviendra automatiquement a la phase de scan.

Si des modifications sont requises, appuyez sur le bouton « Return to scan » (Revenir
\J
R 4
au scan) ou « Edit » (Modifier), I, ou appuyez sur la phase appropriée sur le ruban
de progression pour modifier la procédure.

v

Appuyez sur « Close Procedure » (Fermer la procédure), EEElESEEE, confirmez que
vous souhaitez enregistrer tous les scans dans la mémoire locale et réinitialisez le
mode Acquisition pour une nouvelle procédure.
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12 Procédures d’évaluation et d’archivage

Il est possible d’évaluer, d’archiver, de modifier et de supprimer les procédures
enregistrées préecédemment en mode Révision.

Pour passer en mode Révision depuis le mode Acquisition, appuyez sur le bouton de

mode Makoto lorsqu’aucune procédure n’est en cours.

Basculement entre les
modes du Makoto

Select

Vue

Destination
d’exportation

Imprimer le
rapport

Importation

Figure 12-1 : mode Révision affichant la phase « Select » (Sélection).

En entrant en mode Révision, 'opérateur voit apparaitre la phase « Select » (Sélection)
du flux de travail de révision. Lors de cette phase, 'opérateur sélectionnera les
procédures et scans sur lesquels effectuer des actions supplémentaires. L'opérateur
peut choisir de modifier, afficher, supprimer ou imprimer des rapports relatifs a la
procédure ou aux scans sélectionnés.

Il est également possible de sélectionner des scans pour les importer dans la mémoire locale.
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12.1 Sélectionner des procédures et scans
Il est possible de sélectionner des procédures et scans individuels pour effectuer des
actions supplémentaires dans la phase « Select » (Sélection) du mode Révision.

Les données contenues dans le systeme sont disposées dans trois tableaux, en fonction
du type d’'informations. Il y a un tableau pour les procédures, pour les scans de la
procédure sélectionnée, et pour les marques et captures d’écran du scan sélectionné.

Filtre
Archive Status
7]
20:04:12 REPEAT Pullback ||' @ .
Liste de
scans
Liste de

procédures
Liste de
marques
Historique
de scans

Figure 12-2 : phase « Select » (Sélection) du mode Révision avec indication des différentes listes d’informations.

Vous pouvez afficher les procédures sélectionnées ou imprimer les captures d’écran ou
rapports de marques. Vous pouvez exporter et afficher les procédures cochées. Si la
procédure cochée est aussi la sélection actuelle, vous pouvez imprimer ses captures
d’écran ou rapports de marques.

Pour sélectionner une seule procédure, appuyez a n'importe quel endroit sur la ligne
d’'informations de la procédure dans la liste de procédures. La procédure sélectionnée
devient la sélection actuelle. Les scans de cette procédure s’affichent dans la liste

de scans.

Cochez les cases pour sélectionner plusieurs procédures afin d’exporter des lots de
données depuis le systeme.

Remarque : Par défaut, les procédures seront classées en commencant par
la date de procédure la plus récente en haut de la liste.

Remarque : Les scans seront classés par défaut dans I'ordre chronologique,
le scan le plus ancien étant en haut de la liste.
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Remarque : Appuyez sur les en-tétes de colonnes des listes de procédures
et de scans pour modifier le classement des informations.

Remarque : Lorsqu’une procédure est cochée, tous les scans gu’elle
contient sont cochés par défaut.

Pour sélectionner plusieurs procédures, appuyez sur la case a cocher a cété des
informations de la procédure souhaitée. Enlevez les procédures d’'une sélection multiple
en appuyant a nouveau sur la case a cocher.

Remarque : L’exportation personnalisée n’est possible que pour une seule
procédure.

12.1.1 Historique de scans

Les modifications apportées aux scans apres la procédure seront enregistrées dans
I'historique de scans. Ceci inclut les modifications portant sur le nom de scan, les ajouts
ou suppressions de marques, et les actions d’exportation ou d’archivage.

12.1.2 Filtrer la liste de procédures

Entre I'archivage de routine et la suppression des données du systeme, le catalogue de
procédures enregistrées peut devenir fort long. Utilisez un filtre par terme pour réduire
le nombre d’entrées affichées dans la liste de procédures et faciliter la sélection.

Select

ient ID Gender | Physician Name

Modifier la
procédure

Figure 12-3 : phase « Select » (Sélection) avec filtre appliqué aux listes de procédures et de scans pour les entrées
contenant le mot « Sample ».

Saisissez un court volume de texte dans la case de filtre, cela réduira la liste a un
nombre d’entrées plus facilement gérable.
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Le systeme recherchera ces caractéres dans les ID de procédure, noms de patients,
ID de patients, noms de médecins, références de lot de cathéter ou notes de scan.

Appuyez sur Effacer, m pour revenir a la liste compléte des procédures.

12.1.3 Modifier la procédure
Vous pouvez modifier les informations de procédures ou de patients pour rectifier ou
mettre a jour des informations. Dans la liste de procédures comprenant la sélection

O
actuelle, appuyez sur I'icone Modifier, , pour ouvrir la fenétre « Edit Procedure »
(Modifier la procédure).

Les détails de la procédure actuelle s’affichent dans la fenétre « Edit Procedure »
(Modifier la procédure). Utilisez les commandes disponibles pour mettre a jour
les champs.

Edit Procedure

TS 70170618

Wl 12/14/3015 =)

Save
(Enregistrer)

Cancel
(Annuler)

Figure 12-4 : phase « Select » (Sélection) avec fenétre « Edit Procedure » (Modifier la procédure) ouverte.

Appuyez sur « Save » (Enregistrer), E&EE pour enregistrer les modifications et fermer

la fenétre. Appuyez sur « Cancel » (Annuler), m pour fermer la fenétre sans
enregistrer les modifications.

infraredy:

A N NIPRD COMPANY

IFU0163rJ.fr (2021-05-05) 12-4



Makoto Intravascular Imaging System™
Guide d’utilisation

Remarque : Les modifications apportées a la procédure affecteront tous les
scans associés a la procédure dans le systeme. Ceci inclut les
scans non cochés.

Remarque : Affichez la procédure pour modifier les détails de scans inclus
dans la procédure sélectionnée.

12.1.4 Imprimer le rapport

Vous pouvez imprimer des rapports complets sur une sélection d’'une ou de plusieurs
procédures depuis le Makoto Intravascular Imaging System™ en utilisant une
imprimante compatible configurée.

Remargue : Contactez votre représentant commercial local ou le service
client Infraredx pour plus d’informations sur les imprimantes
compatibles et leur configuration.

Les rapports complets incluront un réesumé de tous les scans effectués dans une
procédure, y compris les régions créées et les marques et mesures effectuées. Pour
imprimer un rapport complet, sélectionnez une procédure en cochant la case a coté de
I'entrée dans la liste de procédures, puis en appuyant sur le bouton « Print » (Imprimer

le rapport de procédure),

52:38 Frame 2 LiveRecording

Imprimer le
rapport de
marque

Imprimer le
rapport de
procédure

RS-IVUS [DI
)

Figure 12-5: phase « Select » (Sélection) avec indication du bouton Print Mark Report (Imprimer le rapport de marques).
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Sélectionnez une marque ou une capture d’écran et appuyez sur « Print » (Imprimer),
E, pour envoyer un rapport de marques d’'une page ou une capture d’écran vers

limprimante.

Remargue : Le contenu du rapport de marques est inclus dans le rapport
complet pour la procédure.

12.1.5 Afficher
Pour afficher, modifier, analyser et supprimer des scans inclus dans la procédure

actuellement sélectionnée, appuyez sur le bouton « View » (Afficher), Id&ll. Ceci
charge tous les scans de la procédure actuellement sélectionnée dans la phase
« View » (Visualisation) du mode Révision.

Vous pouvez naviguer, afficher, modifier et supprimer la procédure et les scans de la
méme maniére que dans la phase « Scan » (Numérisation) du mode Acquisition.

Reportez-vous a la section 10 Révision, mesure et annotation de scans pour plus
d’informations et de conseils.

03/11/2015 Sample, Delta DOB 01/01/1954 [~ -~ = (y'vus
Select \_J) ¥ NIRs

Figure 12-6 : phase « View » (Visualisation) du mode Révision.

Remarque : Les modifications apportées aux marques, régions, mesures et
annotations lors de la phase « View » (Visualisation) seront
intégrées aux données de procédure enregistrées lorsque vous
revenez a la phase de sélection.
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Appuyez sur « Select » (Sélectionner), SE|ECt , sur le ruban de progression ou sur le
bouton de sélection de mode Makoto pour revenir a la phase de sélection du mode
Révision.

12.2Exportation et archivage

Le Makoto Intravascular Imaging System™ offre plusieurs méthodes et formats
d’exportation des données depuis le systeme. Vous disposez de deux méthodes
rapides configurables pour I'exportation et d’'une méthode d’exportation personnalisée.

Il est possible d’exporter une ou plusieurs procédures sélectionnées depuis le systéme,
a des fins d’archivage ou pour toute autre utilisation. Aprés avoir sélectionné les
procédures souhaitées, utilisez le bouton « Export Destination » (Destination
d’exportation) pour démarrer le transfert de données.

Select

Archive
Status (Etat
d’archivage)

. C
Mo PACS
oo
Supports
| | amovibles
W o (USB/DVD)
o
Boutons de :
destination =
. C

d’exportation Personnalisé

(USB/DVD)

Figure 12-7 : phase « Select » (Sélection) avec indication des boutons de destination d’exportation.

Lorsque I'exportation est terminée, la liste de scans est actualisée et indique la
destination d’archivage dans la colonne « Archive Status » (Etat d’archivage).

12.2.1 Configurer les destinations d’exportation
Les formats d’exportation et la compression par défaut peuvent étre configurés pour les
destinations PACS et supports amovibles (USB/DVD).
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Reportez-vous aux sections 13.2 et 13.3 pour plus d’'informations sur la configuration de
ces parametres par défaut.

12.2.2 Exportation PACS

Assurez-vous que les cables provenant du Makoto Intravascular
Imaging System™ ou y étant branchés sont bien a plat sur le
sol.

AVERTISSEMENT

Les données issues du Makoto Intravascular Imaging System™ peuvent étre stockées
sur le systeme PACS de I'hépital si les systémes ont été correctement configurés. Les
systemes PACS acceptent les données formatées selon la norme DICOM.

Le systeme est congu pour étre connecté a un réseau d’hdpital protégé pour un
transfert direct des données du Makoto Intravascular Imaging System™ vers une
solution de stockage réseau telle que le PACS. Raccordez un céable blindé Cat5e au
connecteur PACS ou un cable d’'intégration mobile Infraredx au connecteur pour
rayons X du cété droit de la console Makoto™.

Configurez les paramétres de connexion PACS en suivant les conseils fournis a la
section 13 Parametres systeme.

Appuyez sur le bouton PACS, IEZXsS8 pour commencer le transfert des procédures
cochées vers la destination configurée.

La connexion a des réseaux informatiques, y compris d’autres
éguipements, peut entrainer des risques jusque-la non identifiés

ATTENTION Pour les patients, opérateurs et tiers.

A Les modifications apportées au réseau informatique peuvent
entrainer de nouveaux risques exigeant des analyses
ATTENTION  supplémentaires. Les modifications du réseau informatique
incluent :
¢ modifications de la configuration réseau ;
e connexion d’éléments supplémentaires ;

e déconnexion d'éléments ;

infraredy:

A N NIPRD COMPANY

IFU0163rJ.fr (2021-05-05) 12-8




Makoto Intravascular Imaging System™
Guide d’utilisation

e mises a jour d’équipements ;
e mises a niveau d’équipements.

Le client est tenu d’identifier, analyser, évaluer et contréler les
risques liés a la connexion du Makoto Intravascular Imaging

ATTENTION System™ aun réseau informatique.

12.2.3 Exportation vers des supports amovibles (USB/DVD)
Les données issues du Makoto Intravascular Imaging System™ peuvent étre exportées
vers des supports amovibles, USB ou supports Blu-Ray/DVD/CD inscriptibles.

USB 3.0
Blu-Ray/DVD/CD

= | I

Figure 12-8 : panneau pour supports amovibles du Makoto Intravascular Imaging System™

Le systeme vérifiera automatiquement la présence de supports amovibles dans les
ports USB et le lecteur optique du systeme.

Vérifiez les sélections de procédures et de scans ainsi que la taille totale d’exportation.
Confirmez les formats de fichier d’exportation.

Si la taille d’exportation souhaitée est inférieure a I'espace disponible sur le support de
destination de I'exportation, appuyez sur le support souhaité pour commencer
I'exportation. Si la taille d’exportation estimée est trop importante pour le support,
révisez les formats et la sélection de procédures afin de réduire la taille de I'exportation.
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Export Procedures

rocedure Date | Name

m 07/01/2018 MC10.2, Sample2

Espace
disponible sur
le support de

Sélection de destination
procédures et
de scans
Modifier le
format e P A—— Taille estimée
’ 7 Total Export Size: 2.37 GB .
d’exportation = de I'exportation

Figure 12-9 : fenétre d’exportation vers un support amovible.

Décochez des scans individuels ou des procédures entieres pour réduire la
taille d’exportation.

Reportez-vous a la section 13.3 pour plus d’'informations sur la configuration et la
modification des formats d’exportation par défaut.

Remarque : Un disque de support optique de la session ouverte peut étre
crée ; il acceptera plusieurs exportations en décochant
« Finalize disc » (Finaliser le disque) dans les options
d’exportation USB/DVD décrites a la section 13.3.

12.2.4 Exportation personnalisée

Les données issues du Makoto Intravascular Imaging System™ peuvent étre exportées
vers des supports amovibles de maniére personnalisée. Cette méthode d’exportation
implique de sélectionner ou de confirmer les formats de données et la destination de
stockage. Cette méthode permet également a l'utilisateur de supprimer les identifiants
souhaités de I'ensemble de données.

Les informations d’identification incluses dans le texte des
annotations d’'image ou de scans ne seront pas modifiées.
ATTENTION

Remargue : L’exportation personnalisée est utile pour les exportations de
données inhabituelles ou pour des applications de recherche qui
exigent 'anonymat.

Remarque : L’exportation personnalisée n’est possible que pour exporter
une seule procédure.
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Sélectionnez les procédures et scans souhaités en appuyant sur leurs entrées dans les
listes de procédures et de scans. Appuyez sur le bouton d’exportation personnalisée,

, pour ouvrir la fenétre d’exportation personnalisée.

Export Procedure (07/01/2018 - MC10.2, Sample2 )

Medium (Better quality) -

Medium (Better quality) -

Figure 12-10 : fenétre d’exportation personnalisée permettant de définir des types et des formats de données pour
I'exportation vers des supports amovibles.

Confirmez les derniers parametres de format de données utilisés pour les supports
amovibles ou modifiez si nécessaire pour cette exportation. Consultez la section 13.2
pour plus d’'informations sur les types et formats de données.

Consultez la section 13.3 pour en savoir plus sur la finalisation des supports optiques.

Si le lecteur DICOM désiré nécessite que le DICOMDIR soit écrit au niveau de la racine
du support amovible, cochez I'option « Export files to root directory (top level) of target
media » (Exporter les fichiers vers le répertoire racine (niveau maximal) du support
cible). Cette option nécessite que le support cible soit vide.
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Export Procedure (07/01/2018 - MC10.2, Sample2 )

Medium (Better quality) «

Medium (Better quality) -

[UERIE PACS
C

Total PACS Size:0.90 GB 4
Total USB/DVD Size: 1.20 GB ose

Figure 12-11 : fenétre d’exportation personnalisée pour configurer des emplacements de stockage réseau alternatifs.

Si les données d’exportation personnalisée sont transférées en passant par le réseau,
confirmez ou modifiez les fichiers de données DICOM et les paramétres de compression.
Configurez un serveur PACS alternatif pour transférer les données personnalisées.

Remarque : Les éléments PACS a inclure et les paramétres PACS utilisés
pour une exportation personnalisée n’affecteront pas les
parametres standards d’exportation PACS.

Remarque : De nombreux programmes d’analyse capables d’analyser des
données issues du systéme Makoto™ acceptent le transfert
réseau d’informations DICOM. Utilisez I'exportation
personnalisée pour configurer 'adresse réseau des postes
d’analyse si elle difféere du PACS des dossiers médicaux de

I'hépital.
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Export Procedure (07/01/2018 - MC10.2, Sample2 )

Patient 1D EISISSEEeY
DEICE LGN 01/01/2021

@ Vale
( del

Jll 07/01/2018 £

Total PACS Size: 0.90 GB
Total USB/DVD Size: 1.20 GB

Figure 12-12 : fenétre d’exportation personnalisée pour I'anonymisation des données de procédure.
Rendez les données anonymes en utilisant les fonctions « Anonymize » (Anonymiser).
Cochez la case « Anonymize » (Anonymiser) et saisissez les informations alternatives
souhaitées.

REMARQUE : L’anonymisation ne modifie pas les données originales qui
restent dans le systéeme.

REMARQUE : Les fonctions d’anonymisation n’affectent pas I'heure de
procédure ou toute note, commentaire ou annotation effectués
au niveau des scans.

REMARQUE : Les fonctions d’anonymisation permettent de masquer le nom
et la date de naissance du patient, mais n’ont pas d’impact sur
le reste du contenu des captures d’écran.
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Export Procedure (07/01/2018 - MC10.2, Sample2 )
Procedure export status: Exporting scans

19:51:06 pre

20:04:12 REPEAT

Total PACS Size: 0.90 GB
Total USB/DVD Size: 1.20 GB

A Do not remove media while export is in progress

Figure 12-13 : fenétre d’exportation personnalisée avec une exportation de scan vers support USB en cours.

Vérifiez la taille des données a exporter pour vous assurer qu’elles pourront étre
contenues sur le support de destination. Modifiez vos sélections si nécessaire.

Appuyez sur le support amovible de destination pour démarrer le transfert vers la
destination avec les types, formats et compressions de fichiers qui ont été configurés.

12.3 Importer des données
Il est possible d'importer les données de procédures et de scans sur le Makoto
Intravascular Imaging System™ pour les visionner, modifier, mesurer et réexporter.

REMARQUE : Les données archivées au format TVC peuvent étre importées
sur tout Makoto Intravascular Imaging System™ ayant un
numéro de modele compatible pour étre visionnées
ultérieurement.

Le Makoto Intravascular Imaging System™ accepte les données au format TVC (*.tvc
de TVC-MC10 ou TVC-MC9) ou les données d’exportation TVC (*.zip de TVC-MCS8 ou
TVC-MCB8Xx) générées par ce systeme ou un autre systeme d’imagerie TVC. Ces
données peuvent étre importées depuis des sources Blu-Ray, DVD ou USB.

12.3.1 Conflits d’importation

Si les données existent déja ou que les données de scan de procédure ou de patient
importées sont similaires aux données deéja présentes dans le systéme, une intervention
supplémentaire de I'utilisateur peut étre nécessaire pour terminer cette action.
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La résolution de conflit aura lieu aprés que toutes les tentatives d’'importation ont été
traitées. Cela permettra de résoudre tous les conflits en une fois et de faciliter
grandement I'importation par lot.

r

9 Scan already exists on the system, do you want to
overwrite it?

Existing scan:

Patient: Sample, Delta 01/01/1954
Scan name: RCA
Start time: 03/11/2015 14:32:50

Will be overwritten with:

Scan name: RCA
Start time: 03/11/2015 14:32:50

v X

Import  Skip

| |

Figure 12-14 : message de conflit d'importation. Ecrasez ou annulez I'importation du fichier pour résoudre le conflit.

Lorsque le message de conflit d'importation s’affiche, vous pouvez choisir :

« Import » Pour passer a la résolution du conflit. S’il n’y a aucune modification

(Importer) de données de procédure ou de patient, le fichier existant sur le
systeme est écrasé. S'il y a des modifications de données de
procédure ou de patient, I'utilisateur doit prendre une décision pour
les informations concernées.

Ou

« Skip » (Passer) Ce conflit d'importation sera passé et 'utilisateur devra résoudre
d’autres conflits liés au lot importé.

infraredy:

A N NIPRD COMPANY

IFU0163rJ.fr (2021-05-05) 12-15



Makoto Intravascular Imaging System™
Guide d’utilisation

The procedure information for the incom onflicts with the The procedure information for the incom
procedure currently on the system. What vant to do? ocedure currently on the system. Wha

Import Information  Existing Information Import Information  Existing Information
/2015 03 015 re e Date 0 2015 03/11/2015

Patient Gender Female

g Information will b subsequent imports for the same procedure
during this import

Y % v X

Figure 12-15 : message de résolution de conflit d’importation.

Si l'utilisateur décide de résoudre le conflit d'importation et que des informations de
procédure ou de patient ont été modifiées, I'utilisateur doit choisir :

« Use Import » Pour utiliser les informations de procédure et de patient du fichier
(Utiliser le fichier  importé. Cette décision s’appliquera aux autres scans importés
importé) pour cette procédure lors de I'importation de lot ET modifiera

tous les scans déja présents sur le systeme et appartenant a la
méme procédure.

Ou

« Use Existing » Pour utiliser les informations de procédure et de patient déja

(Utiliser le fichier  présentes dans la mémoire du systeme pour modifier le fichier

existant) importé. Cette décision s'appliquera aux autres scans importés
pour cette procédure lors de cette importation de lot.

Ou

« Skip » (Passer) Ce conflit d'importation sera passé et I'utilisateur devra résoudre
d’autres conflits liés au lot importé.

Sélectionner « Import » (Importer) importera ces données de procédure conformément
a la sélection.
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12.4 Supprimer des scans et procédures
Vous pouvez supprimer des procédures et scans stockés sur le systeme pour libérer de
I'espace disponible dans la mémoire locale.

Vous pouvez supprimer des procédures entieres, une a la fois, depuis la phase
« Select » (Sélection) du mode Révision. Appuyez sur la procédure pour la

sélectionner, puis appuyez sur le bouton « Delete » (Supprimer), . Vous devrez
confirmer cette action, car la suppression ne peut pas étre annulée.

A La suppression de données du systeme est définitive et NE
PEUT PAS étre annulée.

ATTENTION

Vous pouvez supprimer des scans lors de la phase « View » (Visualisation) ou « Scan »
(Numérisation) en supprimant les scans individuellement en ouvrant la fenétre « Scan
Edit » (Modifier le scan). Reportez-vous a la section 10.2.9 Supprimer le scan pour
davantage d’'informations et de conseils sur cette fonction.

REMARQUE : Il n’est pas possible de supprimer le dernier scan d’'une
procédure lors de la phase « View » (Visualisation). Revenez
a la phase « Select » (Sélection) et supprimez la procédure
pour effacer totalement la procédure du systeme.

REMARQUE : Supprimer un scan effacera toutes les captures d’écran et
mesures associées.

Le Makoto Intravascular Imaging System™ n’est pas congu pour constituer un
emplacement permanent de stockage de données. Le client est fortement encouragé a
établir un plan de sauvegarde et d’archivage incluant la suppression périodique des
données du systeme.

Le Makoto Intravascular Imaging System™ n’est pas destiné a
servir d’'emplacement permanent de stockage de données ou
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13 Parametres systeme

Il est possible de configurer les paramétres locaux du Makoto Intravascular Imaging
System™ pour répondre aux besoins de 'utilisateur. L’utilisateur peut configurer les
parametres de communication réseau, les formats d’exportation par défaut, ajuster les
parametres d’affichage et accéder aux utilitaires de diagnostic du systeme.

Edit Settings

Figure 13-1: paramétres systéme, section « About » (A propos de).

REMARQUE :

L'utilisateur doit appuyer sur « Save » (Enregistrer), E
pour que les modifications apportées aux parametres
soient appliquées.

13.1About (A propos de)
Cette section des parametres systeme fournit des informations sur le numéro de modele du
systéme ainsi que les numeéros de version des logiciels installés actuellement.

Les informations de contact du fournisseur et/ou prestataire de service du client sont
disponibles a cet emplacement.
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13.2 PACS
Cette section des parametres systeme vous permet de configurer les types de données
ainsi que 'emplacement et les identifiants du serveur PACS.

Edit Settings

About Ites

m W NIRS 5 JPEG Medium (Better quality)

Medium (Better quality) -

[123.456 Port W enable TLs

Figure 13-2 : parameétres systéme, section « PACS ».

13.2.1 Eléments de données ainclure

Le Makoto Intravascular Imaging System™ permet de générer plusieurs types de
données et de rapports.

Ces types et formats de fichiers sont décrits dans le tableau ci-dessous :

Tableau 1: types et formats de fichiers de données disponibles

Type de fichier Formats disponibles
DICOM  Standard Description

NIRS-IVUS Oui *.avi Une boucle des images transversales
enregistrées des données NIRS et
IVUS.
Les enregistrements en direct d'IVUS
ou d’images ne produiront que des
images d’'IVUS ou en niveaux de gris.

IVUS Oui *.avi Une boucle des images transversales
enregistrées des données IVUS
uniquement.

Rapport Oui *. pdf Un rapport résumant les informations
du patient, les détails de la procédure,
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Type de fichier Formats disponibles
DICOM  Standard Description
les annotations, les mesures, les

régions et les marques.

TVC Non * tve Un fichier contenant les données NIRS
et IVUS au format natif du systeme.

Capture d’écran Oui *.png Captures d’écran générées par le
systeme et enregistrées par
I'utilisateur.
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Type de fichier Formats disponibles
DICOM  Standard Description

13.2.2 Compression JPEG

Les parametres de compression du format de données DICOM peuvent étre ajustés
pour améliorer la qualité d'image ou réduire la taille du fichier de données.

Le Makoto Intravascular Imaging System™ offre une compression JPEG pour produire
des fichiers images a compression faible, moyenne ou élevée.

Tableau 2. Paramétres de compression DICOM

Parametre de Qualité Parametre de Taille de fichier
compression d’'image gualité d’image

(qualitative) (1-100) (qualitative)
Bas Tres 100 Large

elevée
Moyen Elevée 80 Moyenne
Elevé Bon 50 Petite

13.2.3 Interprétation photométrique pour les fichiers couleur DICOM

La norme DICOM propose différentes méthodes d’encodage des informations d’images
couleur. Le Makoto Intravascular Imaging System™ vous permet de choisir « RGB » ou
« YBR Full 422 ».

13.2.4 Paramétres de connexion au serveur PACS
Pour utiliser I'option d’exportation PACS, il est nécessaire de configurer I'adresse réseau
du serveur PACS. Pour configurer 'adresse, saisissez les informations suivantes :

IP L'adresse de protocole Internet, version 4 du PACS.

Port Le port de communication sur lequel le PACS
communiquera. Il s’agit généralement du port 104.

« Name » (Nom) Le nom de réseau du serveur PACS.

Client Le nom utilisé pour identifier le Makoto Intravascular Imaging
System™ sur le réseau.

« Enable TLS » Activer ou désactiver I'utilisation d’'identifiants sécurisés pour
(Activer TLS) accéder au PACS. Si cette option est activée, fournissez le
mot de passe et le certificat requis.
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i . Test Connection |
Appuyez sur « Test Connection » (Tester la connexion), I, pour vous

assurer que le PACS et le Makoto Intravascular Imaging System™ peuvent
communiquer. Contactez votre agent de service ou le service client Infraredx pour
obtenir une assistance pour la configuration.

13.3USB/DVD (supports amovibles)
Vous pouvez configurer les options de formats de données par défaut a enregistrer
pour les supports amovibles dans cette section des parametres systeme.

Edit Settings

UECIRRE [ ow (Best quality) -
Low (Best quality)

Figure 13-3 : parametres systéme, section « USB/DVD ».

13.3.1 Formats DICOM a inclure

Les formats DICOM disponibles, décrits dans le tableau 1 ci-dessus, sont également
disponibles pour I'exportation vers des supports amovibles. Il est possible d’associer
I'exportation de formats de fichiers DICOM et standards en une seule action
d’exportation.

13.3.2 Formats standards ainclure

Outre les types de fichiers de données uniqguement disponibles en format DICOM, vous
pouvez sélectionner des types de fichiers de données supplémentaires en format
standard (non DICOM).

Les formats standards peuvent étre plus adaptés a la présentation, la création ou le
visionnage lorsque les outils DICOM ne sont pas disponibles.
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13.3.2.1 Compression AVI
Les parametres de compression avi des données IVUS ou IVUS+NIRS sont définis sur
les codecs suivants : XviD.

13.3.3 Supports optiques

L’enregistrement multisession est pris en charge lors de I'exportation sur supports
optiques (CD, DVD, Blu-Ray). Décochez « Finalyze disc » (Finaliser le disque) pour
permettre des exportations supplémentaires vers le méme support.

13.4Liste de travail de modalité
Vous pouvez configurer 'emplacement réseau et les identifiants de connexion de la
liste de travail des modalités en remplissant les champs de cette section.

Edit Settings

Server

Connection status: Unknown

Te ection

Figure 13-4 : parametres systéme, « Modality Worklist » (Liste de travail des modalités)

13.4.1 Parameétres de connexion serveur de la liste de travail des modalités
Pour utiliser les options de configuration semi-automatiques de la liste de travail des
modalités, il est nécessaire de configurer I'adresse réseau du serveur de la liste de
travail. Pour configurer I'adresse, saisissez les informations suivantes :

IP L’'adresse de protocole Internet, version 4 du serveur de la
liste de travalil.

Port Le port de communication sur lequel le serveur de la liste de
travail communiquera. Il s’agit généralement du port 104.

« Name » (Nom) Le nom de réseau du serveur de la liste de travail.

Client Le nom utilisé pour identifier le Makoto Intravascular Imaging
System™ sur le réseau.
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« Secure TLS » Activer ou désactiver l'utilisation d’'identifiants sécurisés pour
(TLS sécurisé) accéder a la liste de travail. Si cette option est activée,
fournissez le mot de passe et le certificat requis.

) . Test Connection |
Appuyez sur « Test Connection » (Tester la connexion), I, pour vous

assurer que le serveur de la liste de travail et le Makoto Intravascular Imaging System™
peuvent communiquer. Contactez votre agent de service ou le service client Infraredx
pour obtenir une assistance pour la configuration.

13.5Champs requis

La phase « Setup » (Configuration) du systeme peut étre configurée de maniére a ce
gue certains champs doivent étre remplis avant de fermer une procédure ou de modifier
les informations relatives a des procédures terminées. Il est possible de définir un
champ comme requis en le sélectionnant dans la liste « Not Required » (Non requis) et
en cliquant ou en appuyant sur le bouton « Add >> » (Ajouter >>). Sélectionnez des
champs dans la liste « Required » (Requis) et en cliquant ou en appuyant sur « <<
Remove » (<< Retirer) pour réduire les exigences.

Edit Settings

list

Required Field

an D

Figure 13-5: parametres systéme, section « Required Fields » (Champs requis).
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13.6 Affichage des scans

La section « Scan Display » (Affichage des scans) des paramétres systéeme permet de
personnaliser certains aspects visuels des phases « Scan » (Numeérisation) et « View »
(Visualisation).

Edit Settings

Figure 13-6 : parametres systéme, section « Scan Display » (Affichage des scans).

13.6.1 Mesures transversales

Utilisez ce bouton pour afficher ou masquer les mesures et les résultats transversaux
sur I'affichage. Le fait de réduire les résultats de mesure masquera également les
contours des mesures. Lorsque vous ouvrez des scans pour les examiner, les mesures
seront masqueées et les résultats seront réduits.

13.6.2 Plage d’'images de larévision du flux lumineux
Utilisez cette commande pour modifier la plage d'images jouées lorsque la fonction de
révision du flux lumineux est activée, voir section 10.3.2 Révision de la lumiere.

13.6.3 Visibilité longitudinale du chemogram du niveau du bloc

La visibilité du chemogram au niveau du bloc peut étre modifiée en fonction des
préférences de l'utilisateur. Ces changements deviendront les parametres par défaut
pour les nouveaux scans enregistrés. La visibilité du chemogram au niveau du bloc sur
chaque scan peut étre définie en modifiant les propriétés du scan, section 10.2
Modification des scans.
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REMARQUE : Pour ajuster la visibilité du chemogram longitudinal au niveau
du bloc sur un scan, consultez la section 10.2 Modification
des scans.

13.6.4 Visibilité transversale du bloc du chemogram

La visibilité du chemogram au niveau du bloc au centre de I''VUS transversal peut étre
modifiée en fonction des préférences de l'utilisateur. Ces changements deviendront les
parametres par défaut pour les nouveaux scans enregistrés. La visibilité du chemogram
au niveau du bloc sur chaque scan peut étre définie en modifiant les propriétés du scan,
section 10.2 Modification des scans.

REMARQUE : Pour ajuster la visibilité du chemogram au niveau du bloc sur
'image de I'lVUS transversal d’un scan, consultez la section
10.2 Modification des scans.

13.6.5 « mx LCBI Window Size » (Taille de fenétre du LCBI max)

Utilisez cette commande pour modifier la taille de fenétre du LCBI max du scan par
défaut sur I'écran. Les résultats du LCBI max dans les rapports seront générés a l'aide
du réglage actuel de la taille de fenétre du LCBI max. Cette valeur peut étre réglée a
l'aide du curseur entre 1 mm et 10 mm par incréments de 1 mm.

REMARQUE : Pour ajuster la fenétre mxLCBI sur un scan, consultez la
section 10.2 Modification des scans.

13.7 Assistance technique

Cette section des parametres systéme permet de configurer I'exportation des fichiers
journaux du systeme. Ces fichiers fournissent des informations utiles aux techniciens de
maintenance pour diagnostiquer les problemes de performances du systéme.
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Edit Settings

Figure 13-7 : parametres systéme, section « Support » (Assistance technique).
Définissez la plage de dates souhaitée a I'aide des contrdles fournis, décidez de
l'inclusion des fichiers de données et de résultats SST améliorés, puis choisissez la
destination ou les fichiers seront copiés.

Les fichiers généreés par cet utilitaire ne contiennent aucune information de santé
protégée.

13.8« Service Options » (Options de service)

Dans cette section des parametres, définissez le nom de I'établissement ou les
procédures sont effectuées et enregistrées. Le texte saisi dans ce champ s’affichera
dans I'en-téte DICOM des fichiers générés par le systeme.

Si le systéme a été configuré avec une imprimante par défaut, il est possible d’activer
et de désactiver les boutons d’impression du systeme.
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Edit Settings

Enter the service password to unlock more options

iptions

Figure 13-8 : parametres systéme, section « Service Options » (Options de service).

Cette section des parametres systeme permet également aux techniciens de
maintenance formés d’accéder aux utilitaires de diagnostic.
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14 Intégration de I'’exportation vidéo et du systeme

a rayons X
Le Makoto Intravascular Imaging System™ peut transmettre de la vidéo, des données
ou partager le contrdle avec un systéme a rayons X fluoroscopique compatible.

L'utilisation des fonctions présentées dans cette section peut impliquer des connexions
cablées supplémentaires depuis des emplacements fixes vers la console Makoto™.

AVERTISSEMENT

14.1Sortie vidéo numérique

Il est possible d’exporter le signal vidéo de la console Makoto™ en raccordant un
moniteur externe au systeme a l'aide d’un cable DVI-D. Le raccordement du cable DVI-D
au connecteur de sortie vidéo permet d’exporter une image de 1920 x 1080 pixels de
I'écran du moniteur du médecin.

De maniére optionnelle, il est possible de configurer la résolution de la vidéo exportée a
1600 x 1200 pixels (rapport d’aspect 4:3), contactez votre agent de service ou le service
client Infraredx pour obtenir une assistance.

Figure 14-1: panneau d’exportation vidéo et de contrdle du Makoto Intravascular Imaging System™

La sortie vidéo DVI-D est située au centre du panneau, il s’agit du troisieme connecteur
en partant de la droite.
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15 Glossaire des termes

Chemogram au niveau du Une représentation simplifiee des informations de chemogram,

bloc

Chemogram

Bloc de chemogram

Halo du chemogram

Console

Interface utilisateur de la
console

Indicateur de spectre

Masque de cathéter de
guidage

Indicateur du fil-guide

Letterbox (panoramique)

Indice de masse du coeur
lipidique

IFU0163rJ.fr (2021-05-05)

segmentée en blocs discrets qui ne dépendent pas des
informations de position de rotation.

Une carte prenant la forme d’'une représentation graphique
indiquant la probabilité de présence de plaques d’intérét
contenant un cceur lipidique.

Un segment unigue du chemogram du niveau du bloc.

Une représentation de la portion du chemogram située au
niveau d’'une image IVUS transversale donnée, qui s’affiche
avec un anneau de couleur autour de I''VUS transversale qui
est enregistrée en rotation.

Le principal composant du Makoto Intravascular Imaging
System™ : il contient le laser, le logiciel, I'alimentation
électrique et I'ordinateur.

Fournit a l'utilisateur une interface interactive pour collecter ou
examiner des données a l'aide des boutons de controle a
I'écran.

Affichage graphique représentant le nombre de spectres
valides enregistrés lors d’'une acquisition de retrait.

Inclus dans le progiciel pour détecter automatiquement un
cathéter guide. Cette fonctionnalité peut étre activée et
désactivée par le médecin.

Une carte permettant au médecin d’identifier de possibles
artefacts, y compris ceux causés par la présence d’un fil guide.

Un format d’affichage d’informations dans lequel des bandes
noires apparaissent au-dessus et en dessous du contenu de
l'image afin de remplir I'écran sans déformer le contenu de
limage.

Une mesure de la proportion globale de cceur lipidique dans le
segment artériel scanné sur une échelle de 0 a 1000 (masse
du cceur lipidique faible a élevée).
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Image composée La configuration d’affichage du Makoto Intravascular Imaging
System™ qui inclut le chemogram, I'lVUS longitudinale et
I'IVUS transversale avec halo de chemogram.

Cordon Le céble permettant de raccorder le contréleur Makoto™ a la
console Makoto™.

XviD Un codec de compression de fichier vidéo produisant de petits
fichiers vidéo faciles a gérer et pouvant étre lus sur de
nombreux lecteurs.
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16 Entretien

16.1Informations relatives au systeme

Le systeme comprend trois composants principaux : une console, un contréleur (sous-
systeme de retrait/rotation) et le cathéter. Ces composants sont connectés de maniéere
optique, électrigue et mécanique.

Le systeme est compatible avec les accessoires suivants :

Kit d’impression Bluetooth (REF TVC-9BPK)
Cable blindé Cat5e (REF PN2690)
Cable vidéo blindé DVI-D (REF PN2665)
Données intégrées et cable vidéo (REF TVC-10PMC)

Les dispositifs Makoto Intravascular Imaging System™ (TVC-MC10, TVC-MC10i) fabriqués
par Infraredx sont congus pour une utilisation avec le modeéle de cathéter suivant :

Dualpro™ IVUS+NIRS Imaging Catheter (REF TVC-C195-42)

Les caractéristiques de la console du Makoto Intravascular Imaging System™ et du
contrbleur Makoto™ sont détaillées ci-dessous. Les caractéristiques du cathéter
d’'imagerie coronarienne peuvent étre obtenues dans les instructions d’utilisation du
cathéter associé incluses dans I'emballage du cathéter.

16.1.1 Caractéristiques physiques

e La console Makoto™ occupe un espace de 61 cm de large, 150 cm de haut et 71 cm
de profondeur (24" x 56" x 28") (hors cables et fibres).

e La console Makoto™ comporte quatre roues, dont deux avec blocage de position et
deux avec blocage de direction.

e La poignée de la console Makoto™ est congue pour faire rouler la console. La console
ne peut pas étre soulevée par sa poignée.

e Le contrbleur Makoto™ occupe un espace de 12,7 x 15,2 x 43,2 cm (5" x 6" x 17") (hors
cables et fibres).

e Le Makoto Intravascular Imaging System™ pése 92 kg (202 Ib).

16.1.2 Environnement

e La console doit étre utilisée a une température ambiante de 15 a 32 °C (60 a 90 °F).

e La console doit étre utilisée a un taux d’humidité ambiante de 20 % a 80 % (sans
condensation).

e La console doit étre transportée et stockée a une température de -12 a 50 °C
(10 a2 120 °F).

e La console doit étre transportée et stockée a un taux d’humidité relative de 10 % a 85 %
(sans condensation).
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Le cathéter compatible, TVC-C195-42, doit étre utilisé et conservé a température
ambiante de 15 & 30 °C (60 a 86 °F).

Le cathéter compatible, TVC-C195-42, ne fait 'objet d’aucune exigence d’humidité
relative pour le fonctionnement ou le stockage. Le produit doit &tre maintenu au sec.
Le cathéter compatible, TVC-C195-42, doit étre transporté dans une plage de
température de 15 a 30 °C (60 a 86 °F).

Le cathéter compatible, TVC-C195-42, doit étre transporté a un taux d’humidité relative
de < 85 % (sans condensation).

16.1.3 Caractéristiques électriques

Le dispositif fonctionne sur une tension secteur nominale de 100 VCA, 120 VCA,

220 VCA ou 240 VCA, 50 — 60 Hz, monophasé. Le module d’entrée de I'alimentation
doit étre configuré manuellement a une tension d’entrée et une protection par fusibles
appropriées. Pour une utilisation sur du 100 VCA ou 120 VCA, deux fusibles 3AG
rapides a haut pouvoir de coupure de 5 A sont utilisés. Pour une utilisation sur du
240 VCA, deux fusibles 3AG rapides a haut pouvoir de coupure de 3 A sont utilisés.
Le dispositif fonctionne sur un seul cordon d’alimentation.

Le raccordement électrique est de qualité hospitaliére.

Le dispositif est un dispositif électrique de classe I.

Piece appliquée a protection de type CF.

Le systeme est capable de transmettre et de recevoir des communications sans fil via le
protocole de communication Bluetooth®2.0.

16.1.4 Caractéristiques optiques

Le Makoto Intravascular Imaging System™ comprend un laser de classe 1M proche-
infrarouge.

La lumiére du laser est transmise de la console au cathéter connecté via le contréleur
Makoto™ et les cables de raccordement.

16.1.5le contréleur du Makoto™

Vitesse de rotation = 960, 1800 tr/min, dans le sens antihoraire en regardant la prise de
connexion.

Vitesse longitudinale = 0,5, 1,0, 2,0, 10,0 mm/s.

Amplitude totale du mouvement longitudinal = 155 mm (minimum).

Le contrbleur Makoto™ fonctionne a I'intérieur d’'une barriere stérile intermédiaire de
contréleur Makoto™.

16.2Installation Responsabilités
Cette section décrit les exigences relatives au site d’installation et le déplacement
eventuel du systeme.
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16.2.1 Responsabilités du client

Le Makoto Intravascular Imaging System™ est destiné a étre installé dans un
laboratoire de cathétérisme coronarien. Avant l'installation, il convient de préparer le
site prévu comme décrit dans cette section. Le site doit disposer d’'un espace suffisant
pour accueillir le systeme, garantir une configuration et des prises d’alimentation
électrique appropriées et se conformer aux spécifications environnementales
supplémentaires détaillées ci-dessous.

Il est de la responsabilité du client de s’assurer que la configuration de l'installation du
Makoto Intravascular Imaging System™ (TVC-MC10) est conforme aux exigences
applicables décrites dans la norme CEIl 60601-1.

16.2.2 Responsabilités du fabricant

L'installation du Makoto Intravascular Imaging System™ est effectuée par un agent de
service. Apreés linstallation, le membre du personnel ou le représentant agréé Infraredx
donnera aux membres désignés du personnel du laboratoire de cathétérisme les
instructions élémentaires concernant le fonctionnement de base et I'entretien du
systeme. Ces informations viendront en complément des informations plus détaillées
contenues dans ce manuel.

16.3Exigences relatives a lI'installation

16.3.1 Exigences liées au site

Le Makoto Intravascular Imaging System™ est congu pour étre utilisé dans un
laboratoire de cathétérisme coronarien typique. En regle générale, I'infrastructure en
place ne nécessite aucune modification.

16.3.2 Espace requis

Il convient de prévoir un espace suffisant au sol pour l'installation du systéme. Afin de
laisser un espace suffisant pour le cable d’alimentation et de permettre la circulation de
I'air provenant de ventilateurs de refroidissement, veillez a laisser un écart d’au moins
40 cm (15") entre le panneau arriere du systéme et le mur devant lequel ce dernier

se trouve.

16.3.3 Systeme électrique requis
Le Makoto Intravascular Imaging System™ est con¢u pour fonctionner sur le cablage
électrique standard prévu dans un laboratoire de cathétérisme coronarien.
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Le Makoto Intravascular Imaging System™ est équipé d’'une borne de terre
équipotentielle, située a l'arriere de I'appareil.

16.4Exigences / précautions environnementales

16.4.1 Qualité de l'air

Assurez-vous que I'atmospheére n’est pas corrosive et que I'air qui y circule n’est ni salin
ni acide. L’acide, les agents corrosifs et les matériaux volatiles peuvent attaquer le
cablage électrique, de méme que la surface des composants optiques.

Veillez a maintenir le taux de particules volatiles de poussiére au plus bas. Les
particules de poussiere peuvent endommager la surface de I'équipement optique de
maniére irrémédiable. Les poussiéres métalliques peuvent endommager I'équipement
électrique.

La console contient un filtre a air. Ce filtre sera inspecté et, si cela s'avére nécessaire,
nettoyé ou remplacé pendant les maintenances habituelles.

16.5 Informations générales et informations de contact

En régle générale, le Makoto Intravascular Imaging System™ ne nécessite aucune
maintenance particuliere de la part de l'utilisateur. L’entretien quotidien du contréleur
Makoto™ et le nettoyage et la désinfection de I'extérieur du systeme sont abordés a la
section 16.5.2 Nettoyage et désinfection.

Les indicateurs de défaut ou d’avertissement et les solutions recommandées sont
décrits dans la section 16.6 Témoins d’avertissement et de panne. Tout autre travail de
maintenance ou d’entretien doit étre effectué par un agent d’entretien agréé. La
maintenance préventive habituelle du systeme doit étre effectuée par un agent
d’entretien agréé au moins une fois tous les 12 mois. A chaque visite, 'agent de service
vérifie le bon fonctionnement du systéme et régle ce dernier en conséquence.

16.5.1 Coordonnées de contact :
Pour toute demande d’entretien, de maintenance et de remplacement de piéece, veuillez
contacter votre revendeur et fournisseur de services local, ou appelez Infraredx, Inc. au
numéro suivant : 1-800-596-3104.
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16.5.2 Nettoyage et désinfection

L’extérieur de la console du Makoto Intravascular Imaging System™ et du

contrbleur Makoto™ peut étre nettoyé au moyen d’un chiffon humide imprégné d’'une
solution de savon doux et d’eau. Ne pas utiliser de détergents agressifs. Si vous devez
désinfecter I'extérieur de la console Makoto™ ou du contréleur Makoto™, vous pouvez
a cet effet utiliser un chiffon doux imprégné de désinfectant hospitalier.

A Pour la gestion des risques hématogénes, les hdpitaux et les
centres médicaux doivent suivre leur protocole.

ATTENTION

Il convient de prendre les mesures adéquates afin d’empécher
I'entrée de solution nettoyante, de solution saline ou d’autres
liquides dans le contréleur ou la console Makoto™.

>

ATTENTION

Il convient de prendre les mesures adéquates afin d’empécher

la contamination des connecteurs optiques du

contr6leur Makoto™. Si les connecteurs a fibre optique du
ATTENTION  contréleur ne peuvent étre nettoyés, veuillez contacter votre

fournisseur de services ou Infraredx pour obtenir plus

d’'informations.

16.6 Témoins d’avertissement et de panne

Lorsque vous utilisez le Makoto Intravascular Imaging System™, le logiciel de collecte
de données vérifie le lien de communication électrique établi avec le contréleur
Makoto™ ainsi que la source lumineuse laser. Si les appareils ne sont pas connectés
ou si la communication avec I'un ou l'autre appareil ne fonctionne pas correctement, le
logiciel avertit I'utilisateur par un message d’erreur qui apparait en haut de I'écran.

Si vous rencontrez ce probleme, contactez votre fournisseur de services local ou le
service clientéle Infraredx.

Le Makoto Intravascular Imaging System™ ne comporte aucun autre témoin en dehors
des témoins d’avertissement ou de panne mentionnés ci-dessus.
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Causes possibles

Solutions

Le systeme ne
démarre pas

L’alimentation systeme n’est
pas branchée

Branchez l'alimentation

systéme, voir Section 6.1.

Les fusibles ne fonctionnent
pas

Contacter le fournisseur

services, voir Section 13.1.

de

Le systeme ne reste
pas allumé

La batterie du CPU est vide

Branchez le systéme a

une alimentation électrique

entre les utilisations.

L’alimentation électrique est
instable

Essayez une autre prise

de courant. Prenez contact

avec le fournisseur de

services, voir section 13.

1.

Rien ne s’affiche sur
I'’écran de la console

Les écrans sont éteints

Sur le dessous de I'écran
destiné au médecin, situez

et actionnez le bouton
d’alimentation.

A l'arriére de I'écran
destiné au technicien,
situez et actionnez le
bouton d’alimentation.

L'alimentation des écrans n’est
pas branchée

Assurez-vous que le cable

d’alimentation est bien
connecté a I'écran.

Contacter le fournisseur

services, voir Section 13.1.

de

Le cable vidéo est déconnecté

Assurez-vous gque le cable
vidéo est bien connecté a

I’écran.

Le sous-systéme interne de
distribution vidéo ne
fonctionne pas

Contacter le fournisseur

services, voir Section 13.1.

de

Le logiciel du systeme
ne démarre pas, un
message d’erreur
s’affiche

Un composant du systéme n’'a
pas répondu pendant la
procédure de démarrage.

Eteignez le systéme et
rallumez-le.

Si le probleme persiste,

contacter le fournisseur de
services, voir Section 13.1.
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Causes possibles

Makoto Intravascular Imaging System™

Solutions

Le systeme d’exploitation ne
parvient pas a ouvrir un fichier
de configuration ou de
données indispensable.

Eteignez le systéme et
rallumez-le. Si le probleme
persiste, contacter le
fournisseur de services,
voir Section 13.1.

L’écran tactile ne
répond pas

Le céble USB n’est pas bien
connecte.

Assurez-vous que le
cable USB est bien
connecteé.

La souris est en mouvement.

Stabilisez la souris ou
retournez-la.

Le systeme n’est pas
correctement configuré pour la
sortie vidéo 1600 x 1200

Contacter le fournisseur de
services, voir Section 13.1.

L'interrupteur du Mode

révision est
inaccessible

Une procédure active qui
utilise les données collectées
est en cours

Fermez la procédure, voir
Section 11.

Supprimer tous les scans,
voir Section 10.2.9.

L’exportation de
données est
inaccessible

Aucune procédure n’est
sélectionnée

Sélectionnez des
procédures, voir
Section 12.2.

L’exportation
personnalisée est
inaccessible

Plusieurs procédures sont
sélectionnées

Ne sélectionnez qu’une
seule procédure, voir
Section 12.2.4.

Aucune procédure en
phase « Select »
(Sélection)

Toutes les données ont été
supprimées du systeme.

Lancez plus de
procédures, voir Section 7.

Importez des données,
voir Section 12.3.

Le filtre de recherche n’a pas
retourné de procédures ou
de scans.

Supprimez le filtre de
recherche, voir
Section 12.1.2.

Le périphérique de
stockage USB n’est
pas reconnu

Le périphérique est
incompatible

Utilisez un autre
périphérique de
stockage USB

Un périphérique crypté tente
de charger des données ou
des programmes sur le
systeme d’'imagerie.

Utilisez un autre
périphérique de
stockage USB.
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Causes possibles

Solutions

Aucune image IVUS

Niveau du noir trop élevé ou
autre ajustement incorrect de
'image.

Rétablissez les réglages
d’'image d’usine ou réglez
le niveau du noir, voir
Section 10.8.4

Amorcage du cathéter
insuffisant

Irriguez le cathéter avec
un plus grand volume de
solution saline héparinée

ou

Consultez les instructions
d’utilisation du cathéter.

Le transducteur du cathéter ne
fonctionne pas

Changez le cathéter.

L'image IVUS est
sombre ou clignote

Ajustez les réglages d’'image

Rétablissez les réglages
d’'image d’usine ou réglez
les paramétres individuels
de lI'image, voir Section
10.8.4

Amorcage du cathéter
insuffisant

Irriguez le cathéter avec
un plus grand volume de
solution saline héparinée

ou

Consultez les instructions
d’utilisation du cathéter.

L’indicateur du fil-
guide est d’un blanc
uniforme.

La fibre optique du cathéter
est endommagee.

Changez le cathéter.

Le cathéter Dualpro™
ne charge pas ou ne
se connecte pas

Le contrdleur n'est pas sur la
position LOAD (chargement).

Utilisez les commandes de
mouvement distal du
contréleur Makoto™
jusqu’a ce que LOAD
(chargement) apparaisse a
I'écran.

Controleur mal étalonné.

Contacter le fournisseur de
services, voir Section 13.1.
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Causes possibles

Solutions

La poignée du cathéter n’est
pas alignée avec la douille du
contréleur.

Orientez la poignée du
cathéter avec le bouton
coloré vers le haut avant
de l'insérer dans la douille
du controleur Makoto™.

Le noyau d'imagerie de
rotation du cathéter n’est pas
aligné avec la poignée du
cathéter.

A l'aide de la partie
supérieure, faites pivoter le
noyau de maniere a ce
que les couleurs du noyau
correspondent a celles des
boutons.

Le cathéter Dualpro™
ne décharge pas ou ne
se déconnecte pas (le
fil central rotatif reste
connecté lorsque le
manche est retiré)

Le controleur n'est pas en
position READY (PRET) au
moment de la déconnexion.

Reconnectez le manche
du cathéter et placez le
contrbleur en position
READY (PRET) avant
d’'effectuer la déconnexion.

Les boutons de commande du
cathéter sont actionnés
pendant son retrait.

Reconnectez le manche
du cathéter, ajustez la
poignée pour éviter
d’appuyer sur les boutons
colorés du manche du
cathéter pendant la
déconnexion.

Retirez le joint de stérilité
du logement du contréleur.
Insérez le manche a
travers le joint et
connectez-le au logement
du contréleur a l'intérieur
de la cloison. Tentez a
nouveau de retirer le
cathéter.

Le chemogram ne se
génere pas

L’acquisition en direct
d’'images IVUS est en cours.

Il est impossible de
générer des chemogram
pendant I'acquisition en
direct d’images IVUS. Voir
Section 9.1.

Distance de retrait insuffisante

Relancez I'acquisition du
retrait automatique avec
plus de longueur, voir
Section 9.2.2.
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Causes possibles

Makoto Intravascular Imaging System™

Solutions

Excés de signal optique faible
détecté pendant la
numeérisation.

Retournez en position
READY (PRET) et chargez
a nouveau le cathéter.
Réessayez la
numerisation.

Les optiques fibreuses du
cathéter sont endommagées.

Changez le cathéter et
réessayez.

Panne du composant optique
du systeme.

Contacter le fournisseur de
services, voir Section 13.1.

Le chemogram est
couvert de taches
noires.

Artefact d’origine biologique :
réflexion de thrombus
excessifs.

Annulez 'analyse par
chemogram dans cette
zone ou relancez
I'acquisition automatique.
Voir section 9.3.

Artefact d’origine non
biologique : réflexion de
I'espacement dense des stents
qui se chevauchent ou des
stents recouverts.

Annulez I'analyse par
chemogram dans cette
zone ou relancez
I'acquisition automatique.
Voir section 9.3.

Artefact d’origine biologique :
profondeur sanguine
excessive

Annulez I'analyse par
chemogram dans cette
zone ou relancez
I'acquisition automatique.
Voir section 9.3.

Optiques fibreuses du
contrbleur encrassées.

Contacter le fournisseur de
services, voir Section 13.1.

Dysfonctionnement du
contréleur.

Contacter le fournisseur de
services, voir Section 13.1.

Les optiques fibreuses du
cathéter sont encrassées.

Changez le cathéter et
réessayez.

Les fibres optiques du cathéter
sont endommagees.

Changez le cathéter et
réessayez.
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Causes possibles

Solutions

Le controleur ne remet
pas le noyau
d'imagerie en position
« READY » (PRET) et
ne se déplace pas de
maniére distale.

Le noyau d'imagerie essaie

d'avancer dans une fenétre de

transmission coudée.

Suivez les consignes a
I'écran. Redressez les
coudes et réessayez.

Si le probleme persiste,
remplacez le cathéter et
réessayez.

Le noyau d’imagerie du
cathéter est retenu ou
endommagé.

Retirez délicatement la
poignée du cathéter, puis
le noyau d'imagerie en
tirant sur la tige du
cathéter.

Suivez les consignes a
I'écran pour remplacer le
cathéter.

Rien ne bouge a
I'intérieur du contrdleur
lorsque le moteur
tourne est que les
boutons de translation
sont actionnés

Le mécanisme d’entrainement

du contrbleur est usé.

Contacter le fournisseur de
services, voir Section 13.1.

16.8Pieces de rechange
Pour toute information concernant les commandes, veuillez contacter votre fournisseur
de services local ou Infraredx, Inc. en composant le numéro suivant :

1-800-596-3104.

16.9Déclassement du Makoto Intravascular Imaging System™
Pour savoir comment déclasser le systeme en toute sécurité, appelez votre fournisseur
de services local ou Infraredx au :

1-800-596-3104.
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17 Annexes

17.1Annexe A : garantie et informations connexes

La plupart des besoins d’assistance technique qui surviennent au cours de la premiére année suivant
l'acquisition du Makoto Intravascular Imaging System™ sont couverts par notre garantie, comme
'expliguent les sections suivantes. En ce qui concerne l'assistance qui n'est pas spécifiguement couverte
par les termes de la garantie Infraredx, I'assistance sera facturée a I'appel. Pour obtenir une assistance
technique pour votre Makoto Intravascular Imaging System™ ou pour en savoir plus sur les programmes
d'assistance technique disponibles, veuillez contacter le service clientéle Infraredx au 1-800-596-3104.

Garantie

Infraredx garantit que tous les composants standards de son Makoto Intravascular Imaging System™
seront exempts de défauts matériels et de fabrication pour une période d’un (1) an. Durant cette période
de garantie, Infraredx réparera ou remplacera, a sa discrétion, tous les composants défectueux. Un tel
remplacement peut inclure des piéces ou des composants remis a neuf. Apres la fin de la période de
garantie initiale ou de toute extension de garantie achetée, les services de réparation peuvent étre
obtenus aupres d’Infraredx aux tarifs publiés. Infraredx garantit que le logiciel destiné a étre utilisé avec
l'instrument exécutera correctement ses fonctions s'il est correctement installé. Infraredx fournira toutes
les corrections logicielles ou tous les « correctifs de bogue » s'ils sont et lorsqu’ils seront disponibles,
sans frais, pour une période d’'un (1) an apres l'installation. Pour le matériel et les logiciels installés par le
personnel d’'Infraredx, la période de garantie commence a la date d'installation initiale, & moins cette date
ait été postposée a votre demande.

Les garanties ci-dessus ne s’appliquent pas aux défauts résultant d’'une mauvaise utilisation, d’une
négligence ou d’un accident, y compris, sans limitation : I'utilisation par des opérateurs non formés ;
I'utilisation en dehors des prescriptions environnementales relatives a I'instrument ou aux accessoires ; la
maintenance incorrecte ou inadéquate par I'utilisateur ; I'installation de logiciels ou d’interfaces non fournis
par Infraredx ; 'apport de modifications a I'instrument ou au logiciel non autorisées par Infraredx ; les
réparations effectuées par quiconque autre gu’lnfraredx ou un agent de réparation agréé par Infraredx.

Expéditions, retours et réglages au titre de la garantie

Toute réclamation au titre de la garantie doit étre soumise rapidement et doit étre recue par Infraredx au
cours de la période de garantie applicable. S'il s’avere nécessaire de nous retourner un produit pour
réparation et/ou réglage, le client devra obtenir une autorisation de retour de marchandise (ARM) auprés
du service clientéle d’'Infraredx (1-800-596-3104). Infraredx informera le client sur la méthode et le lieu
d’expédition des produits. Tout produit ou composant renvoyé pour examen ou réparation sous garantie
doit étre couvert par une assurance pour I'envoi et payé d’avance, et transiter par le moyen de transport
spécifié par le service clientéle d’'Infraredx.

Les frais d’expédition pour tous les produits ou composants remplacés ou réparés sous garantie sont a la
discrétion de I'acheteur. Dans tous les cas, il reléve de la responsabilité exclusive d’'Infraredx de
déterminer la cause et la nature de la panne d’'un produit ou d’'un composant, et la décision d’Infraredx a
cet égard sera irrévocable.
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Décontamination de I’équipement renvoyé

Afin de se conformer aux lois des Etats-Unis sur les services postaux et le transport, I'équipement
retourné a Infraredx doit étre adéquatement décontaminé au moyen d’un germicide chimique dont
l'utilisation comme désinfectant hospitalier est approuvée. Si I'équipement recu n'a pas été décontaminé,
Infraredx imputera les frais de nettoyage au client.

Limites

Cette garantie ne couvre ni le cathéter intravasculaire Dualpro™ IVUS+NIRS et les composants de test
associés ni tout autre équipement FEO non inclus dans le Makoto Intravascular Imaging System™. Cette
garantie ne couvre pas I'étalonnage, le nettoyage ou I'entretien habituel du systéme. Tout produit renvoyé
a Infraredx sans autorisation préalable le sera aux frais de I'expéditeur. Infraredx se réserve le droit de
modifier ou d’'interrompre ce produit, ses caractéristiques ou son prix, sans préavis.

Indemnisation

L'acheteur accepte d’'indemniser et de tenir Infraredx a couvert contre toutes actions, poursuites,
responsabilités, réclamations, amendes, dommages, pertes ou dépenses, y compris les honoraires
d’'avocat raisonnables et les frais de litige (les « pertes ») encourus par ou imposés dans le cadre de
toutes actions, poursuites, réclamations ou demandes, intentées par des tiers, y compris, sans limitation,
celles découlant de la violation des lois locales, régionales ou fédérales relatives au produit ou a son
utilisation, en ce compris les pertes liées a une inspection inadéquate, aux blessures occasionnées a
guelconque personne ou aux dommages ou a la destruction de toute propriété, a la sélection des
patients, a I'application, au fonctionnement ou a I'utilisation des produits Infraredx, y compris I'utilisation
répétée d'articles a usage unique, sauf pour les pertes résultant de la négligence unique et exclusive
d’Infraredx, de ses employés et de ses agents diment agréés. Aucun agent, employé ou représentant
d’Infraredx n’a le pouvoir de modifier ce qui précéde, ou d’assumer ou de lier Infraredx a toute
responsabilité supplémentaire en rapport avec le produit.

Licences

Le Makoto Intravascular Imaging System™ se compose de matériel et de logiciels développés et détenus
par Infraredx, Inc. ainsi que de logiciels exploités sous licence par Infraredx aupres de divers concédants
de licence de logiciels (« fournisseurs de logiciels d’Infraredx »). Les logiciels installés d’'Infraredx et des
fournisseurs de logiciels d’Infraredx, ainsi que tous les médias, les supports imprimés et la documentation
« en ligne » ou électronique (« LOGICIEL ») associés sont protégés par les lois et les traités
internationaux sur le copyright, ainsi que par d’autres lois et traités sur la propriété intellectuelle. Le
logiciel vous est fourni en vertu d’une licence ou sous-licence non cessible et non exclusive dont vous
disposez uniquement dans le cadre de I'utilisation de Makoto Intravascular Imaging System™. Les
conditions de cette licence peuvent étre plus explicitement exposées dans un contrat a part de celui du
produit. Cette licence ne vous céde aucun titre ni aucun droit de propriété sur le LOGICIEL ou toute partie
du LOGICIEL. Ce LOGICIEL ne peut étre utilisé que sur le Makoto Intravascular Imaging System™. Vous
n'étes pas autorisé(e) a : (1) copier (a des fins autres que la sauvegarde), distribuer, louer, concéder ou
sous-licencier tout ou partie du LOGICIEL ; (2) modifier ou créer des versions dérivées du LOGICIEL ; (3)
afficher publiquement la sortie visuelle du LOGICIEL ; ou (4) diffuser le LOGICIEL sur un réseau, par
téléphone ou par tout autre moyen électronique. Vous acceptez de garder la confidentialité et de faire
tout ce qui est en votre pouvoir pour prévenir la divulgation ou I'utilisation non autorisée du LOGICIEL et
pour protéger ce dernier contre toute divulgation ou utilisation non autorisée. Il vous est interdit de
rétroconcevoir, de décompiler ou de désassembler le LOGICIEL, sauf et uniguement dans la mesure ou
une telle activité est expressément autorisée par la loi en vigueur.

Infraredx GARANTIT QU'UN SOIN RAISONNABLE A ETE MIS DANS LA CONCEPTION ET LA
FABRICATION DE CE DISPOSITIF. LE LOGICIEL EST FOURNI « TEL QUEL » ET Infraredx NE
GARANTIT PAS QUE SON FONCTIONNEMENT SERA ININTERROMPU, EXEMPT D’ERREURS OU
DE BOGUES. VOUS ASSUMEZ LA TOTALITE DU RISQUE EN MATIERE DE QUALITE
SATISFAISANTE, DE PERFORMANCES, DE PRECISION ET D’EFFORT (Y COMPRIS L'ABSENCE DE
NEGLIGENCE). EN OUTRE, IL N'Y A AUCUNE GARANTIE CONTRE LES INTERFERENCES A VOTRE
UTILISATION DU LOGICIEL OU CONTRE LA VIOLATION. LA PRESENTE GARANTIE ET LES
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RECOURS CI-DESSUS REMPLACENT ET EXCLUENT TOUTES LES AUTRES GARANTIES QUI NE
SONT PAS EXPRESSEMENT ENONCEES DANS LE PRESENT DOCUMENT, QU’ELLES SOIENT
EXPLICITES OU IMPLICITES PAR L'EFFET DE LA LOI OU DE TOUTE AUTRE MANIERE, Y
COMPRIS, MAIS NON EXCLUSIVEMENT, LES GARANTIES IMPLICITES DE QUALITE MARCHANDE
OU D'’ADEQUATION A UN USAGE PARTICULIER.

LA MANIPULATION LE STOCKAGE, LE NETTOYAGE ET LA STERILISATION DE CE DISPOSITIF
AINSI QUE D’AUTRES FACTEURS LIES AU PATIENT, AU DIAGNOSTIC, AU TRAITEMENT, AUX
INTERVENTIONS CHIRURGICALES ET A D'AUTRES ELEMENTS ECHAPPANT AU CONTROLE
D'INFRAREDX AFFECTENT DIRECTEMENT LE DISPOSITIF ET LES RESULTATS OBTENUS PAR
SON UTILISATION. INFRAREDX DECLINE TOUTE RESPONSABILITE EN CAS DE PERTES, DE
DOMMAGES OU DE DEPENSES ACCIDENTELS OU CONSECUTIFS, LIES DIRECTEMENT OU
INDIRECTEMENT A L'UTILISATION DE CE PRODUIT (Y COMPRIS, MAIS NON EXCLUSIVEMENT, LA
PERTE D'USAGE, LES PERTES COMMERCIALES, DE REVENUS, DE BENEFICES, DE DONNEES
OU DE TRAVAIL) MEME SI INFRAREDX A ETE INFORMEE DE LA POSSIBILITE DESDITS
DOMMAGES. INFRAREDX N'’ASSUME, ET N'AUTORISE AUCUNE TIERCE PERSONNE A ASSUMER
A SA PLACE, AUCUNE AUTRE OBLIGATION OU RESPONSABILITE EN LIEN AVEC CE DISPOSITIF.
INFRAREDX DECLINE TOUTE RESPONSABILITE A L’'EGARD DES DISPOSITIFS REUTILISES,
RECONDITIONNES OU RESTERILISES ET NE GARANTIT AUCUNEMENT, EXPLICITEMENT OU
IMPLICITEMENT, Y COMPRIS, MAIS NON EXCLUSIVEMENT, LA QUALITE MARCHANDE OU
L’ADEQUATION DE CES DISPOSITIFS A UN USAGE PARTICULIER.

Restrictions a I’exportation

Sauf stipulation contraire de la part d’'Infraredx, si vous exportez le Makoto Intravascular Imaging
System™, vous assumez I'entiére responsabilité de I'obtention de toute autorisation d’exportation requise
et étes tenu de respecter toutes les lois, regles et réglementations en vigueur de toutes les autorités
gouvernementales, y compris, mais non exclusivement, la loi américaine sur I'administration des
exportations (Export Administration Act). Vous vous engagez a ne pas exporter ou réexporter les
données techniques fournies par Infraredx ou le produit direct de ces données contrevenant aux
réglementations d’exportation en vigueur. Vous reconnaissez que le logiciel est d’origine américaine.
Vous acceptez de vous conformer a toutes les lois internationales et nationales en vigueur qui
s'appliquent au logiciel, y compris les réglementations de I'administration américaine des exportations
(U.S. Export Administration Regulations), ainsi qu’aux restrictions concernant I'utilisateur final, I'utilisation
finale et le pays de destination émises par les Etats-Unis et les autres gouvernements.
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17.2 Annexe B : résumé des études clinique et ex vivo

Le systeme d’'imagerie proche infrarouge (PIR) Infraredx a été développé pour identifier les
plaques d'intérét contenues dans des cceurs lipidiques (PCL) dans les arteres coronaires.
L’algorithme de détection de PCL de ce systeme a été développé sur la base de données
récoltées a partir de cceurs provenant d’autopsies dans le cadre d’une étude ex vivo.
Parallelement, des mesures PIR sur des arteres coronaires ont été recueillies in vivo dans
le cadre d’une étude clinique pivot (SPECTACL). L’étude ex vivo a évalué prospectivement
I'exactitude des relevés PIR par comparaison avec I'histologie, tandis que I'étude clinique a
évalué prospectivement I'équivalence des mesures in vivo et ex vivo.

17.2.1 Etude ex vivo

Objectif de I'étude

L'objectif de I'étude ex vivo était d’étalonner et de valider prospectivement le systéme
d’'imagerie PIR Infraredx pour la détection des PCL. L’étalonnage et la validation du
systeme ont été effectués a l'aide d’arteres coronaires provenant de cceurs humains
autopsiés et compareés a l'aide de criteres histologiques prédéfinis.

Plan d’étude

L’étalonnage et la validation du systeme Infraredx ont été réalisés par la collecte de
données spectroscopiques et histologiques co-enregistrées de 84 cceurs humains, dont
33 ont été utilisés pour le processus d’étalonnage et 51 pour la validation finale.
L’ensemble de données d’étalonnage a été utilisé pour construire un modele de
discrimination multivarié afin de détecter la présence de PCL a partir de mesures de
scan PIR. Ce modéle a ensuite été validé prospectivement en testant sa performance
de détection des PCL sur I'ensemble de données de validation.

Pour I'étalonnage comme pour la validation, chaque segment artériel a été installé dans un
dispositif congu pour permettre la perfusion de sang et I'enregistrement précis du site de
mesure PIR ainsi que des sections histologiques qui en découlent. Tous les scans ont été
réalisés au moyen d’un dispositif automatisé de retrait et de rotation qui tirait 'extrémité
optique le long de l'artere a 0,5 mm/s et a une vitesse de rotation de 240 tr/min. Les
spectres individuels ont été recueillis & une fréquence d’environ 40 Hz. Cette configuration,
avec une longueur moyenne de segment de pres de 50 mm, a permis de réaliser 'analyse
des tissus selon une moyenne de pres de 4000 points par segment.

La PCL a été définie comme un fibroathérome doté d’'un cceur lipidique de plus de

60 degrés d’extension circonférentielle non contigué, d’'une épaisseur moyenne
supérieure a 200 microns et recouvert d’'une coiffe fibreuse d’une épaisseur moyenne
de 0 a 450 microns. Une section histologique a été analysée a chaque

section transversale de 2 mm (bloc) d’artere. Les caractéristiques histologiques des
artéres ont été classifiées par un pathologiste selon le schéma de « classification AHA
modifiee » (Virmani R, Kolodgie FD, Burke AP, Farb A, Schwartz SM. Lessons From
Sudden Coronary Death : A Comprehensive Morphological Classification Scheme for
Atherosclerotic Lesions. Arterioscler Thromb Vasc Biol. 2000; 20(5):1262-1275).
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Tableau 1. Données démographiques sur les donneurs, antécédents médicaux et cause du décés

Caractéristiques (n=51)
Profil démographique
Homme, n (%) 36 (71)
Age moyen +/- écart type, années 65,9 + 15

Antécédents médicaux, n (%)

Hypertension 31 (61)
Fumeur chronique 21 (41)
Diabete sucré 17 (33)
Antécédents d’insuffisance cardiague congestive 16 (31)
Antécédents de crise cardiaque 11 (22)
Pontage aorto-coronaire précédent 4 (8)

Cause du déces, n (%)

Cardiovasculaire 40 (78)
Non cardiovasculaire 8 (16)
Inconnu 3 (6)

Criteres d’évaluation de I'étude

L’exactitude du diagnostic du systéme Infraredx a été évaluée selon trois criteres principaux
de I'étude en utilisant la surface sous la courbe (SSC) de la courbe caractéristique de la
performance du test (ROC), et ce, pour deux utilisations cliniques : la détection localisée de
PCL et le calcul de la masse globale du cceur lipidique d’'un segment d’artére scanné.

Critére d’évaluation principal : précision de I'image dans la détection de PCL
indépendamment de I'épaisseur de la coiffe

La précision de la détection localisée a été évaluée pour tous les blocs adéquats de 2 mm
d’artere scannés en utilisant I'analyse ROC des valeurs d’intensité du chemogram par bloc
par rapport aux comparaisons histologiques appariées pour les blocs ayant un diametre
intérieur inférieur ou égal a 3,0 mm. L'intensité du chemogram par bloc correspond au 90¢
centile des pixels du chemogram dans un bloc de 2 mm d’artére scannée, ce qui
correspond visuellement aux 10 % de pixels les plus jaunes du bloc. La comparaison
histologique reposait sur la présence ou I'absence de PCL dans chaque bloc de 2 mm. Les
pourcentages de concordance positive et négative du seuil des valeurs du chemogram par
bloc ont été calculés a mesure que le seuil a été ajusté a tous les points possibles, en vue
de balayer la courbe ROC. Ce faisant, la surface sous la courbe (SCC) ROC a également
été calculée. Pour le critére d’évaluation principal, aucune restriction n’a été fixée quant a
I'épaisseur de la coiffe de plague mentionnée dans la définition de la PCL.

Critére d'évaluation secondaire 1 : précision de I'image dans la détection de PCL avec
une épaisseur de coiffe <0,45 mm

Ce critere d’évaluation secondaire reposait sur les mémes hypothéses et méthodes
d’analyse que le critére d'évaluation principal, mais limitait la définition de la PCL a ceux
dotés d’'une épaisseur moyenne de coiffe inférieure a 0,45 mm. Les PCL dotées d’'une
épaisseur de coiffe supérieure ou égale a 0,45 mm ont été classifiés dans le groupe négatif.
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Critére d’évaluation secondaire 2 : Précision de I'Indice de masse du cceur lipidique

Ce critere d’évaluation secondaire de I'étude de validation CDEV3 étayait une utilisation
secondaire du systeme : I'évaluation globale de la masse du cceur lipidique dans un
segment artériel scanné a l'aide du Lipid Core Burden Index (LCBI). La précision de cette
mesure a été évaluée pour tous les segments artériels adéquats scannés au moyen de
lanalyse ROC des valeurs du LCBI par rapport aux comparaisons histologiques appariées.
Tous les diamétres intérieurs des artéres ont été inclus a I'analyse. Le LCBI est une partie
de pixels du chemogram d’un segment scanné qui possedent une intensité de plus de 0,6,
ce qui correspond, sur un plan visuel, au passage du rouge a I'orange foncé sur le
chemogram. La comparaison histologique reposait sur la présence ou I'absence de
fibroathéromes quelconques dans le segment scanné. Les pourcentages de concordance
positive et négative du seuil des valeurs du LCBI ont été calculés a mesure que le seuil a
été ajusté a tous les points possibles, en vue de balayer la courbe ROC. Ce faisant, la
surface sous la courbe (SCC) ROC a également été calculée.

Résultats de I'étude

Pour la détection des PCL, indépendamment de I'épaisseur de la coiffe, TAUC générale
du systéme s’est élevée a 0,80 (zone de confiance de 95 %, 0,76 — 0,85) dans les
artéeres d’'un diametre intérieur égal ou inférieur a 3,0 mm. Pour la détection des PCL
d’'une épaisseur de coiffe inférieure a 0,45 mm, 'AUC a également atteint 0,80 (zone de
confiance de 95 %, 0,76 — 0,84). Pour la détection de la présence d’un fibroathérome le
long d’'un segment d’artere a I'aide du LCBI, I'AUC était de 0,86 (zone de confiance de
97,5 %, 0,80 — 0,91) pour tous les diametres d’arteres. Le tableau 2 résume les
résultats de précision des diagnostics pour les trois critéres principaux de I'étude.
Figure 17-1 indique les pourcentages de concordance correspondants en fonction du
seuil d’intensité du chemogram du bloc (critére principal et critére secondaire 1) ou du
seuil LCBI (critere secondaire 2).

Tableau 2 : résultats de précision pour les trois criteres de I'étude ex vivo

Critere de I'étude AUC
Critére d’évaluation principal :
Précision de I'image dans la détection de PCL 0,80 (95 % CI : 0,76 - 0,85)

indépendamment de I'épaisseur de la coiffe 1
Critere d’évaluation secondaire 1 :

Précision de I'image dans la détection de PCL 0,80 (95 % CI : 0,76 - 0,84)
avec une épaisseur de coiffe <0,45 mm?

Critére d’évaluation secondaire 2 : 0,86 (97,5 % CI : 0,80-
Précision de I'lndice de masse du cceur lipidique ? 0,91)

151 ceeurs, 122 segments, 1909 blocs de 2 mm ; diamétre intérieur moyen 23 mm
251 ceeurs, 120 segments
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17.2.2 Etude clinique pivot

Objectif de I'étude

L'objectif général de I'étude SPECTACL était d’évaluer la similarité des mesures
obtenues dans des conditions cliniques a celles relevées sur des spécimens autopsiés.
Les comparaisons histopathologiques n’étaient pas disponibles pour les patients
cliniques, ce qui a empéché I'évaluation directe de la précision des images

artérielles PIR in vivo. Ainsi, I'étude a utilisé les données spectrales sous-jacentes aux
images pour démontrer que les informations recueillies in vivo étaient similaires aux
informations utilisées dans I'étude ex vivo.

Plan d’étude

SPECTACL était un essai clinigue multicentrique prospectif mené sur des patients
faisant I'objet d’'une intervention coronarienne percutanée facultative ou non urgente
pour une Iésion coronarienne native de novo. Le recrutement incluait des patients
atteints d’angine stable ou progressive, ainsi que des patients atteints d’'un syndrome
coronarien aigu stabilisé. L’étude clinigue SPECTACL a été réalisée dans le but de
montrer que les caractéristiques spectrales des données acquises chez les patients
étaient essentiellement similaires aux caractéristiques spectrales des données
recueillies dans I'étude ex vivo.

Durée de I'étude, sites cliniques et recrutement

L’étude pivot SPECTACL s’est déroulée sur une période de 21 mois sur 6 sites
cliniques des Etats-Unis et du Canada. Au cours de cette période, 106 patients ont été
recrutés pour I'étude. Des images PIR n’ont pas pu étre recueillies chez 17 de ces
patients, ce qui a réduit 'analyse aux données de 89 patients. Les raisons de I'échec
de l'acquisition d'images PIR comprenaient I'incapacité de suivre le vaisseau (7), la
défaillance du dispositif (7), I'erreur de procédure (2) et la mauvaise configuration des
accessoires (1).
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Critere d’évaluation principal : AUC = 0,80, 95 % CI = [0,76-0,85]

100
”/ 100
a0 A a0
-~
+
o B0 W - B0
£
40 o 1 40
-
s
20 ,r" ] o0 PCP
P PCN
Jl
0 . a
0 &0 100 . ==
100-PCN Seuil du chemogram des blocs

Critére d’évaluation secondaire 1 : SCC = 0,80, 95 % Cl =[0,76-0,84]
100

= 100
80 x,f"" - 80
B d,/’* : E0
40 ;,/' : 10
L

PCP
LY

, <4
20 ,f’ 20
J/
0 . a
0 ad 100
100-PCN Seuil du chemogram des blocs
Critére d’évaluation secondaire 2 : SCC = 0,86, 97,5 % Cl = [0,80-0,91]
100 100
a0 a0
a G0 G0
O
8 40 40
20 20
0 . a . . .
0 a0 100 0 100 200 300

100-PCN Seuil LCBI

Figure 17-1. Courbes ROC (colonne de gauche) et courbes de pourcentages de concordance
positive et négative par rapport aux seuils de test (colonne de droite) pour les trois critéres
principaux de I'étude. R. : Critére principal - pas de seuil d’épaisseur de la coiffe. Précision
du chemogram par rapport a I’histologie par blocs de 2 mm (51 coeurs, 122 segments et
1909 blocs de 2 mm). Les trois seuils de couleur sur le chemogram par bloc (qui séparent le
rouge, I'orange foncé, I'orange clair et le jaune) donnent les pourcentages de concordance
positive et négative indiqués par les cercles. B : critére secondaire 1 - un seuil d’épaisseur
de coiffe de 450 microns. C : critere secondaire 2 - précision du Lipid Core Burden Index
(LCBI) par rapport a I’histologie (51 cceurs, 120 segments). PCP : pourcentage de
concordance positive. PCN : pourcentage de concordance négative.
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Parmi les 89 patients, les données de 30 d’entre eux ont été dévoilées au cours de
I'étude clinique aux fins du développement d’algorithmes. En conséquence, I'évaluation
prospective des similitudes entre les mesures PIR in vivo et ex vivo a été établie sur la
base des images PIR des 59 patients restants.

Tableau 3 : valeurs démographiques et caractéristiques cliniques de I'étude ex vivo
Caractéristigues sociodémographiques n = 18 cceurs (%)

Age (années)

Age moyen +/- écart type 65+ 14
Sexe

Male 13 (72)
Race

Caucasiens 17 (94)

Afro-américains 0

Asiatiques 1(6)

Originaires des iles du Pacifique 0

Amérindiens 0

Autre 0

Historique clinique
Antécédents familiaux pour les artéres coronaires

maladie 9 (50)
Hypertension 14 (78)
Diabete sucré 6 (33)
Fumeurs 9 (50)
Antécédents d’infarctus du myocarde 1 (6)

Accident vasculaire cérébral / attaque ischémique transitoire 9 (50)
Insuffisance cardiaque congestive 3 (17)

Cause du déces

Cardiovasculaire 11 (61)

Non cardiovasculaire 3 (17)

Inconnu 4 (22)
infrare
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Tableau 4 : valeurs démographiques, historique clinique et présentation clinique
des patients in vivo

Caractéristigues sociodémographiques n=106(%)* n=48(%):

Age (années)

Moyen +/- écart type 61,7 £10,0 61,4+9,2
Sexe

Méale 86 (81) 38 (79)
Race

Caucasiens 95 (90) 40 (83)

Afro-américains 5 (5) 2(4)

Asiatiques 1(2) 1(2)

Originaires des iles du Pacifique 0 (0) 0 (0)

Ameérindiens 0 (0) 0(0)

Autre 4 (4) 4 (8)

Inconnue / non communiquée 1(1) 1(2)

1 Nombre total de patients recrutés

2 Nombre de patients dans I'ensemble de validation prospective avec retraits adéquats d’un point de vue spectral
(voir Résultats de I'étude)

Historique clinique n=106 (%) n=48 (%)

Hyperlipidémie 70 (66) 36 (75)
Hypertension 74 (70) 36 (75)
Diabete sucré 23 (22) 11 (23)
Antécédents d’infarctus du myocarde 16 (15) 5 (10)
Antécédents d’intervention percutanée 28 (26) 13 (27)
Pontage aorto-coronaire 3(3) 0 (0)
Accident vasculaire cérébral / attaque 0 (0) 0 (0)
ischémique transitoire
Maladie vasculaire périphérique 4 (4) 2 (4)
Antécédents familiaux pour la maladie 46 (43) 19 (40)
coronarienne
Douleur a la poitrine durant les 7 derniers jours 67 (63) 33 (69)
Angine stable 54 (51) 27 (56)
Insuffisance cardiaque congestive 6 (6) 0 (0)
infraredy
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Présentation clinique n =106 n=48
Post-infarctus myocardique 15 (14) 8 (17)
Angine instable 10 (9) 7 (15)
Angine stable 40 (38) 16 (33)
Etude fonctionnelle positive 25 (24) 14 (29)
Douleur atypique a la poitrine 9 (8) 0 (0)
Insuffisance cardiaque congestive 1) 0 (0)
Autre 6 (6) 3 (6)
Sécurité

Bien que I'étude SPECTACL n’ait pas été commandée pour évaluer la sécurité de
'instrument Infraredx, la surveillance des événements indésirables a permis de
s’assurer que le profil d'innocuité était similaire a celui observé avec des cathéters
similaires. Etant donné la similarité des caractéristiques physiques et de I'utilisation du
cathéter Infraredx avec celles du cathéter IVUS, I'on s’attendait a ce que les taux et les
types d’événements indésirables associés au dispositif Infraredx dans

I'étude SPECTACL soient semblables a ceux relevés dans le cadre de I'expérience bien
documentée sur les cathéters IVUS dans un groupe de patients ICP similaire.

Critére de I'étude

Le critére principal de SPECTACL a été évalué de fagon prospective en déterminant la
fraction de patients présentant un retrait semblable a celui des données d’autopsie de
'ensemble d’apprentissage de I'algorithme PCL. Les retraits individuels des patients ont
été jugés semblables a ceux des mesures ex vivo lorsque plus de 80 % des spectres de
gualité adéquate du retrait atteignaient les seuils des mesures de similarité, tel que
décrit ci-dessous.

Adéquation spectrale

Les retraits inadéquats d’'un point de vue spectral ont été jugés de pietre qualité en
raison d’'obstructions ou d’erreurs d’acquisition de données et ont été exclus de
'analyse de similarité. L’adéquation spectrale des spectres individuels a été déterminée
sur la base de plusieurs données aberrantes. Ces données ont été congues afin
d’identifier les obstructions dans le trajet du faisceau optique, qui pourraient fausser la
mesure spectrale. Les obstructions aberrantes comportaient :

e les spectres collectés lorsque le fil-guide obstruait la paroi artérielle ;

e les spectres collectés lorsque I'extrémité optique était encore dans le
cathéter-guide ;

e les spectres signalés a cause des données d’oscillation (p. ex. en raison
de mauvaises connexions optiques ou de la présence de microbulles dans
la solution saline pour I'amorcage des cathéters) ;

e les spectres signalés par les données de visibilité de la paroi (paroi
artérielle non visible a cause d’un afflux de sang trop important).
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En vue d’évaluer la qualité des données, un retrait a été subdivisé en blocs contigus de
2 mm et chaque bloc a fait I'objet d’'une évaluation de I'adéquation spectrale.
L’adéquation spectrale d’'un bloc a été jugée suffisante si plus de 75 % des spectres du
bloc étaient de bonne qualité. Les retraits étaient a leur tour jugés adéquats d’un point
de vue spectral si 75 % des blocs de chacun d’entre eux étaient de bonne qualité.

Similarité spectrale

Deux mesures multivariées ont été utilisées pour évaluer la similarité entre un spectre et
ceux de I'ensemble d’étalonnage du modeéle : la distance de Mahalanobis (DM) et le
rapport des variances spectrales (RVS). Le premier est une mesure de la distance
pondérée par la covariance entre un point et le centre d'un ensemble de points dans un
espace multidimensionnel. Pour un spectre de prédiction x et le spectre moyen y de
'ensemble d’étalonnage, la mesure de la DM est obtenue comme suit (en unités au carre)

1 —l
MD = (x-y)'S ™ (x~ y), W
ol St est l'inverse de la matrice de covariance de 'ensemble d’apprentissage. Etant donné
gue les données du cas d'utilisation du systeme sont bimodales (positives ou négatives
pour les PCL), les DM individuelles ont été calculées en fonction de chaque classe. C’est-
a-dire gu’'une DM était calculée sur la base du sous-ensemble de spectres d’étalonnage
avec une réeférence PCL positive (DM+), tandis que l'autre était obtenue sur la base du
sous-ensemble de spectres d’étalonnage avec référence PCL négative (DM-). Un spectre
de validation donné est attribué a la distance la plus faible des deux (MD+ ou MD-).

Le RVS est une mesure de la somme des carrés des résidus du spectre de validation
par rapport a la somme moyenne des carrés de résidus de I'ensemble d’étalonnage.
Le résidu spectral est la différence entre le spectre estimé construit dans un espace de
projection dimensionnelle inférieur couvert par le modéle et le spectre réel mesuré.
Pour les résidus spectraux eva et eca, respectivement les spectres de validation et
d’étalonnage (pour I'anglais « calibration »), le RVS est calculé comme suit

n m n
2 2
SFR = m(zevalk )/(Zzecali,k )1
k=1 i=1 k=1 (2)
pour m spectres d’étalonnage et n longueurs d’onde dans un méme spectre.

Un retrait a été considéré comme similaire si un minimum de 80 % des spectres
adéquats du retrait se trouvait sous les seulils, tant pour la mesure de la DM que celle
du RVS. Les seuils de la DM et du RVS ont été pris en compte dans I'étalonnage ex
Vivo en tant que parametres de I'algorithme.
Vérification des hypothéses
L’hypothése nulle a vérifier était :

HO : p <= 0,67

Ha:p > 0,67
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ou p représente la proportion de patients démontrant des similarités spectrales entre les
relevés cliniques et 'ensemble de données des autopsies. L’hypothése nulle devait étre
rejetée et, par conséquent, le critére principal était atteint si la limite inférieure de
l'intervalle de confiance a 95 % dépassait 0,67.

Résultats de I'étude

Lors de la validation, 59 retraits de patients (un retrait par patient) ont été évalués au
total. Onze retraits ont été jugés de qualité spectrale inadéquate en raison d’'une
mauvaise connexion optique, de la présence excessive de bulles dans la solution saline
des cathéters amorcés, de perturbations du flux sanguin ou de I'obscurcissement de la
paroi artérielle par un excés de sang. Parmi les 48 retraits de qualité suffisante, 40 se
sont révélés spectralement similaires aux spectres ex vivo, résultant en un taux de
réussite de 0,83 (intervalle de confiance de 95 %, 0,70 - 0,93). Ce taux de réussite
répondait au critere principal de I'étude pivot SPECTACL en démontrant que la limite
inférieure de l'intervalle de confiance de 95 % dépassait 0,67. La Figure 17-2 montre la
similarité en pourcentage pour chacun des 48 retraits. La ligne pointillée horizontale
représente une valeur médiane de similarité spectrale (96 %) des retraits. La ligne
horizontale pleine indique la limite inférieure permettant de déterminer la similarité
spectrale d’un retrait.
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Figure 17-2 : Similarité en pourcentage des retraits adéquats. La ligne pointillée
représente la similarité médiane en pourcentage (96 %). La similarité en pourcentage est
définie comme le pourcentage des spectres d’un retrait qui restait sous les seuils des
mesures de la DM et du RVS. La ligne noire pleine est un seuil minimal de 80 % sous
lequel un retrait n’était plus considéré comme similaire. Quarante des 48 retraits (0,83)
montrent une similarité en pourcentage plus élevée que ce seuil. La comparaison des
spectres in vivo de I'étude SPECTACL est réalisée en fonction de spectres d’étalonnage
ex vivo CDEVS3 (18 cceurs).
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La Figure 17-3 donne également un autre tracé qui illustre la similarité qui existe entre
les spectres recueillis sur les patients et ceux mesurés sur les spécimens d’autopsie.
La figure montre la mesure de la MD pour 1 % au hasard des spectres dans chacun
des ensembles de données d’étalonnage de CDEV3 (18 cceurs) ainsi que chacun des
ensembles de données de validation de SPECTACL et de CDEV3. Le recoupement
significatif entre les différents ensembles de données illustre la similarité entre les
spectres ex vivo et in vivo mesurés a l'aide du systeme d’'imagerie PIR d’Infraredx.
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Figure 17-3 : similarité entre les spectres ex vivo de CDEV3 et in vivo de SPECTACL
du point de vue de la DM. Le rouge indigue une concordance positive de PCL par
histologie ; le bleu indique une concordance négative de PCL par histologie ; le vert
indique I'absence d’histologie. CDEV3 Cal =données du modeéle d’étalonnage
(18 cceurs, 51 segments, 790 spectres) ; SPECTACL Val =données de I'étude clinique
pivot (48 patients, 48 segments, 1770 spectres) ; CDEV3 Val = données de validation
(51 cceurs, 126 segments, 3416 spectres). Chaque groupe représente 1% des
spectres de chaque ensemble, sélectionné au hasard.

Sécurité

Dans le cadre de I'étude clinique pivot SPECTACL, des spectres PIR ont été collectés
chez 89 patients. En combinaison avec les 10 patients scannés lors d’'une étude de
faisabilité préalable, le cathéter d'imagerie PIR a été utilisé sur un total de 99 patients. A
la suite de ces procédures, aucune corrélation n’a pu étre établie entre des événements
indésirables et I'utilisation du dispositif.
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17.4 Annexe D : conformité de sortie acoustique () selon la
norme IEC 60601-2-37:2007

Modele du systeme : Makoto Intravascular Imaging System™ (TVC-MC10)
Transducteur : Cathéter d’imagerie Dualpro™ IVUS+NIRS (TVC-C195-42), 50 MHz
Mode de fonctionnement : mode B

Cas d’utilisation : vasculaire

Modéle des sondes | Type TI Valeur TI IM
(pas d’'unité) (pas d’unité)
TVC-C195-42 TIS 0,43 0,36

Ces données concernent le cas le plus pessimiste. Etant donné que les valeurs Ml et Tl
sont inférieures a 1,0, il n’est pas nécessaire de remplir des tableaux supplémentaires.
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17.5 Annexe E : tableau de rapport de sortie acoustique (ll) pour la
plage 1

Modele du systéme : Makoto Intravascular Imaging System™ (TVC-MC10)

Cathéter d'imagerie Dualpro™ IVUS+NIRS (TVC-C195-42),
50 MHz

Mode B

Modeéle du transducteur :

Mode de fonctionnement :

Application : Intravasculaire
. . Ispta.3 I 3
Sortie acoustique IM spia sbpa
(mW/icm?) | (W/cm?)
Valeur maximale globale 0,36 98 257
Pra (Mpa) 2.6
w (mW) 1,73 1,73
fc (MHz) 51,97 51,97 51,97
Zsp (Cm) 0,1 0,1
Parameétre Dimensions de X-6 (CM) 0,0123
acoustique assoclé | faisceau Y6 (cm) 0,0317
PD usec 0,1356 0,1356
PRF Hz 61 440 61 440
Az. (cm) 0,31
EDS
Elev. (cm) 0,05
Conditions de A’ucun parametre fonctlo.nnel
commande du n’affecte la sortie acoustique
fonctionnement
infraredx-
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17.6 Annexe F : tableau d’indications relatives aux ultrasons pour
I'utilisation de I'appareil

Modele du systeme :
Modele du transducteur :

50 MHz

Makoto Intravascular Imaging System™ (TVC-MC10)
Cathéter d'imagerie Dualpro™ IVUS+NIRS (TVC-C195-42),

Cas d'utilisation clinique

Mode de fonctionnement

Généralités

Spécifique

B

M | PWD

CWD

Couleurs par
Doppler

Combiné
(spécifier)

Autre*
(spécifier)

Ophtalmique

Ophtalmique

Imagerie
foetale et
autres

Foetal

Abdominal

Intra-opératif
(spécifier)

Intra-opératif
(neuro)

Laparoscopique

Pédiatrique

Petit organe
(spécifier)

Néonatal

Céphalique

Céphalique adulte

Transrectal

Transvaginal

Transurétral

Transcesophagien
(non card.)

Musculo-
squelettique
(conventionnel)
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Musculo-
squelettique
(superficiel)

Intravasculaire

Autre

Cardiaque adulte | X

Cardiaque
pédiatrique

Intravasculaire X
Dysfonction | (cardiaque)

cardiague  [Transcesophagien
(Cardiaque)

Intracardiaque

Autre (veuillez

préciser)

Vaisseau
Vaisseau périphérique
périphérique | Autre (veuillez

préciser)
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17.7 Annexe G : exactitude et précision des mesures

Mesure IVUS

Criteres de specification/acceptation

Résultat du test*

Précision du L'écart type des décalages angulaires entre les canaux PIR 6 degrés
coenregistrem et IVUS est inférieur ou égal a 25 degrés.
ent IVUS /
NIR L’écart type des décalages longitudinaux entre les canaux PIR 0,17 mm
et IVUS est inférieur & 0,5 mm.
Précision des | Pour les diameétres intérieurs d’artéres inférieurs a 5 mm, I'écart 0,10 mm
mesures IVUS type du diameétre intérieur mesuré est inférieur ou égal a
0,125 mm.
Pour les diamétres intérieurs inférieurs ou égaux a 4 mm dans 1,56 mm?
le cas de diametres de vaisseaux inférieurs ou égaux a 7,5 mm,
I'écart type de l'aire de la section droite mesurée des plaques
(CSA) doit étre inférieur ou égal a 2,79 mm? en raison des
incertitudes dans les limites du vaisseau (EEM), des limitations
de diametre intérieur et des effets du NURD.
Exactitude Pour les diamétres intérieurs inférieurs ou égaux a 4 mm dans 1,74 %
des le cas de diamétres de vaisseaux inférieurs ou égaux a 7,5 mm,
mesures IVUS | la marge d’erreur dans I'exactitude de l'aire de la section droite
mesurée des plaques (CSA) doit étre inférieur ou égal a -9 %,
+14 % de la valeur mesurée +0,10 mm? en raison des
incertitudes dans les limites du vaisseau (EEM), des limitations
de diametre intérieur et des effets du NURD.
Pour les diamétres intérieurs compris entre 1,8 mm et 5 mm 1,89 %
inclus, la marge d’erreur dans I'exactitude de la surface
intérieure mesurée due a des incertitudes dans les limites de la
paroi intérieure ou l'ultrason ne traverse que le sang doit étre
inférieure ou égale a +5 % de la mesure +0,10 mm?.
Profondeur La conception du systéme doit étre compatible avec les Succes
d’'action du mesures de structures a des profondeurs pouvant atteindre
systeme 8 mm en termes de longueur, et en termes de surface 200 mm?2.
d’'imagerie

* Moyenne du résultat a des vitesses d’acquisition de retrait automatique minimales
(0,5 mm/s) et maximales (2,0 mm/s).
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17.8 Annexe H : conformité électromagnétique

Lignes directrices et déclaration du fabricant — émissions électromagnétiques

Le modéle TVC-MC10 du Makoto Intravascular Imaging System™ est destiné a étre utilisé dans
I'environnement électromagnétique mentionné ci-dessous. Le client ou l'utilisateur du TVC-MC10 doit

garantir que I'appareil sera utilisé dans cet environnement.

Essai
d’émissions

Niveau de test

Conformité

Environnement électromagnétique —
directives

Le Makoto Intravascular Imaging
System™ TVC-MC10 utilise I'énergie des

EmiSSiOhS par 150KHz a 150KHz a | fréquences radio uniguement pour son

conduction 30MHz, 30MHz, fonctionnement interne. Par conséquent,

CEI/EN 61000-4-6 Classe A Classe A ses émissions RF sont tres faibles et ne
peuvent pas causer d'interférences prés
d’un équipement électronique.

Emissions 30MHz a 30MHz a

rayonnées 1,8GHz, 1,8GHz,

CEI/EN 61000-4-3 Classe A Classe A

Harmoniques ) En vertu de la | Le Makoto Intravascular Imaging

Appareil de ™ . a
CEI/EN 61000-3- Classe A Clause 5 de la | System ™ modele TVC-MC10 peut étre

2:2001/A2:2014

norme

Scintillement

CEI/EN 61000-3-
3:2013

En vertu de la
Clause 5 de la
norme

En vertu de la
Clause 5 de la
norme

utilisé dans tous les établissements autres
gue les établissements domestiques ou
que les établissements directement
branchés au réseau de distribution public
de l'alimentation basse tension alimentant
en énergie les batiments utilisés a des fins
domestiques.
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Lignes directrices et déclaration du fabricant — immunité électromagnétique

Le modéle TVC-MC10 du Makoto Intravascular Imaging System ™ est destiné a étre utilisé dans
I'environnement électromagnétique mentionné ci-dessous. Le client ou I'utilisateur du TVC-MC10 doit

garantir que I'appareil sera utilisé dans cet environnement.

Essai Niveau de Niveau de Environnement électromagnétique —
d’immunité test conformité directives
béch Les sols doivent étre en bois, en béton ou en
élggtrzrsggtique 18 kV contact +8 kV contact carreaux de céramique. Si les sols sont
(ESD) +2, 4,8 et 15kV | +2, 4, 8 et 15kV | recouverts d’'un matériau synthétique,
CEIl 61000-4-2 air air Ienv_wonnement doit présenter une humidité
relative de 30 %.

=2 kV pour les +2 kV pour les

lignes lignes

d’alimentation d’alimentation
Coupure /
sursaut +1kV pourles | +1kV pourles | La qualité du réseau d’alimentation doit étre
électrique lignes d’entrée | lignes d’entrée | celle d’'un environnement commercial ou
rapide et de sortie et de sortie hospitalier type.
CEI 61000-4-4 5/50 5/50

5KHz et 5KHz et

100KHz 100KHz
Surtension +.5KkV ligne- +.5 KV ligne- La qualité du réseau d’alimentation doit étre
(Alimentation . . ) . .

ligne ligne celle d’un environnement commercial ou

AC)

+2 kV ligne-terre

+2 kV ligne-terre

hospitalier type.

CEI 61000-4-5

0% Ur pour 0,5 | 0% Ur pour 0,5 | Sjutilisateur souhaite utiliser le

cycle cycle Makoto Intravascular Imaging System™ TVC-
tcérneslfgndgt 0 % Ur pour 1 0 % Ut pour 1 MC10 en continu pendant les coupures de
interruptions cycle cycle courant, il est recommandé que le

CEI 61000-4-11

70 % U pour 25
cycles

0% Ut pour5s

70 % Ut pour 25
cycles

0% Urpour5s

Makoto Intravascular Imaging System™ TVC-
MC10 soit alimenté par une alimentation sans
interruption ou par une batterie.

Immunité
magnétique
CEI/EN 61000-
4-8

30 A/Im

30 A/m

Les champs magnétiques de fréquence de
puissance doivent étre aux niveaux
caractéristiqgues d’'un emplacement typique dans
un environnement commercial ou hospitalier

typique.

Remarque : Ut représente la tension secteur en c.a. avant I'application au niveau de test.
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Lignes directrices et déclaration du fabricant —immunité électromagnétique

Le modele TVC-MC10 du Makoto Intravascular Imaging System™ est destiné a étre utilisé dans
'environnement électromagnétique mentionné ci-dessous. Le client ou l'utilisateur du TVC-MC10 doit
garantir que l'appareil sera utilisé dans cet environnement.

Essai
d'immunité

Niveau de test

Niveau de
conformité

Environnement
électromagnétique — directives

Immunité rayonnée
CEI/EN 61000-4-3

Proximité avec
'équipement de
communication RF
sans fil

CEI/EN 61000-4-3

80 MHz a 2,7
GHz, 3V/m

Fréquences
caractéristiques
385MHz —
5,75GHz,
Modulation par
impulsions

Voir Section 5.3.7
ou Tableau 9 de
la norme dont un
extrait apparait
ci-dessous.

80 MHz to 2.7
GHz, 3 V/m

Fréquences
caractéristiques
385MHz —
5.75GHz,
Modulation par
impulsions

Voir Section 5.3.7
ou Tableau 9 de
la norme dont un
extrait apparait
ci-dessous.

Il est recommandé de respecter, entre
les équipements de communication RF
portables et mobiles et le Makoto
Intravascular Imaging System™
modéele TVC-MC10, y compris les
cébles, la distance de séparation
recommandée calculée selon I'équation
applicable a la fréquence de I'émetteur.

Distance de séparation
recommandée

Les distances de séparation minimales
pour les niveaux de test d'immunité
supérieurs doivent étre calculés a 'aide
de I'équation suivante :

6
E= (—) P
y V.
ou P représente la puissance de sortie
maximale de I'’émetteur en watts (W), d

la distance en m, et E le niveau de test
d’immunité en V/m.

Immunité aux
perturbations
conduites

(lignes
d’alimentation)
(lignes d’entrée et
de sortie)

CEI/EN 61000-4-6

0,015-80 MHz 3
Vrus €16 VrMs €N
bande ISM,
1KHz,

alimentation AC

0,015-80 MHz 3
VRrus €16 VrMs €N
bande ISM,
1KHz,

alimentation AC

Au-dela de la plage de fréquences 150
kHz-80 MHz, I'intensité du champ doit
étre inférieure & 3 V/m.
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Distances de séparation recommandées entre I’équipement de communication
portable et mobile a fréquences radio et le Makoto Intravascular Imaging
System™ TVC-MC10

Le Makoto Intravascular Imaging System ™ TVC-MC10 est destiné a étre utilisé dans un environnement
électromagnétique dans lequel les perturbations dues au rayonnement de fréquences radio sont
controlées. Le client ou I'utilisateur du TVC-MC10 peut protéger I'appareil des interférences
électromagnétiques en conservant une distance minimale entre I'équipement de communication portable
et mobile a fréquences radio (émetteurs) et le Makoto Intravascular Imaging System™ TVC-MC10, tel que
recommandé ci-dessous, en fonction de la puissance de sortie maximale de I'équipement de
communication. Ce tableau est tiré de la norme CEI/EN 61000-4-3.
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Spécifications d’essai pour I'immunité des acceés par I'enveloppe aux appareils
de communication sans fil RF

Fréquence du Bande? Service? Modulation® Pws_sance Distance va’.eau du _te’st
test maximale d'immunité
(MHz) (W) (m) (V/m)
Modulation par
i b
385 380-390| TETRA 400 pulsations® 1,8 0,3 27
18 MHz
FMO
450 430-470 GMRS;;%O' FRS + 5 kHz déviation 2 0,3 28
1 kHz sinus
710 Modulation par
i b
745 704-787 | LTE Band 13, 17| Pulsations® 0,2 0,3 9
780 217 MHz
810 GSM 800/900. | Modulation par
TETRA 800, IDEN pulsations®
870 800-960 820, CDMA 850, 2 0,3 28
1720 GSM 1800; CDMA! Modulation par
1700- |1900; GSM 1900; pulsationsb)
1845 1990 |DECT;LTE Band 2 0.3 28
1970 1,3, 4,25 UMTS| 217 MHz
Bluetooth, WLAN,| Modulation par
2400- 802,11 b/g/n, pulsations®
2450 2570 RFID 2450, LTE 2 0.3 28
Band 7 217 MHz
5240 Modulation par
- i b
5500 S100- ) AN, 802,11 a/n| PUlsations 0.2 0,3 9
5800
5785 217 MHz

REMARQUE : Si cela s'avere nécessaire pour atteindre le niveau d’essai pour I'immunité, la distance
entre 'antenne de transmission et I'équipement EM ou le systéme EM peut étre réduit a 1 m. La distance
d’essai de 1 m est autorisée par la norme CEI 61000-4-3.
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a) Pour certains services, seules les fréquences montantes sont incluses.

b) L'onde porteuse doit étre modulée a 'aide d’un signal carré a rapport cyclique de 50 %.

) A laplace de la modulation FM, une modulation par pulsations de 50 % & 18 Hz peut étre utilisée car
s'il ne s’agit pas réellement de modulation, il s'agirait du pire des cas.
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